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Chapter 1
Before You Begin

1.1

1.2

1.3

Overview

This chapter provides an orientation to the use of this manual, and includes a configuration overview
flowchart and a pre-configuration worksheet. This manual describes the procedures required to start,
configure, use, maintain, and troubleshoot the Micro Motion® Model 24008 transmitter for
PROFIBUS-DP (the Model 2400S DP transmitter).

If you do not know what transmitter you have, see Section 1.3 for instructions on identifying the
transmitter type from the model number on the transmitter’s tag.

Note: Information on configuration and use of Model 2400S transmitters with different 1/O options is
provided in separate manuals. See the manual for your transmitter.

Safety

Safety messages are provided throughout this manual to protect personnel and equipment. Read each
safety message carefully before proceeding to the next step.

Determining transmitter information

Transmitter type, user interface option, and output options are encoded in the model number located
on the transmitter tag. The model number is a string of the following form:

D400S*X*X*++Hr*
In this string:
e 2400S identifies the transmitter family.
* The first X (the seventh character) identifies the I/O option: D = PROFIBUS-DP
* The second X (the ninth character) identifies the user interface option:
- 1 =Display with glass lens
- 3 =Nodisplay
- 4 = Display with non-glass lens
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Before You Begin

1.4 PROFIBUS-DP functionality
The Model 2400S DP transmitter implements the following PROFIBUS-DP functionality:

e Baud rates: standard baud rates between 9.6 kbits/sec and 12.0 Mbits/sec, automatically
detected by transmitter

* 1/O slave messaging:
- Data exchange
- Acyclic
*  Configuration methods:
- Node address: hardware address switches or software addressing

- Device description (EDD) conforming to the following: Specification for PROFIBUS
Device Description and Device Integration: Volume 2: EDDL V1.1, January 2001

- DP-V1 read and write services with PROFIBUS bus parameters
*  Operation methods:

- GSD conforming to the following: Specification for PROFIBUS Device Description and
Device Integration: Volume 1: GSD V5.0, May 2003

- DP-VO cyclic services
- Device description listed above
- DP-VI1 read and write services
¢ Identification and maintenance (I&M) functions:
- 1&MO
- 1&M 1

as specified in Profile Guidelines Part 1: Identification & Maintenance Functions
Version 1.1.1, March 2005.

1.5 Determining version information

Table 1-1 lists the version information that you may need and describes how to obtain the information.
(Additional information is available via the I&M functions. See Section 7.2.)

Obtaining version information

Component Tool Method
Transmitter software With ProLink Il View > Installed Options > Software Revision
With EDD MMI Coriolis Flow > Configuration Parameters >
Device
With display OFF-LINE MAINT > VER
ProLink Il With ProLink Il Help > About ProLink I
GSD version Text editor Open file MMIOA60.GSD
Check parameter GSD_Revision
EDD version Text editor Open file MMICorFlowDP.ddlI

Check parameter DD_Revision

2 Micro Motion® Model 2400S Transmitters for PROFIBUS-DP



Before You Begin

1.6 Communication tools

Most of the procedures described in this manual require the use of a communication tool. Table 1-2
lists the communication tools that can be used, with their functionality and requirements.

Note: You can use either ProLink II, the EDD, or PROFIBUS bus parameters for transmitter setup
and maintenance. It is not necessary to have more than one of these methods available.

o
(0]
-
o
=
(]
o)
[=
o
(']
Q
=

Communication tools for Model 2400S DP transmitter

Functionality

Tool View/operation Setup/maintenance Requirement
Transmitter display Partial Partial Transmitter with display
ProLink® II Full Full® v2.5 (preliminary implementation)

v2.6 (full implementation)

Pocket ProLink® Full Full® v1.3 (preliminary implementation)
v1.4 (full implementation)

PROFIBUS host

(2}
*GSD Partial None GSD file (MMIOA60.GSD) )
*EDD Full Full®™ EDD file set %
* Bus parameters Full Full® None

(1) Except for node address.

The EDD and the GSD can be downloaded from the Micro Motion web site:
www.micromotion.com.

In this manual:

* Basic information on using the transmitter’s user interface and display is provided in
Chapter 3.

* Basic information on using ProLink II or Pocket ProLink, and connecting ProLink II or
Pocket ProLink to your transmitter, is provided in Chapter 4. For more information, see the
ProLink II or Pocket ProLink manual, available on the Micro Motion web site
(www.micromotion.com).

* Basic information on using a PROFIBUS host is provided in Chapter 5.

aoeLIgU| Jas Japlwisuel]

1.7 Planning the configuration
Refer to the configuration overview flowchart in Figure 1-1 to plan transmitter configuration. In
general, perform configuration steps in the order shown here.

Note: Depending on your installation and application, some configuration tasks may be optional.

Note: This manual provides information on topics that are not included in the configuration overview
flowchart, e.g.: using the transmitter, troubleshooting, and calibration procedures. Be sure to review
these topics as required.

11 yuiqoid buisn

Configuration and Use Manual 3



Before You Begin

Configuration overview

v v

Chapter 1 Chapter 6 Chapter 9
Before You Begin Required Configuration Pressure Compensation and
Temperature Compensation
Fill out pre-configuration Characterize the flowmeter . .
worksheet (if required) Configure pressure
J compensation (optional)
3 Confi t unit v
Chapter 2 onfigure measurement units Configure Fempergture
Flowmeter Startup compensation (optional)
Apply power i
PR P Chapter 8 v
l Optional Configuration Chapter 10
Measurement Performance
Set the node address Configure volume flow
measurement for gas Zero the flowmeter (optional)
! ' I
Chapter 3 (if required) Configure cutoffs Perform initial meter
Using the User Interface l verification tests
Learn basic use . X
Configure damping
.
Chapter 4 (if required) Configure flow direction
Connecting with ProLink Il or
Pocket ProLink Software l

Configure events

'

. Configure slug flow

Chapter 5
Using a Profibus Host l

Set up connection

i X Configure status alarm severity
Obtain and import GSD

Obtain and import EDD Configure display functionality
(if required) l

'

Configure digital
Establish communication communications
Import GSD input and output Configure device settings

modules

!

Configure sensor parameters

'

Configure 1&M functions

!

Configure petroleum
measurement application or
enhanced density application

4 Micro Motion® Model 2400S Transmitters for PROFIBUS-DP



Before You Begin

1.8 Pre-configuration worksheet

The pre-configuration worksheet provides a place to record information about your flowmeter and
your application. This information will affect your configuration options as you work through this
manual. You may need to consult with transmitter installation or application process personnel to
obtain the required information.

If you are configuring multiple transmitters, make copies of this worksheet and fill one out for each
individual transmitter.

o))
o
e
o
=
o
&
c
oY)
)
Q
=

Pre-configuration worksheet Transmitter

Iltem Configuration data

Transmitter model number

Transmitter serial number

Transmitter software revision

Sensor model number

Sensor serial number

PROFIBUS-DP node

address
Measurement units Mass flow
Volume flow
Density
Pressure
Temperature
Installed applications O Micro Motion Smart Meter Verification

O Meter verification application, original version
O Petroleum measurement application
O Enhanced density application

Configuration and Use Manual 5
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1.9 Flowmeter documentation

Table 1-3 lists documentation sources for additional information.

Flowmeter documentation resources

Topic Document

Sensor installation Sensor documentation

Transmitter installation Micro Motion® Model 2400S Transmitters: Installation Manual
Hazardous area installation See the approval documentation shipped with the transmitter, or

download the appropriate documentation from the Micro Motion web
site (www.micromotion.com)

1.10  Micro Motion customer service
For customer service, phone the support center nearest you:

e Inthe U.S.A., phone 800-522-MASS (800-522-6277) (toll-free)

* In Canada and Latin America, phone +1 303-527-5200

e In Asia:
- InJapan, phone 3 5769-6803
- In other locations, phone +65 6777-8211 (Singapore)

e In Europe:
- Inthe U.K., phone 0870 240 1978 (toll-free)
- In other locations, phone +31 (0) 318 495 555 (The Netherlands)

Customers outside the U.S.A. can also email Micro Motion customer service at
flow.support@emerson.com.

6 Micro Motion® Model 2400S Transmitters for PROFIBUS-DP



Flowmeter Startup

2.1

2.2

2.3

Configuration and Use Manual

Overview
This chapter describes the following procedures:
* Setting the node address — see Section 2.2

*  Bringing the flowmeter online — see Section 2.3

Setting the node address

Three address switches are provided on the user interface module (see Figure 3-1 or Figure 3-2).
These switches are used to set a three-digit node address for the device:

*  The leftmost switch sets the first digit.

* The center switch sets the second digit.

*  The rightmost switch sets the third digit.
The default setting for the address switches is 126.

You can set the node address manually before bringing the device online, by rotating the address
switches to any value between 0 and 125. If the transmitter was powered on at the time the address
switches were set, it will not accept the new node address until you perform a power cycle.

If the transmitter is brought online with the switches set to 126:
*  The device shows up at address 126 in the live list.

* You can set the node address programmatically by sending a Set Slave Address telegram from
the PROFIBUS host.

*  You can set the node address manually by rotating the switches to any value between 0 and
125, then power-cycling the device.

For more information on setting the node address, see Section 8.10.1.

Note: It is not necessary to set the baud rate. because the Model 24008 DP transmitter automatically
detects and uses the DP segment baud rate.

Bringing the transmitter online
To bring the transmitter online:

1. Follow appropriate procedures to ensure that the process of configuring and commissioning
the Model 2400S DP transmitter does not interfere with existing measurement and control
loops.

2. Ensure that the PROFIBUS cable is connected to the transmitter as described in the transmitter
installation manual.

3. Ensure that all transmitter and sensor covers and seals are closed.

uibag noj ailojag
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Flowmeter Startup

A WARNING

Operating the flowmeter without covers in place creates electrical hazards
that can cause death, injury, or property damage.

To avoid electrical hazards, ensure that the transmitter housing cover and all other
covers are in place before connecting the transmitter to the network.

4. Apply power to the transmitter. The flowmeter will automatically perform diagnostic routines.
When the flowmeter has completed its power-up sequence, the status LED will turn green. If
the status LED exhibits different behavior, an alarm condition is present or transmitter
calibration is in progress. See Section 7.6.

Note: If this is the initial startup, or if power has been off long enough to allow components to reach
ambient temperature, the flowmeter is ready to receive process fluid approximately one minute after
power-up. However, it may take up to ten minutes for the electronics in the flowmeter to reach thermal
equilibrium. During this warm-up period, you may observe minor measurement instability or
inaccuracy.

5. Ensure that the transmitter is visible on the network. For information on establishing
communications between the Model 2400S DP transmitter and a PROFIBUS host, see
Chapter 5.

8 Micro Motion® Model 2400S Transmitters for PROFIBUS-DP



Using the Transmitter User Interface

uibag noj ailojag

3.1 Overview

This chapter describes the user interface of the Model 2400S DP transmitter. The following topics are
discussed:

* Transmitters without or with display — see Section 3.2

* Removing and replacing the transmitter housing cover — see Section 3.3
* Using the Scroll and Select optical switches — see Section 3.4

* Using the display — see Section 3.5

dnpers

3.2 User interface without or with display

The user interface of the Model 2400S DP transmitter depends on whether it was ordered with or
without a display:

» If ordered without a display, there is no LCD panel on the user interface. The user interface
provides the following features and functions:

- Three address switches, used to set the PROFIBUS node address

- Aninternal termination resistor switch

- Three LEDs: a status LED, a network LED, and a software address LED

- Service port clips

- Zero button

For all other functions, either ProLink II or a customer-supplied PROFIBUS host is required.

e If ordered with a display, no zero button is provided (you must zero the transmitter with the
display menu, ProLink II, or a PROFIBUS host), and the following features are added:

=
[V
=
(7]
3
=1
1]
=
[
(7]
1]
=
5
-
1]
=3
D
(2]
(1]

- An LCD panel, which displays process variable data and also provides access to the
off-line menu for basic configuration and management. Optical switches are provided for
LCD control.

- An IrDA port which provides wireless access to the service port

Note: The off-line menu does not provide access to all transmitter functionality; for access to all
transmitter functionality, either ProLink II, the EDD, or PROFIBUS bus parameters must be used.

Figures 3-1 and 3-2 show the user interface of the Model 2400S DP transmitter without and with a
display. In both illustrations, the transmitter housing cover has been removed.

11 yuiqoid buisn

Configuration and Use Manual 9



Using the Transmitter User Interface

User interface — Transmitters without display

Address switches

Status LED

Zero button

Software address LED

o Network LED
Internal termination

resistor switch

Service port clips

User interface — Transmitters with display

Address switches

LCD panel
Status LED

Process variable

Software address LED
Unused

Network LED

Internal termination
resistor switch

Optical switch indicator

Optical switch indicator

Scroll optical switch Select optical switch

Service port clips
IrDA port

If the transmitter does not have a display, the transmitter housing cover must be removed to access all
user interface features and functions.

10 Micro Motion® Model 2400S Transmitters for PROFIBUS-DP



Using the Transmitter User Interface

3.3

3.4

If the transmitter has a display, the transmitter housing cover has a lens. All of the features shown in
Figure 3-2 are visible through the lens, and the following functions may be performed through the
lens (i.e., with the transmitter housing cover in place):

e Viewing the LEDs

*  Viewing the LCD panel

»  Using the Select and Scroll optical switches

* Making a service port connection via the IrDA port
All other functions require removal of the transmitter housing cover.
For information on:

*  Using the address switches, see Section 8.10.1.

* Using the LEDs, see Section 7.5.

* Making a service port connection, see Section 4.4.

»  Using the zero button, see Section 10.5.

Note: The termination resistor switch is used to enable or disable the internal terminator. The internal
terminator can be used instead of an external terminator if termination is required at the transmitter.

Removing and replacing the transmitter housing cover

For some procedures, you must remove the transmitter housing cover. To remove the transmitter
housing cover:

1. If the transmitter is in a Division 2 or Zone 2 area, remove power from the unit.

A WARNING

Removing the transmitter housing cover in a Division 2 or Zone 2 area while
the transmitter is powered up can cause an explosion.

To avoid the risk of an explosion, remove power from the transmitter before
removing the transmitter housing cover.

2. Loosen the four captive screws.
3. Lift the transmitter housing cover away from the transmitter.

When replacing the transmitter housing cover, be sure to adjust the cover and tighten the screws so
that no moisture can enter the transmitter housing.

Using the optical switches
Note: This section applies only to transmitters with a display.

The Scroll and Select optical switches are used to navigate the display menus. To activate an optical
switch, touch the lens in front of the optical switch or move your finger over the optical switch close
to the lens. There are two optical switch indicators: one for each switch. When an optical switch is
activated, the associated optical switch indicator is a solid red.

Configuration and Use Manual 11
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3.5

12

A CAUTION

Attempting to activate an optical switch by inserting an object into the
opening can damage the equipment.

To avoid damage to the optical switches, do not insert an object into the openings.
Use your fingers to activate the optical switches.

Using the display
Note: This section applies only to transmitters with a display.

The display can be used to view process variable data or to access the transmitter menus for
configuration or maintenance.

3.5.1 Display language

The display can be configured for the following languages:

* English
e French

e Spanish
* German

Due to software and hardware restrictions, some English words and terms may appear in the
non-English display menus. For a list of the codes and abbreviations used on the display, see
Appendix E.

For information on configuring the display language, see Section 8.9.

In this manual, English is used as the display language.

3.5.2 Viewing process variables

In ordinary use, the Process variable line on the LCD panel shows the configured display variables,
and the Units of measure line shows the measurement unit for that process variable.

*  See Section 8.9.3 for information on configuring the display variables.
* See Appendix E for information on the codes and abbreviations used for display variables.

If more than one line is required to describe the display variable, the Units of measure line alternates
between the measurement unit and the additional description. For example, if the LCD panel is
displaying a mass inventory value, the Units of measure line alternates between the measurement
unit (for example, G) and the name of the inventory (for example, MASSI).

Auto Scroll may or may not be enabled:

» If Auto Scroll is enabled, each configured display variable will be shown for the number of
seconds specified for Scroll Rate.

*  Whether Auto Scroll is enabled or not, the operator can manually scroll through the configured
display variables by activating Scroll.

For more information on using the display to view process variables or manage totalizers and
inventories, see Chapter 7.
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3.5.3 Using display menus

Note: The display menu system provides access to basic transmitter functions and data. It does not
provide access to all functions and data. To access all functions and data, use either ProLink Il or a
customer-supplied PROFIBUS tool.

To enter the display menu system:

uibag noj ailojag

1. Activate Scroll and Select simultaneously.
2. Hold Scroll and Select until the words SEE ALARM or OFF-LINE MAINT appear.

Note: Access to the display menu system may be enabled or disabled. If disabled, the OFF-LINE
MAINT option does not appear. For more information, see Section 8.9.

For entry into certain sections of the display menu:
» If a password has been enabled, you will be prompted to enter it. See Section 3.5.4.

* If adisplay password is not required, you will be prompted to activate the optical switches in a
pre-defined sequence (Scroll-Select-Scroll). This feature is designed to prevent unintentional
entry to the menu caused by variations in ambient lighting or other environmental factors.

If no optical switch activity occurs for two minutes, the transmitter will exit the off-line menu system
and return to the process variable display.

dnpers

To move through a list of options, activate Scroll.

To select from a list or to enter a lower-level menu, scroll to the desired option, then activate Select. If
a confirmation screen is displayed:

* To confirm the change, activate Select.

* To cancel the change, activate Scroll.
To exit a menu without making any changes:

e Use the EXIT option if available.

¢ Otherwise, activate Scroll at the confirmation screen.

3.5.4 Display password

Some of the display menu functions, such as accessing the off-line menu, can be protected by a
display password. For information about enabling and setting the display password, refer to
Section 8.9.

=
[V
=]
(7]
3
=1
1]
=
[
(7]
1]
=
5
-
1]
=3
D
(2]
(1]

If a password is required, the word CODE? appears at the top of the password screen. Enter the digits
of the password one at a time by using Scroll to choose a number and Select to move to the next
digit.

If you encounter the display password screen but do not know the password, wait 60 seconds without
activating any of the display optical switches. The password screen will time out automatically and
you will be returned to the previous screen.

3.5.5 Entering floating-point values with the display

Certain configuration values, such as meter factors or output ranges, are entered as floating-point
values. When you first enter the configuration screen, the value is displayed in decimal notation (as
shown in Figure 3-3) and the active digit is flashing.

11 yuiqoid buisn
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Numeric values in decimal notation

S‘.‘»X.XXXX

|

Sign Digits

For positive numbers, leave this space Enter a number (maximum length: eight
blank. For negative numbers, enter a digits, or seven digits and a minus sign).
minus sign (-). Maximum precision is four.

To change the value:

1. Select to move one digit to the left. From the leftmost digit, a space is provided for a sign. The
sign space wraps back to the rightmost digit.

2. Scroll to change the value of the active digit: 1 becomes 2, 2 becomes 3, ..., 9 becomes 0, 0
becomes 1. For the rightmost digit, an E option is included to switch to exponential notation.

To change the sign of a value:
1. Select to move to the space that is immediately left of the leftmost digit.
2. Use Scroll to specify — (for a negative value) or [blank] (for a positive value).

In decimal notation, you can change the position of the decimal point up to a maximum precision of
four (four digits to the right of the decimal point). To do this:

1. Select until the decimal point is flashing.
2. Scroll. This removes the decimal point and moves the cursor one digit to the left.

3. Select to move one digit to the left. As you move from one digit to the next, a decimal point
will flash between each digit pair.

4. When the decimal point is in the desired position, Scroll. This inserts the decimal point and
moves the cursor one digit to the left.

To change from decimal to exponential notation (see Figure 3-4):
1. Select until the rightmost digit is flashing.
2. Scroll to E, then Select. The display changes to provide two spaces for entering the exponent.
3. To enter the exponent:
Select until the desired digit is flashing.

Scroll to the desired value. You can enter a minus sign (first position only), values
between 0 and 3 (for the first position in the exponent), or values between 0 and 9 (for the
second position in the exponent).

c. Select.

Note: When switching between decimal and exponential notation, any unsaved edits are lost. The
system reverts to the previously saved value.

Note: While in exponential notation, the positions of the decimal point and exponent are fixed.
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Figure 3-4  Numeric values in exponential notation

|SX.X&(EYY

| \—\

Sign — Digit (0-9)

Digits
Enter a four-digit
number; three digits Sign or Digit (0-3)
must fall to the right
of the decimal point. Exponent
indicator

To change from exponential to decimal notation:

1. Select until the E is flashing.

2. Scroll to d.

3. Select. The display changes to remove the exponent.
To exit the menu:

» If the value has been changed, Select and Scroll simultaneously until the confirmation screen
is displayed.

- Select to apply the change and exit.
- Scroll to exit without applying the change.

» If the value has not been changed, Select and Scroll simultaneously until the previous screen
is displayed.
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Connecting with ProLink Il or Pocket ProLink
Software

41

4.2

Overview

ProLink II is a Windows-based configuration and management tool for Micro Motion transmitters. It
provides complete access to transmitter functions and data. Pocket ProLink is a version of ProLink IT
that runs on a Pocket PC.

This chapter provides basic information for connecting ProLink II or Pocket ProLink to your
transmitter. The following topics and procedures are discussed:

* Requirements — see Section 4.2
*  Configuration upload/download — see Section 4.3
e Connecting to a Model 2400S DP transmitter — see Section 4.4

The instructions in this manual assume that users are already familiar with ProLink II or

Pocket ProLink software. For more information on using ProLink II, see the ProLink II manual. For
more information on using Pocket ProLink, see the Pocket ProLink manual. Both manuals are
available on the Micro Motion web site (www.micromotion.com). Instructions in this manual will
refer only to ProLink II.

Requirements
To use ProLink II with the Model 2400S DP transmitter:
*  You must have ProLink II v2.5 or higher.

*  You must have either the ProLink II installation kit appropriate to your PC and connection
type, or the equivalent equipment. See the ProLink II manual or quick reference guide for
details.

To use Pocket ProLink with the Model 2400S DP transmitter:
*  You must have Pocket ProLink v1.3 or higher.
¢ In addition:

- If you will connect to the transmitter via the service port clips, you must have either the
Pocket ProLink installation kit or the equivalent equipment. See the Pocket ProLink
manual or quick reference guide for details.

- If you will connect via the IrDA port, no additional equipment is required.

Configuration and Use Manual 17
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4.3

4.4

18

Configuration upload/download

ProLink II and Pocket ProLink provide a configuration upload/download function which allows you
to save configuration sets to your PC. This allows:

* Easy backup and restore of transmitter configuration
* Easy replication of configuration sets

Micro Motion recommends that all transmitter configurations be saved to a PC as soon as the
configuration is complete. See Figure C-1, and refer to the ProLink II or Pocket ProLink manual for
details.

Connecting from a PC to a Model 24008 DP transmitter

To connect to the Model 2400S DP transmitter using ProLink II or Pocket ProLink, you must use a
service port connection.

4.41 Connection options
The service port can be accessed via the service port clips or the IrDA port.
The service port clips have priority over the IrDA port:
» If there is an active connection via the service port clips, access via the IrDA port is disabled.

e If there is an active connection via the IrDA port and a connection attempt is made via the
service port clips, the I'DA connection is terminated.

Additionally:

*  Access via the IrDA port may be disabled altogether. In this case, it is not available for
connections at any time. By default, access via the IrDA port is disabled.

e The IrDA port may be write-protected. In this case, it can be used only to retrieve data from the
transmitter. By default, the IrDA port is write-protected.

See Section 8.10.2 for more information or to change these settings.

4.4.2 Service port connection parameters

The service port uses default connection parameters. Both ProLink II and Pocket ProLink
automatically use these default parameters when Protocol is set to Service Port.

Additionally, to minimize configuration requirements, the service port employs an auto-detection
scheme when responding to connection requests. The service port will accept all connection requests
within the limits described in Table 4-1. If you are connecting to the service port from another tool,
ensure that configuration parameters are set within these limits.
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Service port auto-detection limits

w
Parameter Option g..
Protocol Modbus ASCII or Modbus RTU® )
Address Responds to both: g
e Service port address (111) o
» Configured Modbus address (default=1)® Q
5
Baud rate® Standard rates between 1200 and 38,400
Stop bits 1,2
Parity Even, odd, none
(1) Service port support for Modbus ASCII may be disabled. See Section 8.10.4.
(2) See Section 8.10.3 for information on configuring the Modbus address.
(3) This is the baud rate between the service port and the connecting program. It is not the PROFIBUS DP baud rate.
4.43 Making the connection
To connect to the service port:
(7]
1. If you are using the IrDA port: )
a. [Ensure that the IrDA port is enabled (see Section 8.10.2). S

b. Ensure that there is no connection via the service port clips.

Note: Connections via the service port clips have priority over connections via the IrDA port. If you
are currently connected to the service port clips, you will not be able to connect via the IrDA port.

c. Position the IrDA device for communication with the IrDA port (see Figure 3-2). You do
not need to remove the transmitter housing cover.

Note: The IrDA port is typically used with Pocket ProLink. To use the IrDA port with ProLink 11, a
special device is required; the IrDA port built into many laptop PCs is not supported. For more
information on using the IrDA port with ProLink II, contact Micro Motion customer service.

2. If you are using the service port clips:

a. Attach the signal converter to the serial or USB port of your PC, using the appropriate
connectors or adapters (e.g., a 25-pin to 9-pin adapter or a USB connector).

b. Remove the transmitter housing cover from the transmitter (see Section 3.3), then connect
the signal converter leads to the service port clips. See Figure 4-1.

A WARNING

Removing the transmitter housing cover in a hazardous area can cause an
explosion.

aoeLIgU| Jas Japlwisuel]

Because the transmitter housing cover must be removed to connect to the service
port clips, the service port clips should be used only for temporary connections, for
example, for configuration or troubleshooting purposes.

When the transmitter is in an explosive atmosphere, use a different method to
connect to your transmitter.
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Service port connections to service port clips

25-pin to 9-pin serial port
adapter (if necessary)

RS-485 to RS-232

signal converter
RS-485/A

Service port clips

3. Start ProLink II or Pocket ProLink software. From the Connection menu, click Connect to
Device. In the screen that appears, specify:

* Protocol: Service Port
* COM Port: as appropriate for your PC
No other parameters are required.

4. Click Connect. The software will attempt to make the connection.

Note: While you are connected to the IrDA port, both optical switch indicators will flash red, and both
the Scroll and Select optical switches are disabled.

5. If an error message appears:
Ensure that you are using the correct COM port.

a.
b. For connections to the IrDA port, ensure that the IrDA port is enabled.

13

For connections to the service port clips, swap the leads between the clips and try again.

o

For connections to the service port clips, check all the wiring between the PC and the
transmitter.

4.5 ProLink Il language

ProLink II can be configured for several different languages. To configure the ProLink II language,
use the Tools menu. See Figure C-1.

In this manual, English is used as the ProLink II language.
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5.1 Overview

This chapter provides basic information for using a PROFIBUS host with the Model 2400S DP
transmitter. The following topics are discussed:

*  Support files — see Section 5.2

*  Connecting to the Model 2400S DP transmitter from a PROFIBUS host — see Section 5.3 E
*  Using a PROFIBUS host with the GSD — see Section 5.4 %‘
* Using a PROFIBUS host with the device description (EDD) — see Section 5.5 5
*  Using PROFIBUS bus parameters — see Section 5.6 é:
5
5.2 Support files -
The following files are available for use with the Model 2400S DP transmitter:
*  MMIOA60.GSD — enables:
- Viewing process data and alarms
- Managing totalizers and inventories
- Accepting external pressure or temperature data for use in pressure or temperature
compensation g
* Device description (EDD) — enables all of the above, plus: ‘E
- Configuration functionality ‘3
- Viewing event status %
- Acknowledging alarms g
- Performing zero and density calibration %
- Performing meter verification
The GSD can be downloaded from the Micro Motion web site (www.micromotion.com), and can be
used with any compatible PROFIBUS host. The EDD can be downloaded from the Micro Motion web
site, and has been certified to work with Siemens Simatic PDM.
Set up the GSD or EDD using the method appropriate to your PROFIBUS host.
_OO
5.3 Connecting to the Model 2400S DP transmitter g
To connect to the Model 2400S DP transmitter: o
1. The transmitter automatically detects and uses the DP segment baud rate. If no baud rate is u-:_;':
detected, the transmitter does not attempt communication. §
S
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2. The factory setting for the hardware address switches is 126, which is the default PROFIBUS
address for decommissioned devices. To commission the transmitter, the node address must be
set to a value in the commissioned range (0—125).

* If you will set the node address via the hardware address switches:
a. Set the node address to the desired value. See Section 8.10.1.
b. From the PROFIBUS host, connect to the network where the transmitter is installed.

c. Using the same methods that you use for other PROFIBUS-DP devices, establish a
connection to the Model 2400S DP transmitter.

e If you will set the node address via software:
a. Ensure that the hardware address switches are set to 126 or above.
From the PROFIBUS host, connect to the network where the transmitter is installed.

c. Using the same methods that you use for other PROFIBUS-DP devices, establish a
connection to the Model 2400S DP transmitter.

d. Send a Set Slave Address telegram. See Section 8.10.1.

5.4 Using the GSD

Modules available with the GSD are listed in Table 5-1. Note that input and output are from the
perspective of the PROFIBUS host; i.e.:

e Input modules input data from the transmitter onto the network, and to the PROFIBUS host.
e QOutput modules take output data from the network into the transmitter.

Set up any desired modules for data exchange. You may select a maximum of 10 input modules.

Input and output modules

Module number  Module name Type Size (bytes) Comments
1 Device Status Input 1 * 0 = Good data
*1 = Bad data
2 Mass Flow Input 4
3 Mass Total Input 4
4 Mass Inventory Input 4
5 Temperature Input 4
6 Density Input 4
7 Volume Flow Input 4 Liquid volume
8 Volume Total Input 4 Liquid volume
9 Volume Inventory Input 4 Liquid volume
10 Drive Gain Input 4
11 GSV Flow Input 4 Gas standard volume
12 GSV Total Input 4 Gas standard volume
13 GSV Inventory Input 4 Gas standard volume
14 API Density Input 4
15 API Volume Flow Input 4
16 API Volume Total Input 4
17 API Volume Inventory Input 4
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Input and output modules continued c
Module number Module name Type Size (bytes) Comments §
18 API Avg Density Input 4 L
19 API Avg Temperature Input 4 8
20 API CTL Input 4 g
21 ED Ref Density Input 4 g:
22 ED Specific Gravity Input 4 A
23 ED Std Vol Flow Input 4
24 ED Std Vol Total Input 4
25 ED Std Vol Inv Input 4
26 ED Net Mass Flow Input 4
27 ED Net Mass Total Input 4
28 ED Net Mass Inv Input 4 §
29 ED Net Vol Flow Input 4 =
30 ED Net Vol Total Input 4 =
31 ED Net Vol Inv Input 4 S
32 ED Concentration Input 4 ‘_E‘
33 ED Baume Input 4 2
34 Ext Pressure Output 4 =
35 Ext Temperature Output 4
36 Start/Stop Totals Output 1 *(0 = Stop
*1 = Start
37 Reset Process Totals Output 1 *0 = No action
*1 = Reset
38 Reset Inv Totals Output 1 *0 = No action
*1 = Reset &
@
5.5 Using the EDD ‘3
When imported into a PROFIBUS host, the EDD controls the organization of specific menus and %
parameters. The menus and parameters controlled by the EDD are shown in Appendix C, Figures C-4 3
through C-12. 5
5.6 Using PROFIBUS bus parameters
Depending on your PROFIBUS host, you may be able to read and write PROFIBUS bus parameters
directly using DP-V1 services. PROFIBUS bus parameters provide direct access to all of the
functionality available through the transmitter’s DP port. PROFIBUS bus parameters are documented
in Appendix D. o
Note that if you choose to configure or use the Model 2400S DP transmitter using PROFIBUS bus -%.
parameters, several kinds of detailed information will be required, for example: B
* The codes used to represent different options (e.g., different measurement units) o
* The bits used to start and stop activities (e.g., totalizers or calibration procedures) or reset u':-;"
totals §_
* The meaning of status bits within status words )

The required information is supplied either in the relevant section in the manual or in Appendix D.

Configuration and Use Manual 23



24

Micro Motion® Model 2400S Transmitters for PROFIBUS-DP



Required Transmitter Configuration

6.1

6.2

Overview

This chapter describes the configuration procedures that are usually required when a transmitter is
installed for the first time.

The following procedures are discussed:
*  Characterizing the flowmeter — see Section 6.2
* Configuring measurement units — see Section 6.3

This chapter provides basic flowcharts for each procedure. For more detailed flowcharts, see the
flowcharts for your communication tool, provided in the appendices to this manual.

For optional transmitter configuration parameters and procedures, see Chapter 8.

Note: All procedures provided in this chapter assume that you have established communication with
the Model 24008 DP transmitter and that you are complying with all applicable safety requirements.

Note: If you are using Pocket ProLink, the interface is similar to the ProLink Il interface described in
this chapter.

Characterizing the flowmeter

Characterizing the flowmeter adjusts the transmitter to compensate for the unique traits of the sensor
it is paired with. The characterization parameters, or calibration parameters, describe the sensor’s
sensitivity to flow, density, and temperature.

6.2.1 When to characterize

If the transmitter and sensor were ordered together, then the flowmeter has already been
characterized. You need to characterize the flowmeter only if the transmitter and sensor are being
paired together for the first time.

6.2.2 Characterization parameters

The characterization parameters that must be configured depend on your flowmeter’s sensor type:
“T-Series” or “Other” (also referred to as “Straight Tube” and “Curved Tube,” respectively), as listed
in Table 6-1. The “Other” category includes all Micro Motion sensors except T-Series.

The characterization parameters are provided on the sensor tag. See Figure 6-1 for illustrations of
sensor tags.
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Required Transmitter Configuration

Sensor calibration parameters

Sensor type

Parameter T-Series Other
K1 v v
K2 v v
FD v v
D1 v v
D2 v v
Temp coeff (DT)™ v/ v
Flowcal /@
FCF v

FTG v

FFQ v

DTG v

DFQ1 v

DFQ2 v

(1) On some sensor tags, shown as TC.
(2) See the section entitled “Flow calibration values.”

Sample calibration tags

T-Series Other sensors
4 N\ (’ ™
MODEL T100T628SCAZEZZZZ S/N 1234567890 MODEL
FLOW FCF XXXX.XX.XX
FTG X.XX FFQ X . XX S/N
DENS D1 X.XXXXX K1 XXXXX . XXX FLOW CALx 19.0005.13
D2 X.XCKKK K2 X000C XXX DENS CAL+ 12500142864 .44
evp RANGI>E< X?xx T(ED)F%(X Cxx.xx DFQ2 X.XX D10.0010 kK1 12502.000
TUBE* CONN#* CASEx D20.9980 K2 14282.000
XXXX  XXXXX  XXXX XXXXXX TC4.44000 Fp 310
* MAXIMUM PRESSURE RATING AT 25:0. ACCORDING TO ASME B31.3 § TEMP RANGE TO C
\ 4+ MAXIMUM PRESSURE RATING AT 25°C, ACCORDING TO ANSI/ASME B16.5, OR MFR'S RATING j TUBE** CONN*** CASE**
: %m’#&‘éﬁﬁr%‘ﬁ'ﬁ c, Awgmmc TO ASME B31.3

26

\ = MAXINUM PRESSURE RATING AT 25, ACCORDING TO ANSI/ASME B16.5 OR MFR'S RATING

Flow calibration values
Two factors are used to define flow calibration:
*  The flow calibration factor, which is a 6-character string (five numbers and a decimal point)

* The temperature coefficient for flow, which is a 4-character string (three numbers and a
decimal point)

These values are concatenated on the sensor tag, but different labels are used for different sensors. As
shown in Figure 6-1:

e For T-Series sensors, the value is called the FCF value.

¢ For other sensors, the value is called the Flow Cal value.
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When configuring the flow calibration factor:

* Using ProLink II, enter the concatenated 10-character string exactly as shown, including the
decimal points. For example, using the Flow Cal value from Figure 6-1, enter 19.0005.13.

* Using other methods, you may be required to enter the concatenated value, or you may be
required to enter the two factors separately, i.e., enter a 6-character string and a 4-character
string. Include the decimal point in both strings. For example, using the Flow Cal value from
Figure 6-1:

- Enter 19.000 for the flow calibration factor.

- Enter 5.13 for the temperature coefficient for flow.

6.2.3 How to characterize
To characterize the flowmeter:
1. See the menu flowcharts in Figure 6-2.
2. Ensure that the correct sensor type is configured.

3. Set required parameters, as listed in Table 6-1.
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6.3

28

Characterizing the flowmeter

ProLink Il

ProLink >
Configuration

Device
- Sensor type

___ Straight 2 Curved
tube Sensor type? tube

—{ Flow ‘ ‘ Flow

—{ Density ‘ ‘ Density

—+ T Series Config ‘

PROFIBUS host with bus parameters®

Block: Device Information (Slot 4)

S t
ensor type Index 8 (sensor type code)

Block: Calibration (Slot 2)
—>» Index 4 (flow calibration factor, first six characters)
Index 5 (flow calibration factor, last four characters)

Flow values

Block: Calibration (Slot 2)
Index 16 (D1)
Index 17 (D2)
Index 18 (FD)

Index 26 (DTC)

; (]
Density values™ —»»| Index 27 (FTG)

Index 28 (FFQ)
Index 29 (DTG)
Index 30 (DFQ1)
Index 31 (DFQ2)

Configuring the measurement units

PROFIBUS host with EDD

MMI Coriolis Flow >
Configuration parameters

Sensor
- Sensor type code

—>{ T-Series!" ‘

(1) Required only for T-Series sensors.

(2) For details on bus parameters, see Tables D-5 and
D-3.

(3) Youwill configure only a subset of the density values,
depending on sensor type.

For each process variable, the transmitter must be configured to use the measurement unit appropriate

to your application.

To configure measurement units, see the menu flowcharts in Figure 6-3. For details on measurement
units for each process variable, see Sections 6.3.1 through 6.3.4.

The measurement units used for totalizers and inventories are assigned automatically, based on the
measurement unit configured for the corresponding process variable. For example, if kg/hr (kilograms
per hour) is configured for mass flow, the unit used for the mass flow totalizer and mass flow
inventory is kg (kilograms). Codes used for the totalizer measurement units are listed in Tables D-10

through D-12.

Note: Pressure unit configuration is required only if you are using pressure compensation (see
Section 9.2) or you are using the Gas Wizard and you need to change the pressure units (see

Section 8.2.1).
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Figure 6-3  Configuring measurement units

ProLink Il PROFIBUS host with EDD
ProLink > MMI Coriolis Flow >
Configuration Configuration parameters

Flow!” —{ Flow® ‘

Densit: Flow > GSV >
Y | GSV Process Variables®

Temperature —% Density ‘

—» Pressure —+ Temperature ‘

—»{ Pressure ‘

Display PROFIBUS host with bus parameters®

.| Block: Measurement (Slot 1)
Index 5

X
[1]
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=
(1]
Q
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Off-line maint >

Off-line config Mass flow unit

A\
A

A 4

‘ Units

_| Block: Measurement (Slot 1)
Index 7

A\
A

Temperature unit

Mass

'

A 4

_| Block: Measurement (Slot 1)

Densi i >
Vol (or GSV) ensity unit Index 9
A 4
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» Temperature v
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A 4
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A\ 4
4

(1) Used for mass flow, liquid volume flow, and gas standard volume flow.

(2) Used for mass flow and liquid volume flow.

(3) Used for gas standard volume flow.

(4) Set parameters to the desired Unit Code, as listed in Tables 6-2 through 6-7. See Tables D-2 and D-3 if
required.
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6.3.1 Mass flow units

The default mass flow measurement unit is g/s. See Table 6-2 for a complete list of mass flow
measurement units.

Mass flow measurement units

Mass flow unit

Display ProLink Il EDD label EDD code Unit description

G/S a/s g_per_s 1318 Grams per second

G/MIN g/min g_per_min 1319 Grams per minute

G/H g’hr g_per_hr 1320 Grams per hour

KG/S kg/s kg_per_s 1322 Kilograms per second

KG/MIN kg/min kg_per_min 1323 Kilograms per minute

KG/H kag/hr kg_per_hr 1324 Kilograms per hour

KG/D kg/day kg_per_day 1325 Kilograms per day

T/MIN mTon/min t_per_min 1327 Metric tons per minute

T/H mTon/hr t_per_hr 1328 Metric tons per hour

T/D mTon/day t_per_day 1329 Metric tons per day

LB/S Ibs/s Ib_per_s 1330 Pounds per second

LB/MIN Ibs/min Ib_per_min 1331 Pounds per minute

LB/H Ibs/hr Ib_per_hr 1332 Pounds per hour

LB/D Ibs/day Ib_per_day 1333 Pounds per day

ST/MIN sTon/min Ston_per_min 1335 Short tons (2000 pounds) per minute
STH sTon/hr Ston_per_hr 1336 Short tons (2000 pounds) per hour
ST/D sTon/day Ston_per_day 1337 Short tons (2000 pounds) per day
LT/H ITon/hr Lton_per_hr 1340 Long tons (2240 pounds) per hour
LT/D ITon/day Lton_per_day 1341 Long tons (2240 pounds) per day

30

6.3.2 Volume flow units
The default volume flow measurement unit is I/s (liters per second).
Two different sets of volume flow measurement units are provided:

*  Units typically used for liquid volume — see Table 6-3

*  Units typically used for gas standard volume — see Table 6-4

If you are using ProLink II or the display, only liquid volume flow units are listed by default. To
access the gas standard volume flow units, you must first configure the volume flow type: liquid or
gas standard.

If you want to measure gas standard volume flow, additional configuration is required. See Section 8.2
for more information.
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Volume flow measurement units — Liquid

Volume flow unit

Display ProLink Il EDD label EDD code Unit description
CUFT/S ft3/sec CFS 1356 Cubic feet per second
CUF/MN ft3/min CFM 1357 Cubic feet per minute
CUFT/H ft3/hr CFH 1358 Cubic feet per hour
CUFT/D ft3/day ft3_per_day 1359 Cubic feet per day

M3/S m3/sec m3_per_s 1347 Cubic meters per second
M3/MIN m3/min m3_per_min 1348 Cubic meters per minute
M3/H m3/hr m3_per_hr 1340 Cubic meters per hour
M3/D m3/day m3_per_day 1350 Cubic meters per day
USGPS US gal/sec gal_per_s 1362 U.S. gallons per second
USGPM US gal/min GPM 1363 U.S. gallons per minute
USGPH US gal/hr gal_per_hour 1364 U.S. gallons per hour
USGPD US gal/d gal_per_day 1365 U.S. gallons per day
MILG/D mil US gal/day Mgal_per_day 1366 Million U.S. gallons per day
L/S I/sec L_per_s 1351 Liters per second

L/MIN I/min L_per_min 1352 Liters per minute

L/H I/hr L_per_hr 1353 Liters per hour

MILL/D mil I/day MI_per_day 1355 Million liters per day
UKGPS Imp gal/sec ImpGal_per_s 1367 Imperial gallons per second
UKGPM Imp gal/min ImpGal_per_min 1368 Imperial gallons per minute
UKGPH Imp gal/hr ImpGal_per_hr 1369 Imperial gallons per hour
UKGPD Imp gal/day ImpGal_per_day 1370 Imperial gallons per day
BBL/S barrels/sec bbl_per_s 1371 Barrels per second™
BBL/MN barrels/min bbl_per_min 1372 Barrels per minute™
BBL/H barrels/hr bbl_per_hr 1373 Barrels per hour”

BBL/D barrels/day bbl_per_day 1374 Barrels per day'”

BBBL/S Beer barrels/sec  Beer_bbl_per_s 1642 Beer barrels per second®
BBBL/MN Beer barrels/min  Beer_bbl_per_min 1643 Beer barrels per minute®
BBBL/H Beer barrels/nr  Beer_bbl_per_hr 1644 Beer barrels per hour®
BBBL/D Beer barrelsday  Beer_bbl_per_day 1645 Beer barrels per day®

(1) Unit based on oil barrels (42 U.S. gallons).
(2) Unit based on U.S. beer barrels (31 U.S. gallons).
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Required Transmitter Configuration

Volume flow measurement units — Gas

Volume flow unit

Display ProLink Il EDD label EDD code Unit description

NM3/S Nm3/sec Nm3_per_s 1522 Normal cubic meters per second
NM3/MN Nm3/min Nm3_per_min 1523 Normal cubic meters per minute
NM3/H Nm3/hr Nm3_per_hr 1524 Normal cubic meters per hour
NM3/D Nm3/day Nm3_per_day 1525 Normal cubic meters per day
NLPS NLPS NL_per_s 1532 Normal liter per second

NLPM NLPM NL_per_min 1533 Normal liter per minute

NLPH NLPH NL_per_hr 1534 Normal liter per hour

NLPD NLPD NL_per_day 1535 Normal liter per day

SCFS SCFS SCFS 1604 Standard cubic feet per second
SCFM SCFM SCFM 1360 Standard cubic feet per minute
SCFH SCFH SCFH 1361 Standard cubic feet per hour
SCFD SCFD SCFD 1605 Standard cubic feet per day
SM3/S Sm3/S Sm3_per_s 1527 Standard cubic meters per second
SM3/MN Sm3/min Sm3_per_min 1528 Standard cubic meters per minute
SM3/H Sm3/hr Sm3_per_hr 1529 Standard cubic meters per hour
SM3/D Sm3/day Sm3_per_day 1530 Standard cubic meters per day
SLPS SLPS SL_per_s 1537 Standard liter per second

SLPM SLPM SL_per_min 1538 Standard liter per minute

SLPH SLPH SL_per_hr 1539 Standard liter per hour

SLPD SLPD SL_per_day 1540 Standard liter per day

6.3.3 Density units

The default density measurement unit is g/em3. See Table 6-2 for a complete list of density

measurement units.

Density measurement units

Density unit

Display ProLink Il EDD label EDD code Unit description
G/CM3 g/cm3 g_per_cm3 1100 Grams per cubic centimeter
G/L gl g_per_L 1105 Grams per liter
G/ML g/ml g_per_ml 1104 Grams per milliliter
KG/L kg/l kg_per_L 1103 Kilograms per liter
KG/M3 kg/m3 kg_per_m3 1097 Kilograms per cubic meter
LB/GAL Ibs/Usgal Ib_per_gal 1108 Pounds per U.S. gallon
LB/CUF Ibs/ft3 Ib_per_ft3 1107 Pounds per cubic foot
LB/CUI lbs/in3 Ib_per_in3 1106 Pounds per cubic inch
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Density measurement units continued

Density unit
Display ProLink Il EDD label EDD code Unit description
ST/CUY sT/yd3 Ston_per_yd3 1109 Short ton per cubic yard
D API degAPI DegAPI 1113 Degrees API
SGU SGU SGU 1114 Specific gravity unit (not temperature
corrected)
6.3.4 Temperature units
The default temperature measurement unit is °C. See Table 6-6 for a complete list of temperature
measurement units.
Temperature measurement units
Temperature unit
Display ProLink Il EDD label EDD code Unit description
°C °C Deg_C 1001 Degrees Celsius
°F °F Deg_F 1002 Degrees Fahrenheit
°R °R Deg_R 1003 Degrees Rankine
°K °K K 1000 Kelvin
6.3.5 Pressure units
The flowmeter does not measure pressure. You need to configure the pressure units if either of the
following is true:
*  You will configure pressure compensation (see Section 9.2). In this case, configure the
pressure unit to match the pressure unit used by the external pressure device.
*  You will use the Gas Wizard, you will enter a reference pressure value, and you need to change
the pressure unit to match the reference pressure value (see Section 8.2).
If you do not know whether or not you will use pressure compensation or the Gas Wizard, you do not
need to configure a pressure unit at this time. You can always configure the pressure unit later.
The default pressure measurement unit is PSI. See Table 6-7 for a complete list of pressure
measurement units.
Pressure measurement units
Pressure unit
Display ProLink I EDD label EDD code Unit description
FTH20 Ft Water @ 68°F ft. H2O @68 DegF 1154 Feet water @ 68 °F
INW4C In Water @ 4°C inch H20 @4 DegC 1147 Inches water @ 4 °C
INW60 In Water @ 60°F inch H20 @60 DegF 1146 Inches water @ 60 °F
INH20 In Water @ 68°F inch H20 @68 DegF 1148 Inches water @ 68 °F
mmW4C mm Water @ 4°C mm H20 @4 DegC 1150 Millimeters water @ 4 °C
mmH20 mm Water @ 68°F mm H20 @68 DegF 1151 Millimeters water @ 68 °F
mmHG mm Mercury @ 0°C  mm Hg @0 DegC 1158 Millimeters mercury @ 0 °C
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Required Transmitter Configuration

Pressure measurement units continued

Pressure unit

Display ProLink I EDD label EDD code Unit description

INHG In Mercury @ 0°C inch Hg @0 DegC 1156 Inches mercury @ 0 °C

PSI PSI psi 1141 Pounds per square inch

BAR bar bar 1137 Bar

mBAR millibar milibar 1138 Millibar

G/SCM g/cm2 g_per_cm2 1144 Grams per square centimeter
KG/SCM kg/cm2 kg_per_cm2 1145 Kilograms per square centimeter
PA pascals Pa 1130 Pascals

KPA Kilopascals KiloPa 1133 Kilopascals

MPA megapascals MegaPa 1132 Megapascals

TORR Torr @ 0C torr @0 DegC 1139 Torr @ 0 °C

ATM atms atm 1140 Atmospheres

34
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1.2

Overview

This chapter describes how to use the transmitter in everyday operation. The following topics and
procedures are discussed:

* Using the I&M functions — see Section 7.2

* Recording process variables — see Section 7.3

*  Viewing process variables — see Section 7.4

* Using the LEDs — see Section 7.5

*  Viewing transmitter status and alarms — see Section 7.6
* Handling status alarms — see Section 7.7

* Viewing and using the totalizers and inventories — see Section 7.8

Note: All procedures provided in this chapter assume that you have established communication with
the Model 24008 DP transmitter and that you are complying with all applicable safety requirements.

Note: If you are using Pocket ProLink, the interface is similar to the ProLink Il interface described in
this chapter.

Using the I&M functions

The Model 2400S DP transmitter implements the following PROFIBUS identification and
maintenance (I&M) functions:

e I&MO
e I&M1

as specified in Profile Guidelines Part 1: Identification & Maintenance Functions Version 1.1.1,
March 2005.

The I&M functions contain a variety of device and manufacturer information. Two of the &M value
are set by the user during installation (see Section 8.12). The other values, including the Manufacturer
ID, are hard-coded. The Manufacturer ID stored on the transmitter can be used as a code to obtain
current device and manufacturer data from the PROFIBUS web site
(http://www.profibus.com/IM/Man_ID_Table.xml).

The 1&M functions are not accessible via ProLink II or the display. If you are using Siemens Simatic
PDM, v6.0 SP2 or higher is required. Earlier versions do not support I&M functions.
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1.3

1.4

36

To use the I&M functions:
1. Read the data from the transmitter:

* Using a PROFIBUS host with the EDD, connect to the transmitter as a Specialist. See
Figure C-12.

* Using PROFIBUS bus parameters, use the I&M Functions block (see Table D-9). You
must read the entire 64-byte dataset.

2. If desired, log onto the PROFIBUS web site and enter the Manufacturer ID code retrieved
from the transmitter.

Recording process variables

Micro Motion suggests that you make a record of the process variables listed below, under normal
operating conditions. This will help you recognize when the process variables are unusually high or
low, and may help in fine-tuning transmitter configuration.

Record the following process variables:
* Flow rate
e Density
e Temperature
e Tube frequency
*  Pickoff voltage
e Drive gain

To view these values, see Section 7.4. For information on using this information in troubleshooting,
see Section 11.13.

Viewing process variahles

Process variables include measurements such as mass flow rate, volume flow rate, mass total, volume
total, temperature, and density.

You can view process variables with the display (if your transmitter has a display), ProLink II, or a
PROFIBUS host.

Note: If the petroleum measurement application is enabled, two of the API process variables are
averages: Batch Weighted Average Density and Batch Weighted Average Temperature. For both of
these, the averages are calculated for the current totalizer period, i.e., since the last reset of the API
volume totalizer.

7.4A1 With the display

By default, the display shows the mass flow rate, mass total, volume flow rate, volume total,
temperature, density, and drive gain. If desired, you can configure the display to show other process
variables. See Section 8.9.3.

The LCD panel reports the abbreviated name of the process variable (e.g., DENS for density), the
current value of that process variable, and the associated unit of measure (e.g., G/ICM3). See
Appendix E for information on the codes and abbreviations used for display variables.
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To view a process variable with the display, refer to Figure 3-2 and: =
e If Auto Scroll is enabled, wait until the desired process variable appears on the LCD panel. g
» If Auto Scroll is not enabled, Scroll until the name of the desired process variable either: %
s
- Appears on the process variable line, or g
- Begins to alternate with the units of measure 2
»
The display precision can be configured separately for each process variable (see Section 8.9.3). This T
affects only the value shown on the display, and does not affect the actual value as reported by the @
transmitter via digital communications.
Process variable values are displayed using either standard decimal notation or exponential notation:
e Values < 100,000,000 are displayed in decimal notation (e.g., 1234567.8).
e Values > 100,000,000 are displayed using exponential notation (e.g., 1.000E08).
- If the value is less than the precision configured for that process variable, the value is
displayed as O (i.e., there is no exponential notation for fractional numbers). E
- If the value is too large to be displayed with the configured precision, the displayed %
precision is reduced (i.e., the decimal point is shifted to the right) as required so that the g
value can be displayed. )
&
=
7.4.2  With ProLink Il =
=]

The Process Variables window opens automatically when you first connect to the transmitter. This
window displays current values for the standard process variables (mass, volume, density,
temperature, external pressure, and external temperature).

To view the standard process variables with ProLink II, if you have closed the Process Variables
window, click ProLink > Process Variables.

To view API process variables (if the petroleum measurement application is enabled), click ProLink >
API Process Variables.

To view enhanced density process variables (if the enhanced density application is enabled), click
ProLink > ED Process Variables. Different enhanced density process variables are displayed,
depending on the configuration of the enhanced density application.
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743 With a PROFIBUS host and the EDD
If you are using a PROFIBUS host with the EDD:

e Use the View menu (see Figure C-5) to view the standard process variables. Gas standard
volume, API, and enhanced density process variables are not displayed.

*  Use the Device menu (see Figure C-6) to view all process variables.

14.4 With a PROFIBUS host and the GSD

If you are using a PROFIBUS host with the GSD, you must import the desired input modules to your
PROFIBUS host (see Section 5.4). The selected process variables will be available for viewing at the
PROFIBUS host.

uoneinbyuo jeuondo
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7.4.5 With PROFIBUS bus parameters
To read process variable data with PROFIBUS bus parameters:
*  For petroleum measurement process variables, use the API block (see Table D-7)
» For enhanced density process variables, use the Enhanced Density block (see Table D-8)

* For all other process variables, use the Measurement block (see Table D-2)

1.5 Using the LEDs
The user interface module provides three LEDs: a status LED, a network LED, and a software address
LED (see Figures 3-1 and 3-2).
*  For transmitters with a display, the LEDs can be viewed with the transmitter housing cover in
place.
*  For transmitters without a display, the transmitter housing cover must be removed to view the
LEDs (see Section 3.3).
For information on:
e Using the network LED, see Section 7.5.1.
*  Using the software address LED, see Section 7.5.2.
»  Using the status LED, see Section 7.6.1.
7.5.1 Using the network LED
Table 7-1 lists the different states of the network LED and defines each state.
Network LED states, definitions, and recommendations
Network LED state Definition Comments
Off Device not online The PROFIBUS-DP communication channel is not
connected to any host system. Check the host
configuration and the wiring, and retry the
connection.
Solid green Device online and connected The device is in data exchange with a Class 1
master or is being configured by a Class 2 master.
No action is required.
Flashing green Device online but not connected The device has detected the network baud rate, but
communication with a host has not been established.
Solid red Communication error Check for any of the following PROFIBUS

communication issues: Invalid Parameterization,
Invalid Configuration, Invalid Slot, Invalid Index,
Invalid C2 Acyclic Communication Initiate Telegram.

38

71.5.2 Using the software address LED
Table 7-2 lists the different states of the software address LED and defines each state.
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Software address LED states, definitions, and recommendations

Software address LED state Definition

Off Device is in hardware addressing mode.

Solid red Device is in software addressing mode but address has not been set by host.

Solid green Device is in software addressing mode and address has been set by host.
7.6 Viewing transmitter status

You can view transmitter status using the status LED, ProLink II, a PROFIBUS host using the EDD,
or PROFIBUS bus parameters. Depending on the method chosen, different information is displayed.

7.6.1 Using the status LED

The status LED shows transmitter status as described in Table 7-3. Note that the status LED does not
report event status or alarm status for alarms with severity level set to Ignore (see Section 8.8).

Transmitter status LED

Status LED state Alarm priority Definition

Green No alarm Normal operating mode

Flashing yellow A104 alarm Zero or calibration in progress

Yellow Low severity (information) alarm ¢ Alarm condition: will not cause measurement error

* Digital communications report process data

Red

High severity (fault) alarm * Alarm condition: will cause measurement error
* Digital communications go to configured fault
action (see Section 8.10.7)

7.6.2 Using ProLink Il

ProLink II provides a Status window that displays:
¢ Device (alarm) status
* Event status

¢ Assorted other transmitter data

7.6.3 Using a PROFIBUS host and the EDD

Status information is located in the View menu (see Figure C-5) and the Device menu (see Figures
C-6 and C-7). The View menu displays alarm status. The Device menu displays:

e Alarm status
¢ Event status

*  Meter and core processor diagnostics

7.6.4 Using PROFIBUS hus parameters

Status information is located in the Diagnostic block (see Table D-4).
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1.7 Handling status alarms
Specific process or flowmeter conditions cause status alarms. Each status alarm has an alarm code.

Status alarms are classified into three severity levels: Fault, Information, and Ignore. Severity level
controls how the transmitter responds to the alarm condition.

Note: Some status alarms can be reclassified, i.e., configured for a different severity level. For
information on configuring severity level, see Section 8.8.

Note: For detailed information on a specific status alarm, including possible causes and
troubleshooting suggestions, see Table 11-2. Before troubleshooting status alarms, first acknowledge
all alarms. This will remove inactive alarms from the list so that you can focus troubleshooting efforts
on active alarms.

The transmitter maintains two status flags for each alarm:
* The first status flag indicates current “active” or “inactive” status.
* The second status flag indicates current “acknowledged” or “unacknowledged” status.

In addition, the transmitter maintains alarm history for the 50 most recent alarm occurrences. Alarm
history includes:

e The alarm code

e The “alarm active” timestamp

e The “alarm inactive” timestamp

e The “alarm acknowledged” timestamp

When the transmitter detects an alarm condition, it checks the severity level of the specific alarm and
performs the actions described in Table 7-4.

Transmitter responses to status alarms

Transmitter response

Alarm severity Digital communications
level® Status flags Alarm history fault action
Fault *“Alarm active” status flag set “Alarm active” record Activated after configured fault
immediately written to alarm history timeout has expired (if
¢ “Alarm unacknowledged” status immediately applicable)®
flag set immediately
Informational *“Alarm active” status flag set “Alarm active” record Not activated
immediately written to alarm history

e “Alarm unacknowledged” status ~ immediately
flag set immediately

Ignore *“Alarm active” status flag set No action Not activated
immediately
¢ “Alarm unacknowledged” status
flag set immediately

(1) See Section 8.8 for information on setting the alarm severity level.
(2) See Sections 8.10.7 and 8.10.8 for more information on digital communications fault action and fault timeout.
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When the transmitter detects that the alarm condition has cleared:
* The first status flag is set to “inactive.”
» Digital communications fault action is deactivated (Fault alarms only).
e The “alarm inactive” record is written to alarm history (Fault and Informational alarms only).
* The second status flag is not changed.

Operator action is required to return the second status flag to “acknowledged.” Alarm
acknowledgment is optional. If the alarm is acknowledged, the “alarm acknowledged” record is
written to alarm history.

1.71 Using the display

The display shows information only about active Fault or Informational alarms, based on alarm status
bits. Ignore alarms are filtered out, and you cannot access alarm history via the display.

To view or acknowledge alarms using the display menus, see the flowchart in Figure 7-1.

If the transmitter does not have a display, or if operator access to the alarm menu is disabled (see
Section 8.9.5), alarms can be viewed and acknowledged using ProLink II, a PROFIBUS host with the
EDD, or PROFIBUS bus parameters. Alarm acknowledgment is optional.

Additionally, the display may be configured to enable or disable the Ack All function. If disabled, the
Ack All screen is not displayed and alarms must be acknowledged individually.
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Viewing and acknowledging alarms with the display

Scroll and Select simultaneously
for 4 seconds

v

SEE ALARM ‘

‘ ACK ALL™" ‘

(1)

Active/
unacknowledged
alarms?

Y

No

}

This screen is displayed only if the ACK AL

function is enabled (see Section 8.9.5) and

there are unacknowledged alarms.

Alarm code NO ALARM
‘ ACK ‘ ‘ EXIT ‘

1.1.2 Using ProLink I
ProLink II provides two ways to view alarm information:

The Status window

The Alarm Log window

Status window

The Status window displays the current status of the alarms considered to be most useful for

information, service, or troubleshooting, including Ignore alarms.

The Status window reads alarm

status bits, and does not access alarm history. The Status window does not display acknowledgment
information, and you cannot acknowledge alarms from the Status window.
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In the Status window:

* Alarms are organized into three categories: Critical, Informational, and Operational. Each
category is displayed on a separate panel.

* If one or more alarms is active on a panel, the corresponding tab is red.
* Onapanel, a green LED indicates “inactive” and a red LED indicates “active.”
Note: The location of alarms on the Status panels is pre-defined, and is not affected by alarm severity.
To use the Status window:
1. Click ProLink > Status.

2. Click the tab for the alarm category you want to view.

Alarm Log window
The Alarm Log window selects information from alarm history, and lists all alarms of the following
types:
e All active Fault and Information alarms
*  All inactive but unacknowledged Fault and Information alarms
Ignore alarms are never listed.
You can acknowledge alarms from the Alarm Log window.
In the Alarm Log window:

* The alarms are organized into two categories: High Priority and Low Priority. Each category is
displayed on a separate panel.

e Onapanel, a green LED indicates “inactive but unacknowledged” and a red LED indicates
“active.”

Note: The location of alarms on the Alarm Log panels is pre-defined, and is not affected by alarm
severity.

To use the Alarm Log window:
1. Click ProLink > Alarm Log.
2. Click the tab for the alarm category you want to view.

3. To acknowledge an alarm, click the Ack checkbox. When the transmitter has processed the
command:

- If the alarm was inactive, it will be removed from the list.

- If the alarm was active, it will be removed from the list as soon as the alarm condition
clears.

1.7.3 Using a PROFIBUS host with the EDD

If you are using a PROFIBUS host with the EDD, alarm information can be viewed in the Alarm
Status window. You can open the Alarm Status window in either of the following ways:

* By clicking Device > Device > Alarm Status
* By clicking View > Display > Alarm Status
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The Alarm Status window displays the current status of the alarms considered to be most useful for
information, service, or troubleshooting, including Ignore alarms. Active alarms are indicated with a
check.

Note: The Alarm Status window reads alarm status bits, and does not access alarm history.

You can use the Alarm Status window to acknowledge a single alarm or to acknowledge all alarms. To
acknowledge a single alarm:

1. Set the Acknowledge Alarm control to the alarm you want to acknowledge.
2. Send the command to the transmitter.

To acknowledge all alarms:
1. Set the Acknowledge All Alarms control to Acknowledge.

2. Send the command to the transmitter.

1.7.4 Using PROFIBUS bus parameters

Using PROFIBUS bus parameters, you can use the Diagnostic block to view the status of a group of
preselected alarms, view information about a specific alarm, acknowledge a single alarm or all alarms,
and retrieve information from alarm history. See Table D-4.

To view the status of a group of preselected alarms, use Indices 10-17.
Note: These are the same alarms that are displayed in the ProLink II Status window.

To view information about a single alarm:
1. Set Index 20 to the code of the alarm you want to check.
2. Read Index 22, and interpret the data using the following codes:
e 0x00 = Acknowledged and cleared
e 0x01 = Active and acknowledged
e 0x10 = Not acknowledged, but cleared
e 0x11 = Not acknowledged, and active
3. Other information about the indexed alarm is available in the following locations:
e Index 23: Number of times this alarm has become active
e Index 24: The time this alarm was last posted
* Index 25: The time this alarm was last cleared
To acknowledge a single alarm:
1. Set Index 20 to the code of the alarm you want to check.
2. Write a value of 0 to Index 22.
To acknowledge all alarms, write a value of 1 to Index 30.
To retrieve information from alarm history:
1. Set Index 26 to specifying the number of the alarm record you want to check. Valid values are

0-49.

Note: The alarm history is a circular buffer, and older records are overwritten by newer records. To
determine whether a record is newer or older than another record, you must compare their
timestamps.
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1.8

2. Read the following values:
e Index 27: The alarm type
* Index 29: The time that this alarm changed status
* Index 28: The type of status change:
- 1= Alarm posted

- 2 =Alarm cleared

Using the totalizers and inventories

The totalizers keep track of the total amount of mass or volume measured by the transmitter over a
period of time. The totalizers can be started and stopped, and the totals can be viewed and reset.

The inventories track the same values as the totalizers. Whenever totalizers are started or stopped, all
inventories (including the API volume inventory and enhanced density inventories) are started or
stopped automatically. However, when totalizers are reset, inventories are not reset automatically —
you must reset inventories separately. This allows you to use the inventories to keep running totals
across multiple totalizer resets.

The transmitter can store totalizer and inventory values up to 2%, Values larger than this cause the
internal totalizer to go into overflow.

7.8.1 Viewing current totals for totalizers and inventories

You can view current totals for the totalizers and inventories with the display (if your transmitter has a
display), ProLink II, a PROFIBUS host, or PROFIBUS bus parameters.

With the display

You cannot view current totals with the display unless the display has been configured to show them.
See Section 8.9.3.

To view a totalizer or inventory value, refer to Figure 7-2 and:
1. Check for the word TOTAL in the lower left corner of the LCD panel.

e If Auto Scroll is enabled, wait until the desired value appears on the LCD panel. You can
also Scroll until the desired value appears.

e If Auto Scroll is not enabled, Scroll until the desired value appears.
2. Refer to Table 7-5 to identify the process variable and unit of measure.

3. Read the current value from the top line of the display.

Totalizer and inventory values on display

Process variable Display behavior

Mass total Unit of measure displayed; no alternation
Mass inventory Unit of measure alternates with MASSI
Volume total (liquid) Unit of measure displayed; no alternation
Volume inventory (liquid) Unit of measure alternates with LVOLI
Gas standard volume total Unit of measure displayed; no alternation
Gas standard volume inventory Unit of measure alternates with GSV |
API corrected volume total Unit of measure alternates with TCORR
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Totalizer and inventory values on display continued

Process variable Display behavior

API corrected volume inventory Unit of measure alternates with TCORI
ED net mass total Unit of measure alternates with NET M
ED net mass inventory Unit of measure alternates with NETMI
ED net volume total Unit of measure alternates with NET V
ED net volume inventory Unit of measure alternates with NETVI
ED standard volume total Unit of measure alternates with STD V
ED standard volume inventory Unit of measure alternates with STDVI

Totalizer and inventory values on display

Current value

TOTAL

S/W_ADDR

Unit of measure

NE TWORK

Scroll optical switch
Select optical switch

With ProLink Il
To view current totals for the totalizers and inventories with ProLink II:
1. Click ProLink.
2. Select Process Variables, APl Process Variables, or ED Process Variables.

With a PROFIBUS host and the EDD
If you are using a PROFIBUS host with the EDD:

*  Use the View menu (see Figure C-5) to view the standard totals and inventories. Totals for gas
standard volume, API, and enhanced density process variables are not displayed.

*  Use the Device menu (see Figure C-6) to view all total and inventory values.

With a PROFIBUS host and the GSD

If you are using a PROFIBUS host with the GSD, you must import the desired input modules to your
PROFIBUS host (see Section 5.4). The selected process variables will be available for viewing at the
PROFIBUS host.
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With PROFIBUS bus parameters

To view current totals for the totalizers and inventories using PROFIBUS bus parameters, see
Section 7.4.5.

7.8.2 Controlling totalizers and inventories

Specific starting, stopping, and resetting functionality depends on the tool you are using.

1SOH SNgId0Hd e bBuisn

With the display

If the required value is shown on the display, you can use the display to start and stop all totalizers
and inventories simultaneously, or to reset individual totalizers. See the flowchart in Figure 7-3. You
cannot reset any inventories with the display.

Controlling totalizers and inventories with the display

Process variable
display

API total®

‘ Mass total™ Volume total” Scroll

ED total™®

uoneinbiuo) palinbay

Select

E1-SP®

Scroll Scroll

4 STOP/START®® r{ RESET®"

i

E2--SP®

‘ STOP/START YES? ‘ ‘ RESET YES? ‘
rYesJ—NoT rYesJ—NoT

[ Select ] [ Scroll ] [ Select ] l Scroll ]
v v v v

(1) Displayed only if configured as a display variable.

(2) The petroleum measurement application or enhanced density application must be enabled.

(3) The Event Setpoint screens can be used to define or change Setpoint A for Event I or Event 2 only. These screens are displayed
only for specific types of events. To reset the setpoint for an event defined on mass total, you must enter the totalizer management
menu from the mass total screen. To reset the setpoint for an event defined on volume total, you must enter the totalizer
management menu from the volume total screen. See Section 8.6.3 for more information.

(4) The display must be configured to allow stopping and starting. See Section 8.9.5.

(5) All totalizers and inventories will be stopped and started together, including API and enhanced density totalizers and inventories.

(6) The display must be configured to allow totalizer resetting. See Section 8.9.5.

(7) Only the totalizer currently shown on the display will be reset. No other totalizers will be reset, and no inventories will be reset.
Be sure that the totalizer you want to reset is displayed before performing this reset.
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With ProLink Il

The totalizer and inventory control functions available with ProLink II are listed in Table 7-6. Note
the following:

*  ProLink II does not support separate resetting of the API volume totalizer and API volume
inventory. To reset these, you must reset all totalizers or all inventories.

* By default, the ability to reset inventories from ProLink II is disabled. To enable it:
a. Click View > Preferences.
b. Check the Enable Inventory Totals Reset checkbox.
c. Click Apply.

Totalizer and inventory control functions supported by ProLink Il

Inventory reset

Object Function Disabled Enabled
Totalizers and Starting and stopping as a group v v
inventories
Totalizers Resetting all v v

Resetting mass totalizer separately v v

Resetting volume totalizer separately v v

Resetting enhanced density totalizers separately v v

Resetting API volume totalizer separately Not supported Not supported
Inventories Resetting all v

Resetting mass inventory separately v

Resetting volume inventory separately v

Resetting enhanced density inventories separately v

Resetting API volume inventory separately Not supported Not supported

To start or stop all totalizers and inventories:

1. Click ProLink > Totalizer Control or ProLink > ED Totalizer Control (if the enhanced
density application is enabled).

2. Click the All Totals Start or All Totals Stop button.

Note: The All Totals functions are replicated in these two windows for convenience. You can start or
stop all totalizers and inventories from either window.

To reset all totalizers:

1. Click ProLink > Totalizer Control or ProLink > ED Totalizer Control (if the enhanced
density application is enabled).

2. Click the All Totals Reset button.
To reset all inventories:

1. Click ProLink > Totalizer Control or ProLink > ED Totalizer Control (if the enhanced
density application is enabled).

2. Click the All Totals Reset Inventories button.
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To reset an individual totalizer or inventory: =
1. Click ProLink > Totalizer Control or ProLink > ED Totalizer Control (if the enhanced ]
density application is enabled). %
2. Click the appropriate button (e.g., Reset Mass Total, Reset Volume Inventory, Reset Net 3
Mass Total). %
@
With a PROFIBUS host and the EDD T
If you are using a PROFIBUS host with the EDD, you can use the Device window to stop and start all 2
totalizers and inventories together; reset all totalizers together; reset all inventories together; or reset
standard, API, or enhanced density totals and inventories separately. See Figure C-6.
With a PROFIBUS host and the GSD
If you are using a PROFIBUS host with the GSD, output modules 36, 37, and 38 are used for totalizer
and inventory control. You can start and stop all totalizers and inventories together, reset all totalizers o
together, or reset all inventories together. To use these output modules: §
1. Import them to your PROFIBUS host. 8
2. Send the appropriate Reset command to the transmitter. o
=]
With PROFIBUS bus parameters %
The totalizer and inventory control functions available with PROFIBUS bus parameters are listed in §'

Table 7-7.

Totalizer and inventory control with PROFIBUS bus parameters

To accomplish this Use

Stop all totalizers and inventories Measurement block (Slot 1)
Index: 22
Value: 0

Start all totalizers and inventories Measurement block (Slot 1)
Index: 22
Value: 1

Reset all totalizers Measurement block (Slot 1)
Index: 23
Value: 1
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Reset all inventories Measurement block (Slot 1)
Index: 24
Value: 1

Reset mass totalizer Measurement block (Slot 1)
Index: 25
Value: 1

Reset mass inventory Measurement block (Slot 1)
Index: 43
Value: 1

Reset liquid volume totalizer Measurement block (Slot 1)
Index: 26
Value: 1

Reset liquid volume inventory Measurement block (Slot 1)
Index: 44
Value: 1

Reset gas standard volume totalizer Measurement block (Slot 1)
Index: 41
Value: 1

uoneinbyuo jeuondo

Configuration and Use Manual 49



Using the Transmitter

Totalizer and inventory control with PROFIBUS bus parameters continued

To accomplish this

Use

Reset gas standard volume inventory

Measurement block (Slot 1)
Index: 42
Value: 1

Reset API reference volume total

API block (Slot 6)
Index: 11
Value: 1

Reset API reference volume inventory

API block (Slot 6)
Index: 12
Value: 1

Reset ED standard volume total

Enhanced Density block (Slot 7)
Index: 17
Value: 1

Reset ED net mass total

Enhanced Density block (Slot 7)
Index: 18
Value: 1

Reset ED net volume total

Enhanced Density block (Slot 7)
Index: 19
Value: 1

Reset ED standard volume inventory

Enhanced Density block (Slot 7)
Index: 20
Value: 1

Reset ED net mass inventory

Enhanced Density block (Slot 7)
Index: 21
Value: 1

Reset ED net volume inventory

Enhanced Density block (Slot 7)
Index: 22
Value: 1
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8.1 Overview

This chapter describes transmitter configuration parameters that may or may not be used, depending
on your application requirements. For required transmitter configuration, see Chapter 6.

Table 8-1 lists the parameters that are discussed in this chapter. Default values and ranges for the most

commonly used parameters are provided in Appendix A. §
Note: All procedures provided in this chapter assume that you have established communication with %‘
the Model 24008 DP transmitter and that you are complying with all applicable safety requirements. g
Note: If you are using Pocket ProLink, the interface is similar to the ProLink Il interface described in %
this chapter. ‘g
=
Configuration map S
Method
Topic Subtopic ProLink II PROFIBUS host!"  Display Section
Volume flow v v 8.2
measurement for gas
Cutoffs v v 8.3
Damping v v 8.4 &
Flow direction v 4 8.5 ‘-§_
Events v v 8.6 i
Slug flow v v 8.7 )
Status alarm severity v v 8.8 §
Display® Update period v v/ v 8.9.1 5
Display language v v 8.9.2
Disp_la_y variables and v v 8.9.3
precision
LCD panel backlight v v 8.9.4
Totalizer start/stop v v v 8.95
Totalizer reset v v v
Auto scroll 4 v 4 -8
Scroll rate v v/ v §
Offline menu v v v %
Password v v v %
Alarm menu v 4 v ‘g
Ack all v v v =
=]
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Configuration map continued

Method
Topic Subtopic ProLink II PROFIBUS host  Display Section
Digital communication ~PROFIBUS node v® /@ 8.10.1
settings address
IrDA port usage v v v 8.10.2
Modbus address v v 8.10.3
Modbus ASCII support v v 8.104
Floating-point byte v 8.10.5
order
Additional v 8.10.6
communications
response delay
Digital communications v/ v 8.10.7
fault action
Fault timeout 4 v 8.10.8
Device settings v /O 8.11
I&M functions v 8.12
Sensor parameters v v 8.13
Petroleum v v 8.14
measurement
application
Enhanced density v v 8.15
application

(1) Via either the EDD or PROFIBUS bus parameters.

(2) These parameters apply only to transmitters with a display.
(3) Via a Set Slave Address telegram.

(4) Via the address witches on the face of the transmitter.

(5) Via PROFIBUS bus parameters only.

8.2 Configuring volume flow measurement for gas
Two types of volume flow measurement are available:
* Liquid volume (the default)
*  QGas standard volume

Only one type of volume flow measurement can be performed at a time (i.e., if liquid volume flow
measurement is enabled, gas standard volume flow measurement is disabled, and vice versa).
Different sets of volume flow measurement units are available, depending on which type of volume
flow measurement is enabled (see Tables 6-3 and 6-4). If you want to use a gas volume flow unit,
additional configuration is required.

Note: If you will use the petroleum measurement application or the enhanced density application,
liquid volume flow measurement is required.
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The method used to configure volume flow measurement for gas depends on the method you are
using: ProLink II, a PROFIBUS host with the EDD, or PROFIBUS bus parameters. In all cases, you

must:

Enable gas standard volume flow
Select the measurement unit to use
Set the low flow cutoff value

Specify the standard density (density at reference conditions) of your gas

Note: Using the display, you can only select a volume measurement unit from the set available for the
configured volume flow type. You cannot configure any other parameters.

8.21

Using ProLink Il

To configure volume flow measurement for gas using ProLink II:

1.
2.
3.

Click ProLink > Configure > Flow.
Set Vol Flow Type to Std Gas Volume.

Select the measurement unit you want to use from the Std Gas Vol Flow Units dropdown list.
The default is SCFM.

4. Configure the Std Gas Vol Flow Cutoff (see Section 8.3). The default is 0.

. If you know the standard density of the gas that you are measuring, enter it in the Std Gas

Density field. If you do not know the standard density, you can use the Gas Wizard. See the
following section.

Using the Gas Wizard
The Gas Wizard is used to calculate the standard density of the gas that you are measuring.
To use the Gas Wizard:

1.
2.
3.

4.

Click ProLink > Configure > Flow.

Click the Gas Wizard button.

If your gas is listed in the Choose Gas dropdown list:
a. [Enable the Choose Gas radio button.

b. Select your gas.

If your gas is not listed, you must describe its properties.
a. Enable the Enter Other Gas Property radio button.

b. Enable the method that you will use to describe its properties: Molecular Weight,
Specific Gravity Compared to Air, or Density.

c. Provide the required information. Note that if you selected Density, you must enter the
value in the configured density units and you must provide the temperature and pressure at
which the density value was determined.

Note: Ensure that the values entered here are correct, and that fluid composition is stable. If either of
these conditions is not met, gas flow measurement accuracy will be degraded.

5.
6.

Click Next.

Verify the reference temperature and reference pressure. If these are not appropriate for your
application, click the Change Reference Conditions button and enter new values for
reference temperature and reference pressure.
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7. Click Next. The calculated standard density value is displayed.
e If the value is correct, click Finish. The value will be written to transmitter configuration.

» If the value is not correct, click Back and modify input values as required.

Note: The Gas Wizard displays density, temperature, and pressure in the configured units. If required,
you can configure the transmitter to use different units. See Section 6.3.

8.2.2 Using a PROFIBUS host with the EDD
To configure volume flow measurement for gas using a PROFIBUS host with the EDD:
1. Referring to Figure C-8:
a. Enable GSV.
b. Send the command to the transmitter.

c. Configure Gas density value, GSV flow units, GSV total units, and GSV cutoff as
desired.

2. Send the command to the transmitter.

8.2.3 Using PROFIBUS bus parameters
To configure volume flow measurement for gas using PROFIBUS bus parameters:
1. Referring to the Measurement block (Table D-2):
a. Enable gas standard volume measurement (Index 33).
b. Set other gas measurement parameters as desired (Indices 34, 38, and 40).

2. Send the command to the transmitter.

8.3 Configuring cutoffs

Cutoffs are user-defined values below which the transmitter reports a value of zero for the specified
process variable. Cutoffs can be set for mass flow, volume flow, gas standard volume flow, and
density.

See Table 8-2 for cutoff default values and related information. See Section 8.3.1 for information on
how the cutoffs interact with other transmitter measurements.

To configure cutoffs:
* Using ProLink II, see Figure C-2.
* Using a PROFIBUS host with the EDD, see Figure C-8.

*  Using PROFIBUS bus parameters, use the Measurement block (see Table D-2), Indices 18, 19,
20, and 40.

Note: This functionality cannot be configured via the display menus.
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Cutoff default values

Cutoff type Default Comments
Mass flow 0.0g/s Recommended setting: 5% of the sensor’s rated maximum flowrate
Volume flow 0.0L/s Limit: the sensor’s flow calibration factor in liters per second, multiplied by 0.2
Gas standard volume 0.0 SCFM No limit
flow
Density 0.2 g/lcm?® Range: 0.0-0.5 g/cm?
8.3.1 Cutoffs and volume flow
If liquid volume flow is enabled:

* The density cutoff is applied to the volume flow calculation. Accordingly, if the density drops
below its configured cutoff value, the volume flow rate will go to zero.

*  The mass flow cutoff is not applied to the volume flow calculation. Even if the mass flow
drops below the cutoff, and therefore the mass flow indicators go to zero, the volume flow rate
will be calculated from the actual mass flow process variable.

If gas standard volume flow is enabled, neither the mass flow cutoff nor the density cutoff is applied
to the volume flow calculation.
8.4 Configuring the damping values

A damping value is a period of time, in seconds, over which the process variable value will change to
reflect 63% of the change in the actual process. Damping helps the transmitter smooth out small,
rapid measurement fluctuations.

* A high damping value makes the output appear to be smoother because the output must change
slowly.

* A low damping value makes the output appear to be more erratic because the output changes
more quickly.

Damping can be configured for flow, density, and temperature.

When you specify a new damping value, it is automatically rounded down to the nearest valid
damping value. Valid damping values are listed in Table 8-3.

Note: For gas applications, Micro Motion recommends a minimum flow damping value of 2.56.

Before setting the damping values, review Section 8.4.1 for information on how the damping values
affect other transmitter measurements.

To configure damping values:
* Using ProLink II, see Figure C-2.
* Using a PROFIBUS host with the EDD, see Figure C-8.

*  Using PROFIBUS bus parameters, use the Measurement block (see Table D-2), Indices 12, 13,
and 14.

Note: This functionality cannot be configured via the display menus.
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8.5

56

Valid damping values

Process variable Valid damping values

Flow (mass and volume) 0, 0.04, 0.08, 0.16, ... 40.96
Density 0, 0.04, 0.08, 0.16, ... 40.96
Temperature 0,0.6,1.2,2.4,438,...76.8

8.4.1 Damping and volume measurement
When configuring damping values, note the following:

* Liquid volume flow is derived from mass and density measurements; therefore, any damping
applied to mass flow and density will affect liquid volume measurement.

* Gas standard volume flow is derived from mass flow measurement, but not from density
measurement. Therefore, only damping applied to mass flow will affect gas standard volume
measurement.

Be sure to set damping values accordingly.

Configuring the flow direction parameter

The flow direction parameter controls how the transmitter reports flow rate and how flow is added to
or subtracted from the totalizers, under conditions of forward flow, reverse flow, or zero flow.

»  Forward (positive) flow moves in the direction of the arrow on the sensor.

*  Reverse (negative) flow moves in the direction opposite of the arrow on the sensor.
Options for flow direction include:

e Forward only

* Reverse only

*  Absolute value

* Bidirectional

* Negate/Forward only

* Negate/Bidirectional
For the effect of flow direction on flow totals and flow values, see Table 8-4.
To configure flow direction:

*  Using ProLink II, see Figure C-2.

* Using a PROFIBUS host with the EDD, see Figure C-8.

» Using PROFIBUS bus parameters, use the Measurement block (see Table D-2), Index 21.

Note: This functionality cannot be configured via the display menus.
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Effect of flow direction on totalizers and flow values c
2.
Forward flow® S
o
Flow direction value Flow totals Flow values 8
Forward only Increase Positive %
c
Reverse only No change Positive 77}
I
Bidirectional Increase Positive ]
Absolute value Increase Positive®
Negate/Forward only No change Negative
Negate/Bidirectional Decrease Negative
Zero flow
Flow direction value Flow totals Flow values
All No change 0 E
3 =
Reverse flow® 3
o
Flow direction value Flow totals Flow values o
=]
Forward only No change Negative “'-;
c
Reverse only Increase Negative N
Bidirectional Decrease Negative g.
Absolute value Increase Positive®
Negate/Forward only Increase Positive
Negate/Bidirectional Increase Positive
(1) Process fluid flowing in same direction as flow direction arrow on sensor.
(2) Refer to the digital communications status bits for an indication of whether flow is positive or negative.
(3) Process fluid flowing in opposite direction from flow direction arrow on sensor:
c
o,
. . =
8.6 Configuring events =
=2
An event occurs if the real-time value of a user-specified process variable varies above or below a ‘_"|
user-specified value, or inside or outside a user-specified range. You can configure up to five events. §
. . . . . . [0
You may optionally specify one or more actions that will occur if the event occurs. For example, if 3
Event 1 occurs, you may specify that the transmitter will stop all totalizers and inventories and reset g

the mass totalizer.

8.6.1 Defining events
To define an event:
e Using ProLink II, see Figure C-3.
* Using a PROFIBUS host with the EDD, see Figure C-9.
* Using PROFIBUS bus parameters, use the Diagnostic block (see Table D-4).
The following general steps are required:
1. Select the event to define (Diagnostic block, Index 4).

2. Specify the Event Type (Diagnostic block, Index 5). Event Type options are defined in
Table 8-5.

3. Assign a process variable to the event (Diagnostic block, Index 8).
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4. Specify the event’s setpoint(s) — the value(s) at which the event will occur or switch state (ON
to OFF, or vice versa).

» If Event Type is High or Low, only Setpoint A (Diagnostic block, Index 6) is used.

» If Event Type is In Range or Out of Range, both Setpoint A (Diagnostic block, Index 6)
and Setpoint B (Diagnostic block, Index 7) are required.

Note: If a mass or volume total has been assigned to Event 1 or Event 2 and also configured as a
display variable, if the event type is High or Low, and the transmitter is configured to allow resetting
totalizers from the display, you can use the display to define or change the high setpoint (Setpoint A).
See Section 7-3.

5. Assign the event to an action or actions, if desired. Possible actions are listed in Table 8-6. To
do this:

* Using ProLink II, open the Discrete Input panel in the Configuration window, identify the
action to be performed, then specify the event using the dropdown list. See Figure C-3.

Note: For consistency with other Micro Motion products, the Discrete Input panel is used here even
though the Model 2400S DP transmitter does not provide a discrete input.

* Using the display, see Figure C-15 and use the ACT submenu.
* Using a PROFIBUS host with the EDD, see Figure C-10.

* Using PROFIBUS bus parameters, use Index 83 in the Diagnostic block (see Table D-4) to
specify the event, and Index 82 to assign the action.

Event types
Type Description
High (> A) Default. Discrete event will occur if the assigned variable is greater than the setpoint (A).™"
Low (< A) Discrete event will occur if the assigned variable is less than the setpoint (A).™
In Range Discrete event will occur if the assigned variable is greater than or equal to the low setpoint (A) and less

than or equal to the high setpoint (B).®

Out of Range Discrete event will occur if the assigned variable is less than or equal to the low setpoint (A) or greater

than or equal to the high setpoint (B).®

(1) An event does not occur if the assigned variable is equal to the setpoint.
(2) An event occurs if the assigned variable is equal to the setpoint.

Event actions

ProLink Il label Display label EDD label Description

Start sensor zero START ZERO Start Sensor Initiates a zero calibration procedure
Zero

Reset mass total RESET MASS Reset Mass  Resets the value of the mass totalizer to 0
Total

Reset volume total RESET VOL Reset Resets the value of the liquid volume totalizer to 0"
Volume Total

Reset gas std volume total RESET GSV Reset GSV Resets the value of the gas standard volume totalizer
Total to 0®@

Reset API ref vol total RESET TCORR Reset API Resets the value of the API temperature-corrected

Volume Total  volume totalizer to 0©

Reset ED ref vol total RESET STD V Reset ED Resets the value of the ED standard volume totalizer

Volume Total to 0¥
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Table 8-6  Event actions continued

ProLink Il label Display label EDD label  Description
Reset ED net mass total RESET NET M ResetED Net Resets the value of the ED net mass totalizer to 0¥
Mass Total
Reset ED net vol total RESET NET V ResetED Net Resets the value of the ED net volume totalizer to 0®
Volume Total
Reset all totals RESET ALL Reset All Resets the value of all totalizers to 0
Totals
Start/stop all totalization START STOP Start/Stop All  If totalizers are running, stops all totalizers
Totals If totalizers are not running, starts all totalizers
Increment current ED INCR CURVE IncrementED Changes the active enhanced density curve from
curve Curve curve 0 to curve 1, from 1 to 2, etc.?
Start meter verification START VERFY Start Meter Starts a Smart Meter Verification test®
Verification

(1) Displayed only if Volume Flow Type = Liquid.

(2) Displayed only if Volume Flow Type = Gas.

(3) Available only if the petroleum measurement application is installed.
(4) Available only if the enhanced density application is installed.

(5) Applies only to systems with Smart Meter Verification.
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Example Define Discrete Event 1 to be active when the mass flow rate in forward
or backward direction is less than 2 Ib/min or greater than 20 Ib/min.
Additionally, if this occurs, all totalizers should be stopped.

Using ProLink II:
1. Specify Ib/min as the mass flow unit. See Section 6.3.1.
2. Set Flow Direction to Absolute Value. See Section 8.5.
3. Select Event 1.
4. Configure:
e Event Type = Out of Range
¢ Process Variable (PV) = Mass Flow Rate
¢ Low Setpoint (A) =2
e High Setpoint (B) = 20

5. In the Discrete Input panel, open the dropdown list for Start/Stop
All Totalization and select Discrete Event 1.

Using PROFIBUS bus parameters:

1. Specify Ib/min as the mass flow unit. See Section 6.3.1.
2. Set Flow Direction to Absolute Value. See Section 8.5.
3. In the Diagnostic block, set the following attributes:

e Discrete event index (Index 4) =0

e Discrete event action type (Index 5) = 3

¢ Discrete event process variable (Index 8) =0

¢ Discrete event setpoint A (Index 6) = 2

¢ Discrete event setpoint B (Index 7) = 20

e Discrete event assignment (Index 83) = 57

¢ Discrete event action code (Index 82) = 9

8.6.2 Checking and reporting event status
There are several ways that event status can be determined:

* ProLink IT automatically displays event information on the Informational panel of the Status
window, and also in the Output Levels window.

*  For PROFIBUS hosts using the EDD, event status is displayed in the Device menu (see
Figure C-6).

* Using PROFIBUS bus parameters, event status is reported in the Diagnostic block, Index 9
(see Table D-4).

Note: You cannot view event status using a PROFIBUS host with the GSD.
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8.6.3 Changing event setpoints from the display

For Event 1 or Event 2 only, the value of Setpoint A can be changed from the display, under the
following circumstances:

* A mass total, volume total, petroleum measurement total, or enhanced density total must be
assigned to the event.

e The event type must be either High or Low.
* The assigned total must be configured as a display variable (see Section 8.9.3).

e The transmitter must be configured to allow resetting totalizers from the display (see
Section 8.9.5).

Then, to change Setpoint A from the display:

1. Referring to the totalizer management flowchart in Figure 7-3, Scroll to the appropriate
display screen.

2. Select.

3. Enter the new setpoint value. See Section 3.5.5 for instructions on entering floating-point
values with the display.

8.7 Configuring slug flow limits and duration

Slugs — gas in a liquid process or liquid in a gas process — occasionally appear in some applications.
The presence of slugs can significantly affect the process density reading. The slug flow parameters
can help the transmitter suppress extreme changes in process variables, and can also be used to
identify process conditions that require correction.

Slug flow parameters are as follows:

*  Low slug flow limit — the point below which a condition of slug flow will exist. Typically, this
is the lowest density point in your process’s normal density range. Default value is 0.0 g/cm3;
range is 0.0-10.0 g/cm3.

*  High slug flow limit — the point above which a condition of slug flow will exist. Typically, this
is the highest density point in your process’s normal density range. Default value is 5.0 g/cm3;
range is 0.0-10.0 g/cm3.

*  Slug flow duration — the number of seconds the transmitter waits for a slug flow condition
(outside the slug flow limits) to return to normal (inside the slug flow limits). Default value is
0.0 sec; range is 0.0-60.0 sec.

If the transmitter detects slug flow:
* A sslug flow alarm is posted immediately.

*  During the slug duration period, the transmitter holds the mass flow rate at the last measured
pre-slug value, independent of the mass flow rate measured by the sensor. The reported mass
flow rate is set to this value, and all internal calculations that include mass flow rate will use
this value.

o If slugs are still present after the slug duration period expires, the transmitter forces the mass
flow rate to 0, independent of the mass flow rate measured by the sensor. Mass flow rate is
reported as 0 and all internal calculations that include mass flow rate will use 0.

*  When process density returns to a value within the slug flow limits, the slug flow alarm is
cleared and the mass flow rate reverts to the actual measured value.
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To configure slug flow parameters:
* Using ProLink II, see Figure C-2.
* Using a PROFIBUS host with the EDD, see Figure C-8.

* Using PROFIBUS bus parameters, use the Diagnostic block (see Table D-4), Indices 1, 2,
and 3.

Note: This functionality cannot be configured via the display menus.

Note: The slug flow limits must be entered in g/cnr’, even if another unit has been configured for
density. Slug flow duration is entered in seconds. Raising the low slug flow limit or lowering the high
slug flow limit will increase the possibility of slug flow conditions. Conversely, lowering the low slug
flow limit or raising the high slug flow limit will decrease the possibility of slug flow conditions. If
slug flow duration is set to 0, the mass flow rate will be forced to 0 as soon as slug flow is detected.

8.8 Configuring status alarm severity
The 2400S DP transmitter can report faults in the following ways:
*  Setting the “alarm active” status bit
*  Writing an “alarm active” record to alarm history
e Implementing the digital communications fault action (see Section 8.10.7)

Status alarm severity determines which methods the transmitter will use when a specific alarm
condition occurs. See Table 8-8. (For a more extensive discussion of status alarm processing and
handling, see Section 7.7.)

Alarm severity levels and fault reporting

Transmitter action if condition occurs

“Alarm active” “Alarm active” record
Severity level status bit set? written to history? Fault action activated?
Fault Yes Yes Yes
Informational Yes Yes No
Ignore Yes No No

(1) For some alarms, the digital communications fault action will not begin until the fault timeout has expired. To configure fault timeout,
see Section 8.8. Other fault reporting methods occur as soon as the fault condition is recognized. Table 8-8 includes information on
which alarms are affected by the fault timeout.

Some alarms can be reclassified. For example:

*  The default severity level for Alarm A020 (calibration factors unentered) is Fault, but you can
reconfigure it to either Informational or Ignore.

e The default severity level for Alarm A102 (drive over-range) is Informational, but you can
reconfigure it to either Ignore or Fault.

For a list of all status alarms and default severity levels, see Table 8-8. (For more information on
status alarms, including possible causes and troubleshooting suggestions, see Table 11-2.)
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To configure alarm severity: =
* Using ProLink II, see Figure C-3. g
* Using a PROFIBUS host with the EDD, see Figure C-9. %
» Using PROFIBUS bus parameters, use the Diagnostic block (see Table D-4), Indices 20 and .C:E
21. g;
Note: This functionality cannot be configured via the display menus. T
@
Status alarms and severity levels
Default Affected by
Alarm code Message" severity Configurable fault timeout
A001 EEprom Checksum Error (Core Processor) Fault No No
(E)EPROM Checksum Error (CP)
A002 RAM Test Error (Core Processor) Fault No No §
RAM Error (CP) £
A003 Sensor Not Responding (No Tube Interrupt) Fault Yes Yes %
Sensor Failure %
A004 Temperature sensor out of range Fault No Yes ‘E'
Temperature Sensor Failure %’_
A005 Input Over-Range Fault Yes Yes =)
Input Overrange
A006 Transmitter Not Characterized Fault Yes No
Not Configured
A008 Density Outside Limits Fault Yes Yes
Density Overrange
A009 Transmitter Initializing/Warming Up Ignore Yes No =
Transmitter Initializing/Warming Up é
A010 Calibration Failure Fault No No 3
Calibration Failure 3
AO011 Excess Calibration Correction, Zero too Low Fault Yes No g
Zero Too Low F
A012 Excess Calibration Correction, Zero too High Fault Yes No -
Zero Too High
A013 Process too Noisy to Perform Auto Zero Fault Yes No
Zero Too Noisy
A014 Transmitter Failed Fault No No
Transmitter Failed
A016 Line RTD Temperature Out-Of-Range Fault Yes Yes -g
Line RTD Temperature Out-of-Range g
A017 Meter RTD Temperature Out-Of-Range Fault Yes Yes o
Meter RTD Temperature Out-of-Range %
A020 Calibration Factors Unentered Fault Yes No ‘f:i
Calibration Factors Unentered (FlowCal) g‘
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Status alarms and severity levels continued

Default Affected by

Alarm code Message" severity Configurable fault timeout

A021 Unrecognized/Unentered Sensor Type Fault No No
Incorrect Sensor Type (K1)

A029 Internal Communication Failure Fault No No
PIC/Daughterboard Communication Failure

A030 Hardware/Software Incompatible Fault No No
Incorrect Board Type

A031 Undefined Fault No No
Low Power

A032@ Meter Verification Fault Alarm Fault No No
Meter Verification/Outputs In Fault

A032® Outputs Fixed during Meter Verification Varies® No No
Meter Verification In Progress and Outputs
Fixed

A033 Sensor OK, Tubes Stopped by Process Fault Yes Yes
Sensor OK, Tubes Stopped by Process

A034® Meter Verification Failed Info Yes No
Meter Verification Failed

A035® Meter Verification Aborted Info Yes No
Meter Verification Aborted

A102 Drive Over-Range/Partially Full Tube Info Yes No
Drive Overrange/Partially Full Tube

A104 Calibration-In-Progress Info Yes® No
Calibration in Progress

A105 Slug Flow Info Yes No
Slug Flow

A107 Power Reset Occurred Info Yes No
Power Reset Occurred

A116 API Temperature Out-of-Limits Info Yes No
API: Temperature Outside Standard Range

A117 API Density Out-of-Limits Info Yes No
API: Density Outside Standard Range

A120 ED: Unable to fit curve data Info No No

ED: Unable to Fit Curve Data
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Status alarms and severity levels continued

c
o,
5
Default Affected by g
Alarm code Message" severity Configurable fault timeout -
X
Al121 ED: Extrapolation alarm Info Yes No g
ED: Extrapolation Alarm E
A131@ Meter Verification Info Alarm Info Yes No g:’
I o
Meter Verification/Outputs at Last Value a
A131® Meter Verification in Progress Info Yes No
Meter Verification In Progress
A132 Simulation Mode Active Info Yes No
Simulation Mode Active
A133 PIC Ul EEPROM Error Info Yes No
PIC Ul EEPROM Error 5
]
(1) Depending on the method you are using to view the alarm, different messages may be displayed. This table shows two possible ‘_—:‘
message versions. The ProLink Il version is displayed in the second message of each pair. 2
(2) Applies only to systems with the original version of the meter verification application. (@)
(3) Applies only to systems with Smart Meter Verification. g..
(4) If outputs are set to Last Measured Value, severity is Info. If outputs are set to Fault, severity is Fault. Q
(5) Can be set to either Informational or Ignore, but cannot be set to Fault. 5
=
=]
8.9 Configuring the display
If your transmitter has a display, you can configure a variety of parameters that control the display
functionality.
8.9.1 Update period
The Update Period (or Display Rate) parameter controls how often the display is refreshed with g
current data. The default is 200 milliseconds; the range is 100 milliseconds to 10,000 milliseconds =
(10 seconds). %’
To configure Update Period: 3
=2
* Using ProLink II, see Figure C-3. g
*  Using the display, see Figure C-15. =

* Using a PROFIBUS host with the EDD, see Figure C-10.
* Using PROFIBUS bus parameters, use the Local Display block (see Table D-6), Index 31.

8.9.2 Language

The display can be configured to use any of the following languages for data and menus:
* English
e French
* German

* Spanish
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To set the display language:
* Using ProLink II, see Figure C-3.
»  Using the display, see Figure C-15.
* Using a PROFIBUS host with the EDD, see Figure C-10.
* Using PROFIBUS bus parameters, use the Local Display block (see Table D-6), Index 33.

8.9.3 Display variables and display precision

The display can scroll through up to 15 process variables in any order. You can configure the process
variables to be displayed and the order in which they should appear. Additionally, you can configure
display precision for each display variable. Display precision controls the number of digits to the right
of the decimal place. Precision can be set to any value between 0 and 5.

To configure display variables or display precision:
* Using ProLink II, see Figure C-3.
* Using a PROFIBUS host with the EDD, see Figure C-10.
* Using PROFIBUS bus parameters, use the Local Display block (see Table D-6):
- Use Indices 16-30 to specify the display variables.
- Use Indices 14 and 15 to specify display precision.

Note: This functionality cannot be configured via the display menus.

Table 8-9 shows an example of a display variable configuration. Notice that you can repeat variables,
and you can also specify None for any display variable except Display Variable 1. For information on
how the display variables will appear on the display, see Appendix E.

Example of a display variable configuration

Display variable Process variable
Display variable 1" Mass flow

Display variable 2 Mass totalizer
Display variable 3 Volume flow
Display variable 4 Volume totalizer
Display variable 5 Density

Display variable 6 Temperature
Display variable 7 External temperature
Display variable 8 External pressure
Display variable 9 Mass flow

Display variable 10 None

Display variable 11 None

Display variable 12 None

Display variable 13 None

Display variable 14 None

Display variable 15 None

(1) Display Variable 1 cannot be set to None.
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8.9.4

LCD panel backlight

The backlight of the LCD panel on the display can be turned on or off. To turn the backlight on or off:

e Using ProLink II, see Figure C-3.

* Using the display, see Figure C-15.
* Using a PROFIBUS host with the EDD, see Figure C-10.
*  Using PROFIBUS bus parameters, use the Local Display block (see Table D-6), Index 13.

In addition, ProLink II, the EDD, and the bus parameters allow you to control the intensity of the
backlight. You can specify any value between 0 and 63; the higher the value, the brighter the
backlight. To control the intensity of the backlight:

*  Using ProLink II, see Figure C-3.
* Using a PROFIBUS host with the EDD, see Figure C-10.
* Using PROFIBUS bus parameters, use the Local Display block (see Table D-6), Index 32.

8.9.5

Display functions

Table 8-10 lists the display functions and describes their behavior when enabled (shown) or disabled

(hidden).

Display functions

Parameter

Enabled (shown)

Disabled (hidden)

Totalizer start/stop

Operators can start or stop totalizers using the
display.

Operators cannot start or stop totalizers using
the display.

Totalizer reset

Operators can reset the mass and volume
totalizers using the display.

Operators cannot reset the mass and volume
totalizers using the display.

Auto scroll™

The display automatically scrolls through each
process variable at a configurable rate.

Operators must Scroll to view process
variables.

Off-line menu

Operators can access the off-line menu (zero,
simulation, and configuration).

Operators cannot access the off-line menu.

Off-line password®

Operators must use a password to access the
off-line menu.

Operators can access the off-line menu
without a password.

Alarm menu

Operators can access the alarm menu
(viewing and acknowledging alarms).

Operators cannot access the alarm menu.

Acknowledge all
alarms

Operators are able to acknowledge all current
alarms at once.

Operators must acknowledge alarms
individually.

(1) If enabled, you may want to configure Scroll Rate.
(2) If enabled, the off-line password must also be configured.

To configure display functions:

* Using ProLink II, see Figure C-3.
* Using a PROFIBUS host with the EDD, see Figure C-10.

* Using PROFIBUS bus parameters, use the Local Display block (see Table D-6), Indices 4—12.
»  Using the display, see Figure C-15.
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8.10

68

Note the following:

If you use the display to disable access to the off-line menu, the off-line menu will disappear
as soon as you exit the menu system. If you want to re-enable access, you must use a different
method (e.g., ProLink II or a PROFIBUS host with the EDD).

Scroll Rate is used to control the speed of scrolling when Auto Scroll is enabled. Scroll Rate
defines how long each display variable (see Section 8.9.3) will be shown on the display. The
time period is defined in seconds; e.g., if Scroll Rate is set to 10, each display variable will be
shown on the display for 10 seconds.

The off-line password prevents unauthorized users from gaining access to the off-line menu.
The password can contain up to four numbers.

If you are using the display to configure the display:
- You must enable Auto Scroll before you can configure Scroll Rate.

- You must enable the off-line password before you can configure the password.

Configuring digital communications

The digital communications parameters control how the transmitter will communicate using digital
communications. The following digital communications parameters can be configured:

8.10.1

PROFIBUS-DP node address

IrDA port usage

Modbus address

Modbus ASCII support

Floating-point byte order

Additional communications response delay
Digital communications fault action

Fault timeout

PROFIBUS-DP node address

The PROFIBUS-DP node address can be set with the address switches on the device (hardware
addressing mode) or with a PROFIBUS host.

Note: You cannot set the node address from ProLink Il or the display.

The transmitter operates in either hardware addressing mode or software addressing mode:

In hardware addressing mode, the address switches are set to a value between 0 and 126, and
the position of the address switches determines the actual node address. The software address
LED on the face of the transmitter is off (see Figure 3-1 or Figure 3-2).

In software addressing mode, the address switches are set to 126 or greater, and the node
address is set via a Set Slave Address telegram from the host. The position of the address
switches does not necessarily match the actual node address. The software address LED is
either red or green:

- Red - the transmitter has not received a Set Slave Address telegram.

- Green — the transmitter has received a Set Slave Address telegram and recognized the
address.

The default node address for the Model 2400S DP transmitter is 126, which allows either hardware
addressing or software addressing.
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To set the node address with address switches:
1. Remove the transmitter housing cover as described in Section 3.3.

2. Identify the three address switches on the user interface module of your transmitter (see
Figure 3-1 or Figure 3-2).

3. For each switch, insert a small blade into the slot to rotate the arrow to the desired position. For
example, to set the node address to 60:

a. Rotate the arrow in the left switch to point to the digit 0.
b. Rotate the arrow in the center switch to point to the digit 6.
c. Rotate the arrow in the right switch to point to the digit 0.

4. Power-cycle the transmitter. At this point, the new node address is recognized by the
transmitter, but not the host. You must update the host configuration for the new address.

To set the node address with software:

1. Ensure that the transmitter is in software addressing mode (software address LED is red or
green). If it is, skip this step and go to Step 2. If it is currently in hardware addressing mode
(software address LED is off):

a. Set the address switches to 126 or higher.

b. Power-cycle the transmitter. At this point, the transmitter enters software addressing mode,
and the software address LED is red.

2. Send a Set Slave Address telegram from the host. It is not necessary to power-cycle the
transmitter. At this point, the new node address is recognized by both the transmitter and the
host, and the software address LED is green.

To return the node address to 126 (sometimes required for maintenance):

1. Because a Set Slave Address telegram cannot specify a node address of 126, you must set this
address via the address switches. If the transmitter is currently in hardware addressing mode
(software address LED is off), skip this step and go to Step 2. If it is currently in software
addressing mode (software address LED is red or green), switch to hardware addressing mode
as follows:

a. Set the address switches to any value between 0 and 125 (e.g., 100).

b. Power-cycle the transmitter. The transmitter enters hardware addressing mode, and the
software address LED is off.

2. Set the address switches to 126.

3. Power-cycle the transmitter.

8.10.2  IrDA port usage

The IrDA port on the display can be enabled or disabled. If enabled, it can be set for read-only or
read/write.

To enable or disable the IrDA port:
*  Using ProLink II, see Figure C-2.
* Using the display menus, see Figure C-15.
* Using a PROFIBUS host with the EDD, see Figure C-10.
» Using PROFIBUS bus parameters, use the Local Display block (see Table D-6), Index 34.
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To configure the IrDA port for read-only or read/write access:
* Using ProLink II, see Figure C-2.
»  Using the display menus, see Figure C-15.
* Using a PROFIBUS host with the EDD, see Figure C-10.
* Using PROFIBUS bus parameters, use the Local Display block (see Table D-6), Index 35.

8.10.3  Modbus address

Note: The Modbus address is applicable only when you are connecting to the service port from a tool
that uses Modbus protocol. After initial startup, service port connections are typically used only for
troubleshooting or for specific procedures such as temperature calibration. ProLink Il is typically
used for service port connections, and by default ProLink Il will use the standard service port address
rather than the configured Modbus address. See Section 4.4 for more information.

The set of valid Modbus addresses depends on whether or not support for Modbus ASCII is enabled
or disabled (see Section 8.10.4). Valid Modbus addresses are as follows:

e Modbus ASCII enabled: 1-15, 32-47, 64-79, 96-110
e  Modbus ASCII disabled: 0-127
To configure the Modbus address:
*  Using ProLink II, see Figure C-2.
* Using the display, see Figure C-15.
Note: This functionality cannot be configured via PROFIBUS protocol.

8.10.4  Modbus ASCII support

When support for Modbus ASCII is enabled, the service port can accept connection requests that use
either Modbus ASCII or Modbus RTU. When support for Modbus ASCII is disabled, the service port
cannot accept connection requests that use Modbus ASCII. Only Modbus RTU connections are
accepted.

The primary reason to disable Modbus ASCII support is to allow a wider range of Modbus addresses
for the service port.

To enable or disable Modbus ASCII support:
*  Using ProLink II, see Figure C-2.
*  Using the display, see Figure C-15.
Note: This functionality cannot be configured via PROFIBUS protocol.

8.10.5 Floating-point byte order

Note: This parameter affects only Modbus communications. PROFIBUS communications are not
changed.

Four bytes are used to transmit floating-point values. For contents of bytes, see Table 8-11.
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Byte contents in Modbus commands and responses c
2.
Byte Bits Definitions 5
1 SEEEEEEE S = Sign 3
E = Exponent g
2 EMMMMMMM E = Exponent =
M = Mantissa »
T
MMMMMMMM M = Mantissa ]
MMMMMMMM M = Mantissa
The default byte order for the Model 2400S transmitter is 3—4 1-2. You may need to reset byte order
to match the byte order used by a remote host or PLC.
To configure byte order using ProLink II, see Figure C-2.
Note: This functionality cannot be configured via the display menus or PROFIBUS protocol. E
c
g
8.10.6  Additional communications response delay o
=]
Note: This parameter affects only Modbus communications. PROFIBUS communications are not =
changed. §
Some hosts or PLCs operate at slower speeds than the transmitter. In order to synchronize §
communication with these devices, you can configure an additional time delay to be added to each
response the transmitter sends to the remote host.
The basic unit of delay is 2/3 of one character time, as calculated for the current serial port baud rate
setting and character transmission parameters. This basic delay unit is multiplied by the configured
value to arrive at the total additional time delay. You can specify a value in the range 1 to 255.
To configure additional communications response delay using ProLink II, see Figure C-2.
c
e . , ; ; =
Note: This functionality cannot be configured via the display menus or PROFIBUS protocol. g
3
8.10.7  Digital communications fault action 5'
=]
Note: This parameter affects both PROFIBUS and Modbus communications. g
Digital communications fault action controls how process variables will be reported via digital )

communications during fault conditions. Table 8-12 lists the options for digital communications fault
action.

Note: Digital communications fault action does not affect the alarm status bits. For example, if digital
communications fault action is set to None, the alarm status bits will still be set if an alarm occurs.
See Section 7.7 for more information.
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Digital communications fault action options

Option
ProLink Il label EDD label Definition
Upscale Upscale * Process variables indicate that the value is greater than the
upper sensor limit.
* Totalizers stop incrementing.
Downscale Downscale * Process variables indicate that the value is less than the
lower sensor limit.
* Totalizers stop incrementing.
Zero IntZero-All O * Flow rate variables go to the value that represents zero
flow. Density is reported as zero.
* Temperature is reported as 0 °C, or the equivalent if other
units are used (e.g., 32 °F).
* Totalizers stop incrementing.
Not-A-Number (NAN) Not-a-Number * Process variables report IEEE NAN.
* Drive gain is reported as measured.
* Modbus scaled integers are reported as Max Int.
* Totalizers stop incrementing.
Flow to Zero IntZero-Flow O * Flow rate variables go to the value that represents zero
flow;
» Other process variables are reported as measured.
* Totalizers stop incrementing.
None (default) None * Process variables are reported as measured.

* Totalizers increment if they are running.

72

To configure digital communications fault action:
*  Using ProLink II, see Figure C-2.
» Using a PROFIBUS host with the EDD, see Figure C-9.
* Using PROFIBUS bus parameters, use the Diagnostic block (see Table D-4), Index 18.

Note: This functionality cannot be configured via the display menus.

Note: Digital communications fault action is affected by the configured fault timeout. See
Section 8.10.8.

8.10.8 Fault timeout

By default, the transmitter activates the digital communications fault action as soon as the fault is
detected. The fault timeout (last measured value timeout) allows you to delay the digital
communications fault action for a specified interval, for certain faults only. During the fault timeout
period, digital communications reports the last measured value.

Note: The fault timeout applies only to the digital communications fault action. The “alarm active”
status bit is set as soon as the fault is detected (all alarm severity levels), and the “alarm active”
record is written to history immediately (Fault and Informational alarms only). For more information
on alarm handling, see Section 7.7. For more information on alarm severity, see Section 8.8.

The fault timeout applies only to specific faults. Other faults are reported immediately, regardless of
the fault timeout setting. For information on which faults are affected by the fault timeout, see
Table 8-8.
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To configure fault timeout:
*  Using ProLink II, see Figure C-2.
* Using a PROFIBUS host with the EDD, see Figure C-9.
* Using PROFIBUS bus parameters, use the Diagnostic block (see Table D-4), Index 19.

Note: This functionality cannot be configured via the display menus.

Configuring device settings

The device settings are used to describe the flowmeter components. Table 8-13 lists and defines the
device settings.

Device settings

Parameter Description

Descriptor Any user-supplied description. Not used in transmitter processing, and not required.

Maximum length: 16 characters.

Message Any user-supplied message. Not used in transmitter processing, and not required.

Maximum length: 32 characters.

Date

Any user-selected date. Not used in transmitter processing, and not required.

8.12

To configure device settings using ProLink II, see Figure C-2.
Note: This functionality cannot be configured via the display menus or PROFIBUS protocol.

If you are entering a date, use the left and right arrows at the top of the calendar shown in ProLink II
to select the year and month, then click on a date.

Configuring PROFIBUS 1&M function values

Most 1&M function values are configured at the factory and cannot be changed by the user. Two I&M
function values can be configured by the user:

* Device identification tag
* Device location identification tag
To configure these values:
e Using ProLink II, see Figure C-2. ProLink II v2.6 or later is required.

*  Using a PROFIBUS host with the EDD, see Figure C-12. You must connect as a Specialist to
use the I&M Functions menu.

* Using PROFIBUS bus parameters, see Table D-9.

Note: These values cannot be configured via the display menus.
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8.13

8.14

74

Configuring sensor parameters

The sensor parameters are used to describe the sensor component of your flowmeter. One sensor
parameter (curved or straight tube) must be set during characterization (see Section 6.2). The
remaining sensor parameters are not used in transmitter processing, and are not required:

*  Serial number
* Sensor material
e Liner material
e Flange
To configure sensor parameters:
e Using ProLink II, see Figure C-2.
* Using a PROFIBUS host with the EDD, see Figure C-10.

* Using PROFIBUS bus parameters, use the Device Information block (see Table D-5),
Indices 7-12.

Note: This functionality cannot be configured via the display menus.

Configuring the petroleum measurement application

The API parameters determine the values that will be used in API-related calculations. The API
parameters are available only if the petroleum measurement application is enabled on your
transmitter.

Note: The petroleum measurement application requires liquid volume measurement units. If you plan
to use API process variables, ensure that liquid volume flow measurement is specified. See
Section 8.2.

8.14.1  About the petroleum measurement application

Some applications that measure liquid volume flow or liquid density are particularly sensitive to
temperature factors, and must comply with American Petroleum Institute (API) standards for
measurement. The petroleum measurement application enables Correction of Temperature on volume
of Liquids, or CTL.

Terms and definitions
The following terms and definitions are relevant to the petroleum measurement application:
* API - American Petroleum Institute

e CTL - Correction of Temperature on volume of Liquids. The CTL value is used to calculate
the VCF value

* TEC - Thermal Expansion Coefficient

*  VCF - Volume Correction Factor. The correction factor to be applied to volume process
variables. VCF can be calculated after CTL is derived

CTL derivation methods
There are two derivation methods for CTL:
* Method 1 is based on observed density and observed temperature.

e Method 2 is based on a user-supplied reference density (or thermal expansion coefficient, in
some cases) and observed temperature.
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API reference tables

Reference tables are organized by reference temperature, CTL derivation method, liquid type, and
density unit. The table selected here controls all the remaining options.

* Reference temperature:

- If you specify a 5x, 6x, 23x, or 24x table, the default reference temperature is 60 °F, and
cannot be changed.

- If you specify a 53x or 54x table, the default reference temperature is 15 °C. However, you
can change the reference temperature, as recommended in some locations (for example, to
14.0 or 14.5 °C).

¢ CTL derivation method:

- If you specify an odd-numbered table (5, 23, or 53), CTL will be derived using method 1
described above.

- If you specify an even-numbered table (6, 24, or 54), CTL will be derived using method 2
described above.

e Theletters A, B, C, or D that are used to terminate table names define the type of liquid that the
table is designed for:

- A tables are used with generalized crude and JP4 applications.
- Btables are used with generalized products.

- Ctables are used with liquids with a constant base density or known thermal expansion
coefficient.

- D tables are used with lubricating oils.
» Different tables use different density units:

- Degrees API

- Relative density (SG)

- Base density (kg/m?)

Table 8-14 summarizes these options.
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API reference temperature tables

CTL

derivation

Table method

Density unit and range

Base temperature Degrees API Base density Relative density

5A Method 1 60 °F, non-configurable 0to +100
5B Method 1 60 °F, non-configurable 0to +85
5D Method 1 60 °F, non-configurable —10to +40
23A Method 1 60 °F, non-configurable 0.6110 to 1.0760
23B Method 1 60 °F, non-configurable 0.6535 to 1.0760
23D Method 1 60 °F, non-configurable 0.8520 to 1.1640
53A Method 1 15 °C, configurable 610 to 1075 kg/m?®
53B Method 1 15 °C, configurable 653 to 1075 kg/m?
53D Method 1 15 °C, configurable 825 to 1164 kg/m®

Reference temperature Supports
6C Method 2 60 °F, non-configurable 60 °F Degrees API
24C Method 2 60 °F, non-configurable 60 °F Relative density
54C Method 2 15 °C, configurable 15 °C Base density in kg/m®

8.14.2  Configuration procedure
The API configuration parameters are listed and defined in Table 8-15.

API parameters

Variable Description

Table type Specifies the table that will be used for reference temperature and reference density unit. Select
the table that matches your requirements. See AP reference tables.

User defined TEC  Thermal expansion coefficient. Enter the value to be used in CTL calculation.

Temperature units®

Read-only. Displays the unit used for reference temperature in the reference table.

Density units

Read-only. Displays the unit used for reference density in the reference table.

Reference
temperature

Read-only unless Table Type is set to 53x or 54x. If configurable:
* Specify the reference temperature to be used in CTL calculation.
* Enter reference temperature in °C.

(1) Configurable if Table Type is set to 6C, 24C, or 54C.
(2) In most cases, the temperature unit used by the API reference table should also be the temperature unit configured for the transmitter
to use in general processing. To configure the temperature unit, see Section 6.3.4.
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To configure the petroleum measurement application:

e Using ProLink II, see Figure C-3.
* Using a PROFIBUS host with the EDD, see Figure C-11.
* Using PROFIBUS bus parameters, use the API block (see Table D-7), Indices 13-15.

Note: This functionality cannot be configured via the display menus.
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For the temperature value to be used in CTL calculation, you can use the temperature data from the
sensor, or you can configure external temperature compensation to use either a static temperature
value or temperature data from an external temperature device.

* To use temperature data from the sensor, no action is required.

* To configure external temperature compensation, see Section 9.3.

8.15 Configuring the enhanced density application
Micro Motion sensors provide direct measurements of density, but not of concentration. The enhanced
density application calculates enhanced density process variables, such as concentration or density at
reference temperature, from density process data, appropriately corrected for temperature.
Note: For a detailed description of the enhanced density application, see the manual entitled
Micro Motion Enhanced Density Application: Theory, Configuration, and Use.
Note: The enhanced density application requires liquid volume measurement units. If you plan to use
enhanced density process variables, ensure that liquid volume flow measurement is specified. See
Section 8.2.
8.15.1  About the enhanced density application
The enhanced density calculation requires an enhanced density curve, which specifies the relationship
between temperature, concentration, and density for the process fluid being measured. Micro Motion
supplies a set of six standard enhanced density curves (see Table 8-16). If none of these curves is
appropriate for your process fluid, you can configure a custom curve or purchase a custom curve from
Micro Motion.
The derived variable, specified during configuration, controls the type of concentration measurement
that will be produced. Each derived variable allows the calculation of a subset of enhanced density
process variables (see Table 8-17). The available enhanced density process variables can be used in
process control, just as mass flow rate, volume flow rate, and other process variables are used. For
example, an event can be defined on an enhanced density process variable.
e For all standard curves, the derived variable is Mass Conc (Dens).
*  For custom curves, the derived variable may be any of the variables listed in Table 8-17.
The transmitter can hold up to six curves at any given time, but only one curve can be active (used for
measurement) at a time. All curves that are in transmitter memory must use the same derived variable.
Standard curves and associated measurement units
Name Description Density unit Temperature unit
Deg Balling Curve represents percent extract, by mass, in g/cm® °F
solution, based on °Balling. For example, if a wort
is 10 °Balling and the extract in solution is 100%
sucrose, the extract is 10% of the total mass.
Deg Brix Curve represents a hydrometer scale for sucrose  g/cm?® °C
solutions that indicates the percent by mass of
sucrose in solution at a given temperature. For
example, 40 kg of sucrose mixed with 60 kg of
water results in a 40 °Brix solution.
Deg Plato Curve represents percent extract, by mass, in g/cm?® °F

solution, based on °Plato. For example, if a wort is
10 °Plato and the extract in solution is 100%
sucrose, the extract is 10% of the total mass.
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Standard curves and associated measurement units continued

Name Description Density unit Temperature unit

HFCS 42 Curve represents a hydrometer scale for HFCS 42  g/cm?® °C
(high fructose corn syrup) solutions that indicates
the percent by mass of HFCS in solution.

HFCS 55 Curve represents a hydrometer scale for HFCS 55 g/cm?® °C
(high fructose corn syrup) solutions that indicates
the percent by mass of HFCS in solution.

HFCS 90 Curve represents a hydrometer scale for HFCS 90  g/cm?® °C
(high fructose corn syrup) solutions that indicates
the percent by mass of HFCS in solution.

Derived variables and available process variahles

Available process variables

. . . Density at Standard Specific Concentration Net Net
Derived variable — ProLink Il label reference  volume  gravity mass volume
and definition temperature flow rate flow rate  flow rate
Density @ Ref v v
Density at reference temperature
Mass/unit volume, corrected to a given
reference temperature
SG v v v
Specific gravity
The ratio of the density of a process fluid at
a given temperature to the density of water
at a given temperature. The two given
temperature conditions do not need to be
the same.

Mass Conc (Dens) v v v v
Mass concentration derived from reference

density

The percent mass of solute or of material

in suspension in the total solution, derived

from reference density

Mass Conc (SG) v v v v v
Mass concentration derived from specific

gravity

The percent mass of solute or of material
in suspension in the total solution, derived
from specific gravity

Volume Conc (Dens) v v v v
Volume concentration derived from

reference density

The percent volume of solute or of material

in suspension in the total solution, derived

from reference density
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Derived variables and available process variables continued

Available process variables

. . . Density at Standard Specific Concentration Net Net
Derived variable — ProLink Il label reference  volume  gravity mass volume
and definition temperature flow rate flow rate  flow rate
Volume Conc (SG) v v v v v
Volume concentration derived from specific
gravity
The percent volume of solute or of material
in suspension in the total solution, derived
from specific gravity
Conc (Dens) v v v
Concentration derived from reference
density

The mass, volume, weight, or number of
moles of solute or of material in
suspension in proportion to the total
solution, derived from reference density

Conc (SG) v v v v
Concentration derived from specific gravity

The mass, volume, weight, or number of

moles of solute or of material in

suspension in proportion to the total

solution, derived from specific gravity

8.15.2  Configuration procedure

Complete configuration instructions for the enhanced density application are provided in the manual
entitled Micro Motion Enhanced Density Application: Theory, Configuration, and Use.

Note: The enhanced density manual uses ProLink Il as the standard configuration tool for the
enhanced density application. Because the menu structure defined in the EDD is very similar to the
ProLink Il menus, you can follow the instructions for ProLink Il and adapt them to your host.

The typical configuration procedure simply sets up the enhanced density application to use a standard
curve. The following steps are required:

1. Set the transmitter’s density measurement unit to match the unit used by the curve (as listed in
Table 8-16).

2. Set the transmitter’s temperature measurement unit to match the unit used by the curve (as
listed in Table 8-16).

3. Set the derived variable to Mass Conc (Dens).
4. Specify the active curve.
To perform these steps:
*  With ProLink II, see Figures C-2 and C-3.
*  With a PROFIBUS host and the EDD, see Figures C-8 and C-11.

*  With PROFIBUS bus parameters, use the Measurement block and the Enhanced Density block
(see Tables D-2 and D-8).
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Pressure Compensation and
External Temperature Compensation

9.1

9.2

Overview
This chapter describes the following procedures:
*  Configuring pressure compensation — see Section 9.2
* Configuring external temperature compensation — see Section 9.3

* Obtaining external pressure or temperature data — see Section 9.4

Note: All procedures provided in this chapter assume that you have established communication with
the Model 24008 DP transmitter and that you are complying with all applicable safety requirements.

Note: If you are using Pocket ProLink, the interface is similar to the ProLink Il interface described in
this chapter.

Pressure compensation

The Model 2400S DP transmitter can compensate for the effect of pressure on the sensor flow tubes.
Pressure effect is defined as the change in sensor flow and density sensitivity due to process pressure
change away from calibration pressure.

Note: Pressure compensation is an optional procedure. Perform this procedure only if required by
your application.

9.2.1 Options
There are two ways to implement pressure compensation:
*  You can use an output module to obtain pressure data from the system. See Section 9.4.

» If the operating pressure is a known static value, you can configure that value in the
transmitter.

Note: Ensure that your pressure value is accurate, or that your pressure measurement device is
accurate and reliable.

9.2.2 Pressure correction factors

When configuring pressure compensation, you must provide the flow calibration pressure — the
pressure at which the flowmeter was calibrated (which therefore defines the pressure at which there
will be no effect on the calibration factor). Refer to the calibration document shipped with your
sensor. If the data is unavailable, enter 20 PSI.
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Two additional pressure correction factors may be configured: one for flow and one for density. These
are defined as follows:

*  Flow factor — the percent change in the flow rate per psi
» Density factor — the change in fluid density, in g/cm*/psi

Not all sensors or applications require pressure correction factors. For the pressure correction values
to be used, obtain the pressure effect values from the product data sheet for your sensor, then reverse

the signs (e.g., if the flow factor is 0.000004 % per PSI, enter a pressure correction flow factor of
—0.000004 % per PSI).

9.2.3 Configuration

To enable and configure pressure compensation:
e With ProLink II, see Figure 9-1.
*  With a PROFIBUS host with the EDD, see Figure 9-2.
*  With PROFIBUS bus parameters, see Figure 9-3.

Pressure compensation — ProLink Il

Enable Set measurement unit" Configure
View > ProLink > ProLink >
Preferences »  Configuration > »  Configuration >
L Pressure Pressure
Enable External Pressure l l
Compensation ‘ Enter Pressure units ‘ ‘

Enter Flow factor ‘

== - l

A

Enter Density factor ‘

f !

‘ Enter Cal pressure ‘

Use static
pressure value?

No Yes
(1) Pressure measurement unit must be configured to match l l
pressure ‘unit used by external device or static pressure value. Set up output Enter External
See Section 6.3. module® Pressure
(2) See Section 9.4.

\4
Done
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Pressure compensation - PROFIBUS host with the EDD

MMI Coriolis Flow >
Pressure >
Pressure Configuration

v

Enable Pressure Compensation

Y

‘ Select Pressure unit" ‘

!

MMI Coriolis Flow >
> Pressure >

Enter External Pressure Input <«—

v
Transfer

Pressure Compensation

v

Enter Pressure correction factor
for flow

!

Enter Pressure correction factor
for density

'

Enter Flow calibration pressure

'

Transfer

|

Use static
pressure value?

No—+ Set up output module® ‘

v

Done

(1) Pressure measurement unit must be configured to match pressure unit used by external device
or static pressure value. See Section 6.3.

(2) See Section 9.4.

Pressure compensation — PROFIBUS bus parameters

|

l

Configure pressure
correction factor for flow

l

Configure pressure
correction factor for density

l

Configure flow calibration
pressure

Use static

ressure value?
No P

Enable —>»

Block: Calibration (Slot 2)"
Index 36

Set pressure unit —>p

Block: Calibration (Slot 2)
Index 38

Block: Calibration (Slot 2)
Index 39

(1) See Table D-3 for more information

about the bus parameters.

Block: Calibration (Slot 2)
Index 40

(2) Pressure measurement unit must be
configured to match pressure unit used
by external device or static pressure

value. See Section 6.3.

Block: Calibration (Slot 2)
Index 41

(3) See Section 9.4.

Yes

'

|

Set up output

module® Set static value

Block: Calibration (Slot 2)
Index 37
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9.3 External temperature compensation

External temperature compensation can be used with the petroleum measurement application or the
enhanced density application:

* If external temperature compensation is enabled, an external temperature value (or a static
temperature value), rather than the temperature value from the sensor, is used in petroleum
measurement or enhanced density calculations only. The temperature value from the sensor is
used for all other calculations.

e If external temperature compensation is disabled, the temperature value from the sensor is
used in all calculations.

There are two ways to implement external temperature compensation:
*  You can use an output module to obtain temperature data from the system. See Section 9.4.

o If the operating temperature is a known static value, you can configure that value in the
transmitter.

Note: Ensure that your temperature value is accurate, or that your temperature measurement device is
accurate and reliable.

To enable and configure external temperature compensation:
*  With ProLink II, see Figure 9-4.
*  With a PROFIBUS host with the EDD, see Figure 9-5.
*  With PROFIBUS bus parameters, see Figure 9-3.

External temperature compensation — ProLink Il

Enable Configure
View Menu > ¢
Preferences ProLink >
l Configuration >
Enable Use External Temperature

Temperature v

‘ Enter Temperature units"
Apply

A 4

Use static
temp value?

Nf st
(1) Temperature measurement unit must be Set up output Enter External
configured to match temperature unit used module® Temperature
by external device or static temperature
value. See Section 6.3.
(2) See Section 9.4.

Done
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External temperature compensation — PROFIBUS host with the EDD

(@)
o
MMI Coriolis Flow > MMI Coriolis Flow > _g
Temperature > > Temperature > g
External Temperature "
¢ L 2
i4(1) o
‘ Check Temperature unit ‘ Enable External Temp 1
for APl or ED
!
Transfer

Use static
temp value?
No

(1) Temperature measurement unit must be Yes
configured to match temperature unit used i i
by external device or static temperature Enter External s @
value. See Section 6.3. Temperature Input st up output module

(2) See Section 9.4.
Transfer

Done

99UBWLIONA JUBWaINSEa|

External temperature compensation — PROFIBUS bus parameters

Block: Calibration (Slot 2)"

Enable ™ Index 34

}

. Block: Measurement (Slot 1)
Set temperature unit ™ ndex 7@ g'
c
=2
®
7]
=3
3
Use static %"
temp value? Q@
Nlo Yes
Set up ou(t3p))ut Set static value Block: Calibration (Slot 2)
module Index 35
(1) See Tables D-3 and D-2 for more information about the bus parameters.
(2) Temperature measurement unit must be configured to match temperature unit used by external device or static temperature
value. See Section 6.3.
(3) See Section 9.4.
O
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9.4 Obtaining external pressure and temperature data

The output modules used to obtain external pressure and/or temperature data are listed in Table 9-1.
Use standard methods to implement the required connection.

Output modules used for pressure or temperature compensation

Module nhumber Module name Size
34 External pressure 4 bytes
35 External temperature 4 bytes
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10.1

10.2

Overview
This chapter describes the following procedures:
e Meter verification — see Section 10.3
e Meter validation and adjusting meter factors — see Section 10.4
*  Zero calibration — see Section 10.5
* Density calibration — see Section 10.6

* Temperature calibration — see Section 10.7

Note: All procedures provided in this chapter assume that you have established communication with
the Model 24008 DP transmitter and that you are complying with all applicable safety requirements.

Note: If you are using Pocket ProLink, the interface is similar to the ProLink Il interface described in
this chapter.

Meter validation, meter verification, and calibration

The Model 2400S transmitter supports the following procedures for the evaluation and adjustment of
measurement performance:

*  Meter verification — establishing confidence in the sensor’s performance by analyzing
secondary variables associated with flow and density

*  Meter validation — confirming performance by comparing the sensor’s measurements to a
primary standard

* Calibration — establishing the relationship between a process variable (flow, density, or
temperature) and the signal produced by the sensor

Meter validation and calibration are available on all Model 2400S DP transmitters. Meter verification
is available only if the meter verification option was ordered with the transmitter.

These three procedures are discussed and compared in Sections 10.2.1 through 10.2.4. Before
performing any of these procedures, review these sections to ensure that you will be performing the
appropriate procedure for your purposes.

10.2.1 Meter verification

Meter verification evaluates the structural integrity of the sensor tubes by comparing current tube
stiffness to the stiffness measured at the factory. Stiffness is defined as the load per unit deflection, or
force divided by displacement. Because a change in structural integrity changes the sensor’s response
to mass and density, this value can be used as an indicator of measurement performance. Changes in
tube stiffness are typically caused by erosion, corrosion, or tube damage.

Note: Micro Motion recommends performing meter verification at regular intervals.
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Measurement Performance

There are two versions of the meter verification application: the original version and Micro Motion
Smart Meter Verification. Table 10-1 lists requirements for each version. Table 10-2 provides a
comparison of the two versions.

Note: If you are running an older version of ProLink II or the EDD, you will not be able to access the
additional features in Smart Meter Verification. If you are running an updated version of ProLink 11
or the EDD with the original version of meter verification, the meter verification procedures will be
slightly different from the procedures shown here.

Version requirements for meter verification application

Requirement type

Meter verification application

Original version

Smart Meter Verification

Transmitter

vi.0

vi4

ProLink Il requirements

v2.5

v2.9

EDD requirements

2400SDP_pdmrev1_00 folder

2400SDP_pdmrev1_40 folder

Comparison of meter verification features and functions: original version vs. Smart Meter

Verification

Feature or function

Meter verification application

Original version

Smart Meter Verification

Process interruption

No need to halt flow

No need to halt flow

Measurement interruption

Three minutes. Outputs go to:
e Last Measured Value
* Configured Fault Value

User option:

* Continue Measurement. Measurement is
not interrupted. Test requires
approximately 90 seconds.

¢ Last Measured Value. Outputs fixed and
measurement interrupted for
approximately 140 seconds.

* Configured Fault Value Outputs fixed and
measurement interrupted for
approximately 140 seconds.

Result storage

Test results stored only for tests run with
ProLink Il, and stored on the PC

Twenty most recent results stored on the
transmitter, independent of tool used to
perform the procedure. For tests run with
ProLink I, additional result data stored on
PC.

Result data on display

Pass/Fail/Abort for current test

For all results stored on transmitter:

¢ Pass/Fail/Abort

¢ Abort code (if relevant)

« Stiffness of the right and left pickoffs
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Comparison of meter verification features and functions: original version vs. Smart Meter
Verification continued

Feature or function

Meter verification application

Original version

Smart Meter Verification

Result data with EDD

Pass/Caution/Abort for current test

For all results stored on transmitter:

¢ Pass/Caution/Abort

¢ Abort code (if relevant)

« Stiffness of the right and left pickoffs
* Comparison table for stored results
e Comparison plot for stored results

Result data with ProLink Il

For all results stored on PC:

* Pass/Fail/Abort

* Abort code (if relevant)

» Stiffness of the right and left pickoffs

* Test execution metadata

* Comparison graphs

* Test reports

* Data export and manipulation
capabilities

For all results stored on transmitter:

¢ Pass/Fail/Abort

¢ Abort code (if relevant)

* Stiffness of the right and left pickoffs

* Test execution metadata

* Comparison graphs

* Test reports

* Data export and manipulation
capabilities

Startup methods

Manual

Manual
Scheduler
Event

10.2.2

Meter validation and meter factors

Meter validation compares a measurement value reported by the transmitter with an external
measurement standard. Meter validation requires one data point.

Note: For meter validation to be useful, the external measurement standard must be more accurate

than the sensor. See the sensor’s product data sheet for its accuracy specification.

If the transmitter’s mass flow, volume flow, or density measurement is significantly different from the
external measurement standard, you may want to adjust the corresponding meter factor. A meter
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factor is the value by which the transmitter multiplies the process variable value. The default meter §
factors are 1.0, resulting in no difference between the data retrieved from the sensor and the data g
reported externally. %
Meter factors are typically used for proving the flowmeter against a Weights & Measures standard. %
You may need to calculate and adjust meter factors periodically to comply with regulations. @
10.2.3  Calibration
The flowmeter measures process variables based on fixed points of reference. Calibration adjusts
those points of reference. Three types of calibration can be performed:

e Zero, or no flow

* Density calibration

*  Temperature calibration
Density and temperature calibration require two data points (low and high) and an external =
measurement for each. Zero calibration requires one data point. Calibration produces a change in the ic,"
offset and/or the slope of the line that represents the relationship between the actual process value and 7

the reported value.

Note: For density or temperature calibration to be useful, the external measurements must be
accurate.
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Micro Motion flowmeters with the Model 2400S transmitter are calibrated at the factory, and
normally do not need to be calibrated in the field. Calibrate the flowmeter only if you must do so to
meet regulatory requirements. Contact Micro Motion before calibrating your flowmeter.

Note: Micro Motion recommends using meter validation and meter factors, rather than calibration, to
prove the meter against a regulatory standard or to correct measurement error.

10.2.4

Comparison and recommendations

When choosing among meter verification, meter validation, and calibration, consider the following

factors:

*  Process and measurement interruption

Smart Meter Verification provides an option that allows process measurement to continue
during the test.

The original version of meter verification requires approximately three minutes to
perform. During these three minutes, flow can continue (provided sufficient stability is
maintained); however, measurement is halted.

Meter validation for density does not interrupt the process. However, meter validation for
mass flow or volume flow requires process down-time for the length of the test.

Calibration requires process down-time. In addition, density and temperature calibration
require replacing the process fluid with low-density and high density fluids, or with
low-temperature and high-temperature fluids. Zero calibration requires stopping flow
through the sensor.

* External measurement requirements

Neither version of meter verification requires external measurements.
Zero calibration does not require external measurements.

Density calibration, temperature calibration, and meter validation require external
measurements. For good results, the external measurement must be highly accurate.

*  Measurement adjustment

Meter verification is an indicator of sensor condition, but does not change flowmeter
internal measurement in any way.

Meter validation does not change flowmeter internal measurement in any way. If you
decide to adjust a meter factor as a result of a meter validation procedure, only the reported
measurement is changed — the base measurement is not changed. You can always reverse
the change by returning the meter factor to its previous value.

Calibration changes the transmitter’s interpretation of process data, and accordingly
changes the base measurement. If you perform a zero calibration, you can return to the
factory zero (or, if using ProLink II, the previous zero). However, if you perform a density
calibration or a temperature calibration, you cannot return to the previous calibration
factors unless you have manually recorded them.

Micro Motion recommends that you purchase the meter verification option and perform meter
verification frequently.
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10.3

Performing meter verification

10.3.1 Preparing for the meter verification test

Process fluid and process conditions

The meter verification test can be performed on any process fluid. It is not necessary to match factory
conditions.

During the test, process conditions must be stable. To maximize stability:
* Maintain a constant temperature and pressure.
*  Avoid changes to fluid composition (e.g., two-phase flow, settling, etc.).
*  Maintain a constant flow. For higher test certainty, reduce or stop flow.

If stability varies outside test limits, the test will be aborted. Verify the stability of the process and
repeat the test.

Transmitter configuration

Meter verification is not affected by any parameters configured for flow, density, or temperature. It is
not necessary to change the transmitter configuration.

Control loops and process measurement

If the transmitter outputs will be set to Last Measured Value or Fault during the test, the outputs will
be fixed for two minutes (Smart Meter Verification) or three minutes (original version). Disable all
control loops for the duration of the test, and ensure that any data reported during this period is
handled appropriately.

Specification uncertainty limit

The specification uncertainty limit defines the acceptable degree of variation from factory results,
expressed as a percentage. Variation inside the limit is reported as Pass. Variation outside the limit is
reported as Fail or Caution.

* In Smart Meter Verification, the specification uncertainty limit is set at the factory and cannot
be configured.

* In the original version of meter verification, the specification uncertainty limit is configurable.
However, Micro Motion suggests using the default value. Contact Micro Motion Customer
Service before changing the specification uncertainty limit.

10.3.2  Running the meter verification test, original version
To perform meter verification:
* Using ProLink II, follow the procedure illustrated in Figure 10-1.

*  Using the display menu, follow the procedure illustrated in Figure 10-2. For a complete
illustration of the meter verification display menu, see Figure C-17.

* Using a PROFIBUS host with the EDD, refer to Figure C-7 and follow the procedure
illustrated in Figure 10-4.

* Using PROFIBUS bus parameters, use the Diagnostic block (see Table D-4) and follow the
procedure illustrated in Figure 10-4.

Note: If you start a meter verification test remotely, the transmitter display shows the following
message:
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SENSOR
VERFY/x%

Meter verification procedure — ProLink Il

Tools >
Meter Verification >
Structural Integrity Method

4

Verify configuration
parameters
I

Next 1

View previous test data

Graph of results

A
Enter optional test data

v

View report (option to print
or save)

_ | Initialize and start meter | _ A
- verification N

Fault Hold last
configuration value

Progress bar shows
test in progress

L_| Abort Fail Pass

Yes

(1) If the graph was viewed at the beginning of the procedure,
No clicking Back here will return to the beginning of the procedure
(along the dotted line).
(2) The results of the meter verification test are not saved until
Finish is clicked.
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Figure 10-2 Meter verification procedure — Display menu

Scroll and Select simultaneously
for 4 seconds

OFF-LINE MAINT ‘

‘} SENSOR VERFY ‘

OUTPUTS ‘

|

‘ Choose output setting ‘ ‘ SENSOR EXIT ‘

'
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ﬁj of the flow or drive gain is outside limits.
S (2) Represents the percentage completion of the
P procedure.
A 4 A 4
UNSTABLE FLow® | | x%?
Correct condition L i i
PASS CAUTION ABORT

v

‘ RERUN/YES? ‘

|
No Yes
l

Correct condition

=N
4 A
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Meter verification procedure — EDD

rNO (<16

Device >
Meter Verification

v

Set Output state (optional)

!

Set Stiffness limit set point
(optional)

Transfer

Enable meter verification =
Normal Enable

r&———Manual abort (optional}————

!

Check
Algorithm state

No (=0)
v

Check
Progress (% complete)

Yes (>0)—»

Check
State at abort

Able to
complete?

Check Abort code'"

(1) See Table D-4, Index 57.

Yes (=1 6)—l

Check LPO stiffness out
of limits

No (>0)—| CAUTION

Yes (=0)

Check RPO stiffness out
of limits

No (>0)— CAUTION

Yes (=0)
v

PASS
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Figure 10-4 Meter verification procedure — PROFIBUS bus parameters

Step 1
Set output state (optional)

'

Step 2
Set uncertainty limit (optional)

y

Step 3
Start/abort procedure

y

Step 4 P
Check current algorithm state |

See Table 10-3.

«——Manual abort (optional}———

Step 5
Read percent complete

Yes (>0)—»

No (=0)
v

Step 6
Check algorithm abort state
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=
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Able to
complete?

l—No (<16 Yes (=16)—l

Step 9 Step 7
Check abort code Check inlet stiffness

No (>0)—»" CAUTION

Yes (=0)

Step 8
Check outlet stiffness

No (>0)—| CAUTION

Yes (=0)
v

PASS
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PROFIBUS bus parameters interface for meter verification

Step number Step description Interface®"

1 Set output state Diagnostic block (Slot 3)
Index 54

2 Set uncertainty limit Diagnostic block (Slot 3)
Index 55

3 Start/abort procedure Diagnostic block (Slot 3)
Index 53

4 Check current algorithm state Diagnostic block (Slot 3)
Index 56

5 Read percent complete Diagnostic block (Slot 3)
Index 61

6 Check algorithm abort state Diagnostic block (Slot 3)
Index 58

7 Check inlet stiffness Diagnostic block (Slot 3)
Index 59

8 Check outlet stiffness Diagnostic block (Slot 3)
Index 60

9 Read abort code Diagnostic block (Slot 3)
Index 57

(1) For detailed information, see Table D-4.

10.3.3  Running Smart Meter Verification
To run a Smart Meter Verification test:
*  Using ProLink II, see Figure 10-5.
» Using the display, see Figures 10-6 and 10-7.

* Using a PROFIBUS host with the EDD, refer to Figure C-7 and follow the procedure
illustrated in Figure 10-8.

* Using PROFIBUS bus parameters, use the Diagnostic block (see Table D-4) and follow the
procedure illustrated in Figure 10-9.

Note: If you start a Smart Meter Verification test using ProLink II, the EDD, or PROFIBUS bus
parameters, and the outputs are set to Last Measured Value or Fault, the transmitter display shows
the following message:

SENSOR
VERFY/x%
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Figure 10-5 Smart Meter Verification test — ProLink Il

Tools >
Meter Verification >
Run Meter Verification

Verify configuration View Previous Results
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(optional)

Next
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Y
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Smart Meter Verification top-level menu - Display

Scroll and Select simultaneously |
for 4 seconds

A

RESULTS READ SCHEDULE VERFY

v v v

[ Scroll ] [ Select ]

| L |
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Figure 10-7 Smart Meter Verification test — Display
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Smart Meter Verification test — EDD

Online > Online >
1 Overview > 3 Service Tools >
3 Shortcuts > 4 Maintenance >
6 Meter Verification 1 Routine Maintenance >
3 Meter Verification
6 3

A 4

1 Run Meter Verification
2 View Test Results
3 Schedule Meter Verification

[
1

v
Select Output Behavior

A 4

1 Continue Measuring
2 Outputs Held at Last Value
3 Outputs Held at Fault

!

Meter verification in progress:
X% complete

!

Result screen
A
| Abort | [ ok |
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Smart Meter Verification test - PROFIBUS bus parameters

Step 1 See Table 10-4.
Set output state (optional)

v

Step 2
Start/abort procedure

!

Step 3 P
Check current algorithm state |~
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[¢——Manual abort (optional)

Step 4
Read percent complete

Yes (>0

No (=0)
A 4

Step 5
Check algorithm abort state

Able to
complete?

rNo (<16 Yes (=16>—l
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o
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S
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Step 8 Step 6
Check abort code Check inlet stiffness
No (>0)—» CAUTION
Yes (=0)
Step 7 =
Check outlet stiffness g
<2
o
(7]
=
No (>0)— CAUTION 8
=
@
Yes (=0)
v
PASS
PROFIBUS bus parameters test interface for Smart Meter Verification
Step number Step description Interface"
1 Set output state Diagnostic block (Slot 3) -
* To Fault or Last Measured Value Index 54 g..
* To Continue Measurement Index 53 %

Configuration and Use Manual 101



Measurement Performance

102

PROFIBUS bus parameters test interface for Smart Meter Verification continued

Step number Step description Interface"
2 Start/abort test Diagnostic block (Slot 3)
* Fault or Last Measured Value Index 53
* Continue Measurement Not applicable (test started by
previous step)
3 Check current algorithm state Diagnostic block (Slot 3)
Index 56
4 Read percent complete Diagnostic block (Slot 3)
Index 61
5 Check algorithm abort state Diagnostic block (Slot 3)
Index 58
6 Check inlet stiffness Diagnostic block (Slot 3)
Index 59
7 Check outlet stiffness Diagnostic block (Slot 3)
Index 60
8 Read abort code Diagnostic block (Slot 3)
Index 57

(1) For detailed information, see Table D-4.

10.3.4

Reading and interpreting meter verification test results

Pass/Fail/Abort

When the meter verification test is completed, the result is reported as Pass, Fail or Caution
(depending on the tool you are using), or Abort:

Pass — The test result is within the specification uncertainty limit. In other words, the stiffness
of the left and right pickoffs match the factory values plus or minus the specification uncertain
limit. If transmitter zero and configuration match factory values, the sensor will meet factory
specifications for flow and density measurement. It is expected that meters will pass meter
verification every time the test is run.

Fail/Caution — The test result is not within the specification uncertainty limit. Micro Motion
recommends that you immediately repeat the meter verification test. If you were using Smart
Meter Verification, with outputs set to Continue Measurement, change the setting to Last
Measured Value or Fault.

- If the meter passes the second test, the first Fail/Caution result can be ignored.

- If the meter fails the second test, the flow tubes may be damaged. Use your process
knowledge to determine the possibilities for damage and the appropriate actions for each.
These actions might include removing the meter from service and physically inspecting
the tubes. At minimum, you should perform a flow validation and a density calibration.

Abort — A problem occurred with the meter verification test (e.g., process instability). Abort
codes are listed and defined in Table 10-5, and suggested actions are provided for each code.
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Meter verification abort codes

Abort code Description Suggested action
1 User-initiated abort None required. Wait for 15 seconds before
starting another test.
3 Frequency drift Ensure that temperature, flow, and density are
stable, and rerun the test.
5 High drive gain Ensure that flow is stable, minimize entrained
gas, and rerun the test.
8 Unstable flow Review the suggestions for stable flow in
Section 10.3.1 and rerun the test.
13 No factory reference data for meter verification = Contact Micro Motion customer service and
test performed on air provide the abort code.
14 No factory reference data for meter verification =~ Contact Micro Motion customer service and
test performed on water provide the abort code.
15 No configuration data for meter verification Contact Micro Motion customer service and
provide the abort code.
Other General abort. Repeat the test. If the test aborts again, contact

Micro Motion customer service and provide the
abort code.

Detailed test data with ProLink Il

For each test, the following data is stored on the transmitter:

Powered-on hours at the time of the test (Smart Meter Verification)
Test result

Stiffness of the left and right pickoffs, shown as percentage variation from the factory value. If
the test aborted, O is stored for these values.

Abort code, if applicable

ProLink II stores additional descriptive information for each test in a database on the local PC,
including:

Timestamp from the PC clock

Current flowmeter identification data

Current flow and density configuration parameters
Current zero values

Current process values for mass flow rate, volume flow rate, density, temperature, and external
pressure

(Optional) User-entered customer and test descriptions

If you are using Smart Meter Verification and you run a meter verification test from ProLink II,
ProLink II first checks for new test results on the transmitter and synchronizes the local database if
required. During this step, ProLink II displays the following message:

Synchronizing x out of y
Please wait

Note: If you request an action while synchronization is in process, ProLink Il displays a message
asking whether or not you want to complete synchronization. If you choose No, the ProLink 11
database may not include the latest test results from the transmitter.
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Test results are available at the end of each test, in the following forms:
*  Atestresult chart (see Figure 10-10).

A test report that includes the descriptive information for the current test, the test result chart,

and background information about meter verification. You can export this report to an HTML
file or print it to the default printer.

Note: To view the chart and the report for previous tests without running a test, click View Previous

Test Results and Print Report from the first meter verification panel. See Figure 10-5. Test reports are
available only for tests initiated from ProLink I1.

Test result chart

i@ Structural Integrity Meter Yerification - Test Results

Laszt Meter Verfication Result
’7@ tdeter PASSED Verification. Meter meets factary specifications.

Structural Integrity Normalized Stiffness
Transmiiter Model: 2T00C, Transmitier Serial No.: 0, Sensor Model: TO75, Sensor Serial No.: 0

1 Device Initiated Inlet Stiffness [ Device Initiated Outlet Stiffness & Prolink Initiated Inlet Stiffness
B Prolink Inttiated Cutlet Stiffness

4

T

3 Initiated from ProLink Il
Initiated from the display or other tool

"

-

A @B B A @ 7 B B B B A B @ 2B B A &

Uncertainty { %)
L =
|
=]
=

i

'
Ll

-4 Lowsr Spes LMt _ o ol _
A6TT 1678 1679 1680 1681 1682 1633 1684 1685 1636 1687 1688 1639 1690 1691 1692 1693 1694 1695 1696
Meter Verification Run Counter
A Ll
Right click on the graph ta interact with itD Click '< Back' to collect data again. Esport Data to C5Y Fils |
Click Mest ko generate and print report,

< Back I Mest > I Cancel | Help |

The test result chart shows the results for all tests in the ProLink II database, plotted against the
specification uncertainty limit. The inlet stiffness and the outlet stiffness are plotted separately. This
helps to distinguish between local and uniform changes to the sensor tubes.

This chart supports trend analysis, which can be helpful in detecting meter problems before they
become severe.
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Note the following:

The test result chart may not show all test results, and test counters may not be continuous.
ProLink II stores information about all tests initiated from ProLink II and all tests available on
the transmitter when the test database is synchronized. However, the transmitter stores only the
twenty most recent test results. To ensure a complete result set, always use ProLink II to
initiate the tests, or synchronize the ProLink II database before overwriting occurs.

The chart uses different symbols to differentiate between tests initiated from ProLink IT and
tests initiated using a different tool. A test report is available only for tests that were initiated
from ProLink II.

You can double-click the chart to manipulate the presentation in a variety of ways (change
titles, change fonts, colors, borders and gridlines, etc.), and to export the data to additional
formats (including “to printer”).

You can export this chart to a CSV file for use in external applications.

Detailed test data with the display

Note: Requires Smart Meter Verification. No detailed test data is available with the original version
of the meter verification application.

For each Smart Meter Verification test, the following data is stored on the transmitter:

Powered-on hours at the time of the test
Test result

Stiffness of the left and right pickoffs, shown as percentage variation from the factory value. If
the test aborted, O is stored for these values.

Abort code, if applicable

To view this data, see Figures 10-6 and 10-11.
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Meter verification test data — Display

RESULTS READ

> RUNCOUNT x
Scroll
Pass Result type Abort:
Fail
v l v
xx HOURS xx HOURS xx HOURS
PASS CAUTION Abort Type
xx L STF% xx L STF%
xx R STF% xx R STF%
RESULTS MORE?
Select Scroll
To Runcount x-1 - —To Run Verfy- >
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Detailed test data with the EDD

Note: Requires Smart Meter Verification. No detailed test data is available with the original version
of the meter verification application.

For each Smart Meter Verification test, the following data is stored on the transmitter:

¢ Powered-on hours at the time of the test

uonesuadwo)

e Test result

o Stiffness of the left and right pickoffs, shown as percentage variation from the factory value. If
the test aborted, O is stored for these values.

e Abort code, if applicable
To view this data, see Figure 10-12.

Meter verification test data — EDD

Online > Online >
1 Overview > 3 Service Tools >
3 Shortcuts > 4 Maintenance >
6 Meter Verification 1 Routine Maintenance >

3 Meter Verification
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v

1 Run Meter Verification
2 View Test Results
3 Schedule Meter Verification

[
2
v

1 Run Counter

2 Running Hours

3 Test Result

4 Abort Code

5 LPO Stiffness

5 RPO Stiffness

7 Show Results Table
8 Show Results Plot
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Detailed test data with PROFIBUS bus parameters

Note: Requires Smart Meter Verification. No detailed test data is available with the original version
of the meter verification application.

For each Smart Meter Verification test, the following data is stored on the transmitter:
e Powered-on hours at the time of the test
e Testresult

» Stiffness of the left and right pickoffs, shown as percentage variation from the factory value. If
the test aborted, O is stored for these values.

e Abort code, if applicable
To view this data, see Figure 10-13.

Meter verification test data — PROFIBUS bus parameters

Step 1 See Table 10-6.
Set index

v

Step 2
Read test counter

v

Step 3
Read test start time

!

Step 4
Read test result

!

Step 5
Read LPO stiffness

!

Step 6
Read LPO stiffness

PROFIBUS hus parameters test data interface for Smart Meter Verification

Step number Step description Interface"

1 Set index Diagnostic block (Slot 3)
Index 87

2 Read test counter Diagnostic block (Slot 3)
Index 88

3 Read test start time Diagnostic block (Slot 3)
Index 89

4 Read test result Diagnostic block (Slot 3)
Index 90

5 Read LPO stiffness Diagnostic block (Slot 3)
Index 91

6 Read RPO stiffness Diagnostic block (Slot 3)
Index 92

(1) For detailed information, see Table D-4.
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10.3.5  Setting up automatic or remote execution of the meter verification test

Note: Requires Smart Meter Verification. Scheduling is not available with the original version of the
meter verification application.

There are three ways to execute a Smart Meter Verification test automatically:

¢ Define it as an event action

uonesuadwo)

e Set up a one-time automatic execution
* Set up a recurring execution

You can use these methods in any combination. For example, you can specify that a Smart Meter
Verification test will be executed three hours from now, every 24 hours starting now, and every time a
specific discrete event occurs.

¢ To define meter verification as an event action, see Section 8.6.

» To set up a one-time automatic execution, set up a recurring execution, view the number of
hours until the next scheduled test, or delete a schedule:

- With ProLink II, click Tools > Meter Verification > Schedule Meter Verification.
- With the display, see Figures 10-6 and 10-14.
- With the EDD, see Figure 10-15.
- With PROFIBUS bus parameters, see Figure 10-16.
Note the following:
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* If you are setting up a one-time automatic execution, specify the start time as a number of
hours from the present time. For example, if the present time is 2:00 and you specify 3.5 hours,
the test will be initiated at 5:30.

» If you are setting up a recurring execution, specify the number of hours to elapse between
executions. The first test will be initiated when the specified number of hours has elapsed, and
testing will be repeated at the same interval until the schedule is deleted. For example, if the
present time is 2:00 and you specify 2 hours, the first test will be initiated at 4:00, the next at
6:00, and so on.

* If you delete the schedule, both the one-time execution and the recurring execution settings are
deleted.
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Smart Meter Verification scheduler - Display

SCHEDULE VERFY

A

No Schedule set? es
v v

SCHED IS OFF TURN OFF SCHED/YES?

Scroll

Schedule deleted
v \
HOURS LEFT <
[ Scroll Select ]
xx HOURS
A
— SET NEXT —{ scroll J SET RECUR EXIT
Select Select
e -
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SAVE/YES? SAVE/YES?
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[ Scroll ] [ Select l [ Scroll ] [ Select ]
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Smart Meter Verification scheduler — EDD

3 Meter Verification

(@)

Online > Online > g
1 Overview > 3 Service Tools > o

3 Shortcuts > 4 Maintenance > g

6 Meter Verification 1 Routine Maintenance > &

=L

=

=

v

1 Run Meter Verification
2 View Test Results
3 Schedule Meter Verification

!
v

1 Next Run

2 Set Hrs Until Next Run
3 Set Recurring Hours

4 Turn Off Schedule

Smart Meter Verification scheduler - PROFIBUS bus parameters
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Step 1 See Table 10-7.

Set hours until first test

v

Step 2
Set hours between tests

=
PROFIBUS bus parameters scheduler interface for Smart Meter Verification g
c
o
Step number Step description Interface" -
o
1 Set hours until first test Diagnostic block (Slot 3) S
Index 93 a
2 Set hours between tests Diagnostic block (Slot 3)
Index 94
(1) For detailed information, see Table D-4.
10.4  Performing meter validation
To perform meter validation, measure a sample of the process fluid and compare the measurement
with the flowmeter’s reported value.
Use the following formula to calculate a meter factor:
&
_ ' ExternalStandard Y
NewMeterFactor = ConfiguredMeterFactor x ActuaTransmitterMeasurement %
»

Valid values for meter factors range from 0.8 to 1.2. If the calculated meter factor exceeds these
limits, contact Micro Motion customer service.
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To configure meter factors:
* Using ProLink II, see Figure C-2.
* Using the display menus, see Figure C-16.
* Using a PROFIBUS host with the EDD, see Figure C-8.

* Using PROFIBUS bus parameters, use the Measurement block, Indices 15, 16, and 17 (see
Table D-2).

Example The flowmeter is installed and proved for the first time. The flowmeter

mass measurement is 250.27 Ib; the reference device measurement is
250 Ib. A mass flow meter factor is determined as follows:

250

55027 — 09989

MassFlowMeterFactor = 1 x

The first mass flow meter factor is 0.9989.

One year later, the flowmeter is proved again. The flowmeter mass
measurement is 250.07 Ib; the reference device measurement is
250.25 Ib. A new mass flow meter factor is determined as follows:

250.25
250.07

MassFlowMeterFactor = 0.9989 x = 0.9996

The new mass flow meter factor is 0.9996.

10.5
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Performing zero calibration

Zeroing the flowmeter establishes the flowmeter’s point of reference when there is no flow. The meter
was zeroed at the factory, and should not require a field zero. However, you may wish to perform a
field zero to meet local requirements or to confirm the factory zero.

When you zero the flowmeter, you may need to adjust the zero time parameter. Zero time is the
amount of time the transmitter takes to determine its zero-flow reference point. The default zero time
is 20 seconds.

* A long zero time may produce a more accurate zero reference but is more likely to result in a
zero failure. This is due to the increased possibility of noisy flow, which causes incorrect
calibration.

* A short zero time is less likely to result in a zero failure but may produce a less accurate zero
reference.

For most applications, the default zero time is appropriate.

Note: Do not zero the flowmeter if a high severity alarm is active. Correct the problem, then zero the
flowmeter. You may zero the flowmeter if a low severity alarm is active. See Section 7.6 for
information on viewing transmitter status and alarms.
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If the zero procedure fails, two recovery functions are provided:

* Restore prior zero, available only from ProLink II and only during the current zero procedure.
Once you have closed the Calibration dialog box or disconnected from the transmitter, you can
no longer restore the prior zero.

* Restore factory zero, available via:
- The display (see Figure C-16)
- ProLink II, in the Calibration dialog box (see Figure C-1)
- A PROFIBUS host with the EDD (see Figure C-7)
- PROFIBUS bus parameters (Calibration block, Index 42; see Table D-3).

If desired, you can use one of these functions to return the meter to operation while you are
troubleshooting the cause of the zero failure (see Section 11.8).

uonesuadwo)

10.5.1 Preparing for zero
To prepare for the zero procedure:
1. Apply power to the flowmeter. Allow the flowmeter to warm up for approximately 20 minutes.

2. Run the process fluid through the sensor until the sensor temperature reaches the normal
process operating temperature.

3. Close the shutoff valve downstream from the sensor.
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4. Ensure that the sensor is completely filled with fluid.

5. Ensure that the process flow has completely stopped.

A CAUTION

If fluid is flowing through the sensor during zero calibration, the calibration
may be inaccurate, resulting in inaccurate process measurement.

=
To improve the sensor zero calibration and measurement accuracy, ensure that 2
process flow through the sensor has completely stopped. %
S
o
=Y
10.5.2  Zero procedure 3
To zero the flowmeter:
»  Using the zero button, see Figure 10-17.
» Using the display menu, see Figure 10-18. For a complete illustration of the display zero
menu, see Figure C-16.
e Using ProLink II, see Figure 10-19.
* Using a PROFIBUS host with the EDD, use the Zero Calibration window in the Device menu.
See Figure C-16.
* Using PROFIBUS bus parameters, see Figure 10-21.
S
o
=
)
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Note the following:

If the transmitter was ordered with a display:

The zero button is not available.

If the off-line menu has been disabled, you will not be able to zero the transmitter with the
display. For information about enabling and disabling the off-line menu, see Section 8.9.5.

You cannot change the zero time with the display. If you need to change the zero time, you
must use ProLink II or PROFIBUS protocol.

If the transmitter was ordered without a display, the zero button is available.

You cannot change the zero time with the zero button. If you need to change the zero time,
you must use ProLink II or PROFIBUS protocol.

The zero button is located on the user interface board, beneath the transmitter housing
cover (see Figure 3-1). For instructions on removing the transmitter housing cover, see
Section 3.3.

To press the zero button, use a fine-pointed object that will fit into the opening (0.14 in or
3.5 mm). Hold the button down until the status LED on the user interface module begins to
flash yellow.

During the zero procedure, the status LED on the user interface module flashes yellow.

Zero button - Flowmeter zero procedure

’ Press ZERO button ‘

v

Status LED flashes
yellow

Solid Solid Green or
Red Solid Yellow
Troubleshoot Done
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Figure 10-18 Display menu — Flowmeter zero procedure

Scroll and Select simultaneously
for 4 seconds

Scroll

‘ OFF-LINE MAINT ‘

Select

1_

Scroll

‘ ZERO ‘

Select

LS

‘ ZERO/YES? ‘
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v v
‘ CAL FAIL ‘ ‘ CAL PASS ‘
|—Troub|esho:.,t |

Select

LS

‘ ZERO ‘

Scroll

L

‘ EXIT ‘

Figure 10-19 ProLink Il - Flowmeter zero procedure

ProLink >
Calibration >
Zero Calibration

v

Modify zero time
if required

Perform Auto Zero

Calibration in Progress
LED turns red

v

Wait until Calibration in
Progress LED turns green

Calibration
Failure LED

l—Red

Troubleshoot
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PROFIBUS host with EDD - Flowmeter zero procedure

Device >
Zero Calibration

v

Modify zero time
if required

[ Transfer

v

Perform Auto Zero =
Start Zero Calibration

Transfer

v

Check status
Alarm Five, Bit 8

On Bit 8 value Off]

Check procedure outcome
Alarm Three

lers Zero failed? N

Troubleshoot

Check zero value
Flow Signal Offset at Zero Flow

v

Done

PROFIBUS bus parameters — Flowmeter zero procedure

Modify zero time if .| Block: Calibration (Slot 2)
required “"lIndex 7
Perform zero o> Block: Calibration (Slot 2)
Index 6
.| Block: Diagnostic (Slot 3)
Check status ™ Index 14, Bit 15
Check outcome > Block: Diagnostic (Slot 3)

Index 14, Bits 8, 9, 10, 11

A

Block: Calibration (Slot 2)
Check zero values »» Index 8 (standard deviation)
Index 9 (offset)
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10.6

Performing density calibration
Density calibration includes the following calibration points:
e All sensors:
- DI calibration (low-density)
- D2 calibration (high-density)
e T-Series sensors only:
- D3 calibration (optional)
- D4 calibration (optional)

For T-Series sensors, the optional D3 and D4 calibrations could improve the accuracy of the density
measurement. If you choose to perform the D3 and D4 calibration:

* Do not perform the D1 or D2 calibration.
*  Perform D3 calibration if you have one calibrated fluid.

*  Perform both D3 and D4 calibrations if you have two calibrated fluids (other than air and
water).

The calibrations that you choose must be performed without interruption, in the order listed here.

Note: Before performing the calibration, record your current calibration parameters. If you are using
ProLink II, you can do this by saving the current configuration to a file on the PC. If the calibration
fails, restore the known values.

You can calibrate for density with ProLink II, a PROFIBUS host with the EDD, or PROFIBUS bus
parameters.

10.6.1 Preparing for density calibration

Before beginning density calibration, review the requirements in this section.

Sensor requirements

During density calibration, the sensor must be completely filled with the calibration fluid, and flow
through the sensor must be at the lowest rate allowed by your application. This is usually
accomplished by closing the shutoff valve downstream from the sensor, then filling the sensor with
the appropriate fluid.

Density calibration fluids

D1 and D2 density calibration require a D1 (low-density) fluid and a D2 (high-density) fluid. You
may use air and water. If you are calibrating a T-Series sensor, the D1 fluid must be air and the D2
fluid must be water.

A CAUTION

For T-Series sensors, the D1 calibration must be performed on air and the D2
calibration must be performed on water.

Configuration and Use Manual 117
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For D3 density calibration, the D3 fluid must meet the following requirements:
e Minimum density of 0.6 g/cm’

»  Minimum difference of 0.1 g/cm® between the density of the D3 fluid and the density of water.
The density of the D3 fluid may be either greater or less than the density of water

For D4 density calibration, the D4 fluid must meet the following requirements:
e Minimum density of 0.6 g/cm’

e Minimum difference of 0.1 g/cm® between the density of the D4 fluid and the density of the
D3 fluid. The density of the D4 fluid must be greater than the density of the D3 fluid

e Minimum difference of 0.1 g/cm’ between the density of the D4 fluid and the density of water.
The density of the D4 fluid may be either greater or less than the density of water

10.6.2  Density calibration procedures

To perform a D1 and D2 density calibration:
*  With ProLink II, see Figure 10-22.
e With a PROFIBUS host with the EDD, see Figure 10-23.
*  With PROFIBUS bus parameters, see Figure 10-24.

To perform a D3 density calibration or a D3 and D4 density calibration:
e With ProLink II, see Figure 10-25.
*  With a PROFIBUS host with the EDD, see Figure 10-26.
*  With PROFIBUS bus parameters, see Figure 10-27.

D1 and D2 density calibration — ProLink Il

Close shutoff valve

D1 calibration

Fill sensor with D1 fluid

downstream from sensor

118

) 4

l

D2 calibration

Fill sensor with D2 fluid

ProLink Menu >
Calibration >
Density cal — Point 1

l

Enter density of D1 fluid

Calibration in Progress
light turns red

}

Calibration in Progress
light turns green

Close
|

\ 4

l

ProLink Menu >
Calibration >
Density cal — Point 2

l

Enter density of D2 fluid

Calibration in Progress
light turns red

|

Calibration in Progress
light turns green

Close
|

v

Done
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D1 and D2 density calibration — PROFIBUS host with EDD

Close shutoff valve

D1 calibration

downstream from sensor

A 4

Fill sensor with D1 fluid

'

Device >

Density cal

v

D1 = Density of D1 fluid

v

Do Density Cal — Point 1 =
Start Cal

Transfer

Check status
Alarm Five

Ye

D1 calibration

D2 calibration

in progress?

Fill sensor with D2 fluid

'

A4

D2 = Density of D2 fluid

'

Do Density Cal — Point 2 =
Start Cal

Transfer

Check status
Alarm Five

D2 calibration
in progress?

Yes

Done'"

(1) K1 and K2 values are displayed in the Density section of the Configuration Parameters menu.
You may need to reload values from the transmitter to see the results of the density calibration.

D1 and D2 density calibration — PROFIBUS bus parameters

Close shutoff valve

downstream from sensor

Fill sensor with D1 fluid

!

D1 calibration

Fill sensor with D2 fluid

Enter density of D1 fluid —»»

Block: Calibration (Slot 2)
Index 21

v

Start D1 calibration

b

Block: Calibration (Slot 2)
Index 11

v

Monitor status

b

Block: Diagnostic (Slot 3)
Index 14, Bit 14

2

No

Bit 14 0ff?
Yes

v

Check K1 value

——

Block: Diagnostic (Slot 3)
Index 16

!

D2 calibration

Enter density of D2 fluid —»»

Index 22

Block: Calibration (Slot 2)

v

Start D2 calibration —>p

Index 12

Block: Calibration (Slot 2)

v

Monitor status >

Block: Diagnostic (Slot 3)
Index 14, Bit 13

4

Yes

v

Check K2 value

Index 17

Block: Diagnostic (Slot 3)
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D3 or D3 and D4 density calibration — ProLink Il

Close shutoff valve

D3 calibration

A 4

Fill sensor with D3 fluid

downstream from sensor

v

ProLink Menu >
Calibration >
Density cal — Point 3

v

Enter density of D3 fluid

Calibration in Progress
light turns red

v

Calibration in Progress
light turns green

Close

D4 calibration

A4

Fill sensor with D4 fluid

ProLink Menu >
Calibration >
Density cal — Point 4

v

Enter density of D4 fluid

Calibration in Progress
light turns red

'

Calibration in Progress
light turns green

Close

Done

v

v
Done

D3 or D3 and D4 density calibration — PROFIBUS host with EDD

Close shutoff valve
downstream from sensor

D3 calibration

Fill sensor with D3 fluid

\ 4

Device >
Density cal

v

D3 = Density of D3 fluid

v

Do Density Cal — Point 3 =
Start Cal

Transfer

Check status
Alarm Five

D3 calibration

Yes: -
in progress?

D4 calibration

Fill sensor with D4 fluid

!

A4

D4 = Density of D4 fluid

v

Do Density Cal — Point 4 =
Start Cal

!

Check status
Alarm Five

D4 calibration

Yes: -
in progress?

Done'”

(1) K3 and K4 values are displayed in the Density section of the Configuration Parameters menu.
You may need to reload values from the transmitter to see the results of the density calibration.

120 Micro Motion® Model 2400S Transmitters for PROFIBUS-DP



Measurement Performance

Figure 10-27 D3 or D3 and D4 density calibration - PROFIBUS bus parameters

10.7

Close shutoff valve
downstream from sensor

Y

Fill sensor with D3 fluid

'

D3 calibration

Enter density of D3 fluid

Block: Calibration (Slot 2)
Index 24

'

Start D3 calibration

Block: Calibration (Slot 2)
Index 14

v

Monitor status

Block: Diagnostic (Slot 3)
Index 14, Bit 6

A

Bit 6 Off?

Yes

v

Check K3 value

Block: Diagnostic (Slot 3)
Index 19

» Fill sensor with D4 fluid

!

D4 calibration

Enter density of D4 fluid

Block: Calibration (Slot 2)
Index 25

'

Start D4 calibration

Block: Calibration (Slot 2)
Index 15

v

Monitor status

—>>

Block: Diagnostic (Slot 3)
Index 14, Bit 7

A

Yes

v

Check K4 value

Block: Diagnostic (Slot 3)
Index 20

Performing temperature calibration

Temperature calibration is a two-part procedure: temperature offset calibration and temperature slope
calibration. The entire procedure must be completed without interruption.

Done

Done

To perform temperature calibration, you must use ProLink II. See Figure 10-28.
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Temperature calibration — ProLink Il

Temperature Offset calibration

Fill sensor with low-
temperature fluid

!

Wait until sensor achieves
thermal equilibrium

!

ProLink Menu >
Calibration >
Temp offset cal

’

Enter temperature of low-
temperature fluid

Calibration in Progress
light turns red

'

Calibration in Progress
light turns green

Close

Temperature Slope calibration

Fill sensor with high-

temperature fluid

v

Wait until sensor achieves
thermal equilibrium

'

ProLink Menu >
Calibration >
Temp slope cal

v

Enter temperature of high-
temperature fluid

Calibration in Progress
light turns red

'

Calibration in Progress
light turns green

Close

v

Done
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11.1  Overview

This chapter describes guidelines and procedures for troubleshooting the flowmeter. The information
in this chapter will enable you to:

* Categorize the problem
e Determine whether you are able to correct the problem
» Take corrective measures (if possible)

*  Contact the appropriate support agency

Note: All procedures provided in this chapter assume that you have established communication with
the Model 24008 DP transmitter and that you are complying with all applicable safety requirements.

Note: If you are using Pocket ProLink, the interface is similar to the ProLink Il interface described in
this chapter.

99UBWLIONA JUBWaINSEa|

A WARNING

Using the service port clips to communicate with the transmitter in a
hazardous area can cause an explosion.

Before using the service port clips to communicate with the transmitter in a
hazardous area, make sure the atmosphere is free of explosive gases.

11.2  Guide to troubleshooting topics
Refer to Table 11-1 for a list of troubleshooting topics discussed in this chapter.
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Troubleshooting topics and locations

Section Topic

Section 11.4 Transmitter does not operate

Section 11.5 Transmitter does not communicate

Section 11.6 Checking the communication device

Section 11.7 Diagnosing wiring problems

Section 11.7.1 Checking the power supply wiring

Section 11.7.2 Checking PROFIBUS wiring g
Section 11.7.3 Checking grounding %
Section 11.8 Zero or calibration failure “
Section 11.9 Fault conditions

Section 11.10 Simulation mode
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11.3

11.4

11.5

11.6
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Troubleshooting topics and locations continued

Section Topic

Section 11.11 Transmitter LEDs

Section 11.12 Status alarms

Section 11.13 Checking process variables
Section 11.14 Checking slug flow

Section 11.15 Checking the sensor tubes
Section 11.16 Checking the flow measurement configuration
Section 11.17 Checking the characterization
Section 11.18 Checking the calibration

Section 11.19 Restoring a working configuration
Section 11.20 Checking the test points

Section 11.21 Checking sensor circuitry

Micro Motion customer service

To speak to a customer service representative, contact the Micro Motion customer service department.
Contact information is provided in Section 1.10.

Before contacting Micro Motion customer service, review the troubleshooting information and
procedures in this chapter, and have the results available for discussion with the technician.

Transmitter does not operate

If the transmitter is not receiving power, all three LEDs on the user interface will be off.
1. Check the power supply to the transmitter, as described in Section 11.7.1.
2. Check the grounding, as described in Section 11.7.3.

If the procedures do not indicate a problem with the electrical connections, contact the Micro Motion
customer service department.

Transmitter does not communicate

If the transmitter does not appear to be communicating, the wiring may be faulty or the
communication device may be incompatible. Check the wiring and the communication device:

*  For ProLink II and Pocket ProLink, see Section 11.6 and Chapter 4.

*  For a PROFIBUS host, see Section 11.6, Section 11.7.2, and Chapter 5. Ensure that the
PROFIBUS host is configured to use the appropriate node address.

If you are trying to communicate via the IrDA port, ensure that the port is enabled and that there is no
active connection via the service port clips. See Section 8.10.2.

Checking the communication device

Ensure that your communication device is compatible with your transmitter.

Micro Motion® Model 2400S Transmitters for PROFIBUS-DP
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11.7

ProLink Il

ProLink II v2.5 or later is required. To check the version of ProLink II:
1. Start ProLink II.
2. Click Help > About ProLink.

Verify that ProLink II can connect to other devices using the same connection type (e.g., service port).
If you cannot connect to other devices, see the ProLink II manual for troubleshooting assistance.

Pocket ProLink
Pocket ProLink v1.3 or later is required. To check the version of Pocket ProLink:
1. Start Pocket ProLink.

2. Tap the Information icon (the question mark) at the bottom of the main screen.

PROFIBUS host

The Model 2400S DP transmitter is compatible with all PROFIBUS hosts. Check that your
PROFIBUS host is correctly configured and can make a connection to other devices on the network.

Diagnosing wiring problems

Use the procedures in this section to check the transmitter installation for wiring problems.

A WARNING

Removing the transmitter housing cover in explosive atmospheres while the
device is powered can subject the transmitter to environmental conditions
that can cause an explosion.

Before removing the transmitter housing cover in explosive atmospheres, be sure
to remove power from the device and wait five minutes.

11.71 Checking the power supply wiring
To check the power supply wiring:

1. Follow appropriate procedures to ensure that the process of checking the power supply wiring
does not interfere with existing measurement and control loops.

2. Power down the transmitter.
3. If the transmitter is in a hazardous area, wait five minutes.
4. Referring to Figure B-1:

a. Loosen the four captive transmitter housing cover screws and remove the transmitter
housing cover.

b. Loosen the two captive user interface screws.

c. Gently lift the user interface module, disengaging it from the connector on the transmitter.
5. Referring to Figure B-2:

a. Loosen the Warning flap screw.

b. Lift the Warning flap.

6. Ensure that the power supply wires are connected to the correct terminals. See Figure B-2.
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11.8

11.9

126

7. Verify that the power supply wires are making good contact, and are not clamped to the wire
insulation.

8. Inspect the voltage label on the inside of the field-wiring compartment. Verify that the voltage
supplied to the transmitter matches the voltage specified on the label.

9. Use a voltmeter to test the voltage at the transmitter’s power supply terminals. Verify that it is
within the specified limits. For DC power, you may need to size the cable. See your transmitter
installation manual for power supply requirements.

11.7.2  Checking PROFIBUS wiring
To check the PROFIBUS wiring:

1. Follow appropriate procedures to ensure that the process of checking the PROFIBUS wiring
does not interfere with existing measurement and control loops.

2. Referring to Figure B-1:

a. Loosen the four captive transmitter housing cover screws and remove the transmitter
housing cover.

b. Loosen the two captive user interface screws.
c. Gently lift the user interface module, disengaging it from the connector on the transmitter.

3. Visually inspect the PROFIBUS cable and wiring. Ensure that the wires are inserted into the
correct terminals (see Figure B-2), contact is good at both ends, the cable is not crimped, and
the cable covering is intact. Replace the cable if appropriate.

4. Verify that the internal termination resistor switch is set correctly for your installation. See
Figure 3-1 or 3-2.

11.7.3  Checking grounding

The sensor / transmitter assembly must be grounded. See your sensor installation manual for
grounding requirements and instructions.

Zero or calibration failure

If a zero or calibration procedure fails, the transmitter will send a status alarm indicating the cause of
failure. See Section 11.12 for specific remedies for status alarms indicating calibration failure.

Fault conditions

If a fault is reported, determine the exact nature of the fault by checking the status alarms (see
Section 7.6). Once you have identified the status alarm(s) associated with the fault condition, refer to
Section 11.12.

Some fault conditions can be corrected by cycling power to the transmitter. A power cycle can clear
the following:

e Zero failure

* Stopped internal totalizer

Micro Motion® Model 2400S Transmitters for PROFIBUS-DP



Troubleshooting

11.10 Simulation mode

Simulation allows you to define arbitrary values for mass flow, temperature, and density. Simulation
mode has several uses:

e It can help determine if a problem is located in the transmitter or elsewhere in the system. For
example, signal oscillation or noise is a common occurrence. The source could be the
PROFIBUS host, the meter, improper grounding, or a number of other factors. By setting up
simulation to output a flat signal, you can determine the point at which the noise is introduced.

uonesuadwo)

e It can be used to analyze system response or to tune the loop.

If simulation mode is active, the simulated values are stored in the same memory locations used for
process data from the sensor. Therefore, the simulated values will be used throughout transmitter
functioning. For example, simulation will affect:

e All mass flow, temperature, or density values shown on the display or reported via digital
communications

* The mass total and inventory values

*  All volume calculations and data, including reported values, volume total, and volume
inventory

*  All related values logged by Data Logger (a ProLink II utility)

Accordingly, do not enable simulation when your process cannot tolerate these effects, and be sure to
disable simulation when you have finished testing.

99UBWLIONA JUsWaINSea|

Note: Unlike actual mass flow and density values, the simulated values are not
temperature-compensated.

Simulation does not change any diagnostic values.

Simulation mode is available only via ProLink II. To set up simulation, refer to Figure C-3 and follow
the steps below:

1. Enable simulation mode.
2. For mass flow:

a. Specify the type of simulation you want: fixed value, sawtooth (triangular wave), or sine
wave.

b. Enter the required values.
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* If you specified fixed value simulation, enter a fixed value.

* If you specified sawtooth or sine wave simulation, enter a minimum value, maximum
value, and wave period. Minimum and maximum values are entered in the current
measurement units; the wave period is entered in seconds.

3. Repeat Step 2 for temperature and density.

To use simulation mode for problem location, enable simulation mode and check the signal at various
points between the transmitter and the receiving device.
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1.1

11.12

Alarm
code

Transmitter LEDs

The user interface module includes three LEDs:

e A status LED. See Table 7-3 for information on status LED behavior. If the status LED
indicates an alarm condition:

a. View the alarm code using the procedures described in Section 7.6.

b. Identify the alarm (see Section 11.12).

c. Correct the condition.

d. If desired, acknowledge the alarm using the procedures described in Section 7.7.

¢ A network LED. See Table 7-1 for information on the behavior of the network LED. The
network LED indicates the state of the device on the network, and does not indicate device
status. Troubleshooting should focus on the network rather than the device.

* A software address LED. See Table 7-2 for information on the behavior of the software
address LED. You may need to set the node address for the Model 2400S DP transmitter, or
you may need to configure the PROFIBUS host to use the existing node address.

Status alarms

Status alarm codes are reported on the LCD panel (for transmitters that have displays), and status
alarms can be viewed with ProLink II or a PROFIBUS host. All possible status alarms are listed in
Table 11-2, along with the PROFIBUS host or ProLink II message, possible causes, and suggested

remedies.

You may find it useful to acknowledge all alarms before beginning the troubleshooting procedures.
This will remove inactive alarms from the list and allow you to focus on active alarms.

Status alarms and remedies

Message!"

Cause

Suggested remedy

A001

EEprom Checksum Error
(Core Processor)

(E)EPROM Checksum
Error (CP)

An uncorrectable
checksum mismatch has
been detected

* Cycle power to the flowmeter.
* The flowmeter might need service. Contact Micro
Motion.

AQ002

RAM Test Error (Core
Processor)

RAM Error (CP)

ROM checksum error or a
RAM location cannot be
written to

¢ Cycle power to the flowmeter.
* The flowmeter might need service. Contact Micro
Motion.

A003

Sensor Not Responding
(No Tube Interrupt)

Sensor Failure

Continuity failure of drive
circuit, LPO, or RPO, or
LPO-RPO mismatch when
driving

* Check for slug flow. See Section 11.14.

* Check the test points. See Section 11.20.

* Check the sensor circuitry. See Section 11.21.
* Check sensor tubes for plugging.

* If the problem persists, contact Micro Motion.

A004

Temperature sensor out
of range

Temperature Sensor
Failure

Combination of A016 and
A017

* Check the sensor RTD circuitry. See Section 11.21.

* Verify that process temperature is within range of
sensor and transmitter.

* If the problem persists, contact Micro Motion.
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Alarm
code

Status alarms and remedies continued

Message"

Cause

Suggested remedy

A005

Input Over-Range

Input Overrange

The measured flow has
exceeded the maximum
flow rate of the sensor
(AT > 200 ps)

* If other alarms are present (typically, AO03, A006,
A008, A102, or A105), resolve those alarm
conditions first. If the A005 alarm persists, continue
with the suggestions here.

* Verify process and check for slug flow. See
Section 11.14.

* Check the test points. See Section 11.20.

* Check the sensor circuitry. See Section 11.21.

* Check the sensor tubes for erosion. See
Section 11.15.

* If the problem persists, contact Micro Motion.

A006

Transmitter Not
Characterized

Not Configured

Combination of A020 and
A021

* Check the characterization. Specifically, verify the
FCF and K1 values. See Section 6.2.
* If the problem persists, contact Micro Motion.

A008

Density Outside Limits

Density Overrange

The measured density has
exceeded 0-10 g/cm?®

* If other alarms are present (typically, AO03, A006,
A102, or A105), resolve those alarm conditions first.
If the AOO8 alarm persists, continue with the
suggestions here.

* Verify process. Check for air in the flow tubes, tubes
not filled, foreign material in tubes, or coating in tubes
(see Section 11.15).

* Check for slug flow. See Section 11.14.

* Check the sensor circuitry. See Section 11.21.

* Verify calibration factors in transmitter configuration.
See Section 6.2.

* Check the test points. See Section 11.20.

« If the problem persists, contact Micro Motion.

A009

Transmitter
Initializing/Warming Up

Transmitter
Initializing/Warming Up

Transmitter in power-up
mode

* Allow the flowmeter to warm up (approximately 30
seconds). The error should disappear once the
flowmeter is ready for normal operation.

¢ [f alarm does not clear, make sure that the sensor is
completely full or completely empty.

* Check the sensor circuitry. See Section 11.21.

A010

Calibration Failure

Calibration Failure

Mechanical zero: The
resulting zero was greater
than 3 us
Temperature/Density
calibrations: many
possible causes

* If alarm appears during a transmitter zero, ensure
that there is no flow through the sensor, then retry.

* Cycle power to the flowmeter, then retry.

* If appropriate, restore the factory zero to return the
flowmeter to operation.

AO011

Excess Calibration
Correction, Zero too Low

Zero Too Low

See A010

* Ensure that there is no flow through the sensor, then
retry.

* Cycle power to the flowmeter, then retry.

* If appropriate, restore the factory zero to return the
flowmeter to operation.

A012

Excess Calibration
Correction, Zero too
High

Zero Too High

See A010

* Ensure that there is no flow through the sensor, then
retry.

* Cycle power to the flowmeter, then retry.

* If appropriate, restore the factory zero to return the
flowmeter to operation.
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Troubleshooting

Status alarms and remedies continued

Alarm
code Message'" Cause Suggested remedy
A013 Process too Noisy to See A010 * Remove or reduce sources of electromechanical
Perform Auto Zero noise, then retry. Sources of noise include:
. - Mechanical pumps
Zero Too Noisy - Pipe stress at sensor
- Electrical interference
- Vibration effects from nearby machinery
* Cycle power to the flowmeter, then retry.
* If appropriate, restore the factory zero to return the
flowmeter to operation.
AO014 Transmitter Failed Many possible causes * Cycle power to the flowmeter.
- . * The transmitter might need service. Contact Micro
Transmitter Failed Motion
A016 Line RTD Temperature The value computed for * Check the sensor RTD circuitry. See Section 11.21.
Out-Of-Range the resistance of the Line e« Verify that process temperature is within range of
Line RTD T i RTD is outside limits sensor and transmitter.
Ine emperature ¢ |f the problem persists, contact Micro Motion.
Out-of-Range
A017 Meter RTD Temperature The value computed for * Check the sensor RTD circuitry. See Section 11.21.
Out-Of-Range the resistance of the * Verify that process temperature is within range of
Meter RTD Temperatur Meter/Case RTD is sensor and transmitter.
Oet-e R emperature — ,tside limits * Check the characterization. Specifically, verify the
ut-ol-nange FCF and K1 values. See Section 6.2.
* If the problem persists, contact Micro Motion.
A020 Calibration Factors The flow calibration factor ~  Check the characterization. Specifically, verify the
Unentered and/or K1 has not been FCF and K1 values. See Section 6.2.
.. entered since the last ¢ |f the problem persists, contact Micro Motion.
Calibration Factors master reset
Unentered (FlowCal)
A021 Unrecognized/ The sensor is recognized  * Check the characterization. Specifically, verify the
Unentered Sensor Type  as a straight tube but the FCF and K1 values. See Section 6.2.
| tS T K1 value indicates a * Check the sensor RTD circuitry. See Section 11.21.
(r&ac))rrec ensor lype curved tube, or vice versa e |If the problem persists, contact Micro Motion.
A029 Internal Communication  Transmitter electronics * Cycle power to the flowmeter.
Failure failure * Contact Micro Motion.
PIC/Daughterboard
Communication Failure
A030 Hardware/Software The loaded software is not  * Contact Micro Motion.
Incompatible compatible with the
Incorrect Board Type programmed board type
A031 Undefined The transmitter is not * Check power supply to transmitter. See
receiving enough power Section 11.7.1.
Low Power
A032®  Meter Verification Fault ~ Meter verification in ¢ Allow the procedure to complete.
Alarm progress, with outputs set e If desired, abort the procedure and restart with
to fault outputs set to last measured value.
Meter
Verification/Outputs In
Fault
A032®  Qutputs Fixed during Meter verification in * Allow the procedure to complete.

Meter Verification

Meter Verification In
Progress and Outputs
Fixed

progress, with outputs set
to Fault or Last Measured
Value.

¢ |f desired, abort the procedure and restart with
outputs set to Continue Measurement.
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Status alarms and remedies continued

Alarm
code Message'" Cause Suggested remedy
A033 Sensor OK, Tubes No signal from LPO or * Verify process. Check for air in the flow tubes, tubes
Stopped by Process RPO, suggesting that not filled, foreign material in tubes, or coating in tubes
Sensor OK. Tubes sensor tubes are not (see Section 11.15).
Stopped by Process vibrating
A034®  Meter Verification Failed  Test results were not Rerun the test. If the test fails again, see
Meter Verification Failed within acceptable limits. Section 10.3.4.
A035®  Meter Verification The test did not complete, If desired, read the abort code, see Section 10.3.4, and
Aborted possibly due to manual perform the appropriate action.
Meter Verification abort.
Aborted
A102 Drive Over-Range/ The drive power * Excessive drive gain. See Section 11.20.3.
Partially Full Tube (current/voltage) is at its * Check the sensor circuitry. See Section 11.21.
Drive Overrange/ maximum « If this is the only active alarm, it can be ignored. If
P t'e " f:) I?Tgﬁ desired, reconfigure the alarm severity to Ignore (see
artially Full fube Section 8.8).
A104 Calibration-In- Progress A calibration procedure is  * Allow the flowmeter to complete calibration.
Calibration in P in progress * For zero calibration procedures, you may abort the
alibration In Frogress calibration, set the zero time parameter to a lower
value, and restart the calibration.
A105 Slug Flow The density has exceeded e« See Section 11.14.
Siug FI the user-defined slug
ug Flow (density) limits
A107 Power Reset Occurred The transmitter has been *No action required.
Power Reset Occurred restarted * If desired, reconfigure the alarm severity to Ignore
u (see Section 8.8).
A116 API Temperature Process temperature is * Verify process.
Out-of-Limits outside API-defined * Verify API reference table and temperature
API: Temperature extrapolation limits configuration. See Section 8.14.
Outside Standard Range
A117 API Density Process density is outside ¢ Verify process.
Out-of-Limits API-defined extrapolation e Verify API reference table and density configuration.
API: Density Outside limits See Section 8.14.
Standard Range
A120 ED: Unable to fit curve Configured values for * Verify enhanced density configuration. See
data density curve do not meet Section 8.15.
ED: Unable to Fit Curve  2ocur@® requirements
Data
A121 ED: Extrapolation alarm  Enhanced density * Verify process temperature.
ED: Extrapolation Alarm calculations are outside * Verify process density.
- Extrapolatl the configured data range e« Verify enhanced density configuration.
¢ |f desired, reconfigure the alarm severity to Ignore
(see Section 8.8).
A131@  Meter Verification Info Meter verification in * Allow the procedure to complete.
Alarm progress, with outputs set e If desired, abort the procedure and restart with
Meter to last measured value outputs set to fault.
Verification/Outputs at
Last Value
A131®  Meter Verification in Meter verification in e Allow the procedure to complete.

Progress

Meter Verification in
Progress

progress, with outputs set
to continue reporting
process data.
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Troubleshooting

Status alarms and remedies continued

Alarm
code Message'" Cause Suggested remedy
A132 Simulation Mode Active  Simulation mode is ¢ Disable simulation mode. See Section 11.10.

Simulation Mode Active  S"201ed

A133 PIC Ul EEPROM Error EEPROM data onthe user ¢ Contact Micro Motion.
PIC Ul EEPROM Error interface module is corrupt

(1) Depending on the method you are using to view the alarm, different messages may be displayed. This table shows two possible
message versions. The ProLink II version is displayed in the second message of each pair.

(2) Applies only to systems with the original version of the meter verification application.

(3) Applies only to systems with Smart Meter Verification.

11.13 Checking process variables

Micro Motion suggests that you make a record of the process variables listed below, under normal
operating conditions. This will help you recognize when the process variables are unusually high or
low.

*  Flow rate

* Density

* Temperature

*  Tube frequency
*  Pickoff voltage
e Drive gain

For troubleshooting, check the process variables under both normal flow and tubes-full no-flow
conditions. Except for flow rate, you should see little or no change between flow and no-flow
conditions. If you see a significant difference, record the values and contact Micro Motion customer
service for assistance.

Unusual values for process variables may indicate a variety of different problems. Table 11-3 lists
several possible problems and suggested remedies.

Process variables problems and remedies

Symptom Cause Suggested remedy
Steady non-zero flow rate under Misaligned piping (especially in new * Correct the piping.
no-flow conditions installations)
Open or leaking valve * Check or correct the valve
mechanism.
Bad sensor zero * Rezero the flowmeter or restore the
factory zero or prior zero. See
Section 10.5.
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Process variables problems and remedies continued

Symptom

Cause

Suggested remedy

Erratic non-zero flow rate under
no-flow conditions

Leaking valve or seal

* Check pipeline.

Slug flow

e See Section 11.14.

Plugged flow tube

* Check drive gain and tube frequency.
Purge the flow tubes.

Incorrect sensor orientation

* Sensor orientation must be
appropriate to process fluid. See the
installation manual for your sensor.

Wiring problem

* Check the sensor circuitry. See
Section 11.21.

Vibration in pipeline at rate close to

sensor tube frequency

¢ Check environment and remove
source of vibration.

Damping value too low

* Check configuration. See Section 8.4.

Mounting stress on sensor

* Check sensor mounting. Ensure:
- Sensor is not being used to support
pipe.
- Sensor is not being used to correct
pipe misalignment.
- Sensor is not too heavy for pipe.

Sensor cross-talk

¢ Check environment for sensor with
similar (0.5 Hz) tube frequency.

Erratic non-zero flow rate when flow

is steady

Slug flow

¢ See Section 11.14.

Damping value too low

* Check configuration. See Section 8.4.

Plugged flow tube

* Check drive gain and tube frequency.
Purge the flow tubes.

Excessive or erratic drive gain

¢ See Section 11.20.3

Output wiring problem

* Verify wiring between transmitter and
receiving device. See the installation
manual for your transmitter.

Problem with receiving device

* Test with another receiving device.

Wiring problem

* Check the sensor circuitry. See
Section 11.21.

Inaccurate flow rate

Bad flow calibration factor

* Verify characterization. See
Section 6.2.

Inappropriate measurement unit

* Check configuration. See
Section 11.16.

Bad sensor zero

* Rezero the flowmeter or restore the
factory zero or prior zero. See
Section 10.5.

Bad density calibration factors

* Verify characterization. See
Section 6.2.

Bad flowmeter grounding

¢ See Section 11.7.3.

Slug flow

¢ See Section 11.14.

Wiring problem

* Check the sensor circuitry. See
Section 11.21.
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Troubleshooting

Process variables problems and remedies continued

Symptom

Cause

Suggested remedy

Inaccurate density reading

Problem with process fluid

* Use standard procedures to check
quality of process fluid.

Bad density calibration factors

* Verify characterization. See
Section 6.2.

Wiring problem

* Check the sensor circuitry. See
Section 11.21.

Bad flowmeter grounding

¢ See Section 11.7.3.

Slug flow

¢ See Section 11.14.

Sensor cross-talk

¢ Check environment for sensor with
similar (£0.5 Hz) tube frequency.

Plugged flow tube

* Check drive gain and tube frequency.
Purge the flow tubes.

Incorrect sensor orientation

* Sensor orientation must be
appropriate to process fluid. See the
installation manual for your sensor.

RTD failure

* Check for alarm conditions and follow
troubleshooting procedure for
indicated alarm.

Physical characteristics of sensor have
changed

* Check for corrosion, erosion, or tube
damage. See Section 11.15.

Temperature reading significantly
different from process temperature

RTD failure

* Check for alarm conditions and follow
troubleshooting procedure for
indicated alarm.

* Verify “Use external temperature”
configuration and disable if
appropriate. See Section 9.3.

Temperature reading slightly different
from process temperature

Sensor leaking heat

¢ Insulate the sensor.

Unusually high density reading

Plugged flow tube

* Check drive gain and tube frequency.
Purge the flow tubes.

Incorrect K2 value

* Verify characterization. See
Section 6.2.

Unusually low density reading

Slug flow

¢ See Section 11.14.

Incorrect K2 value

* Verify characterization. See
Section 6.2.

Unusually high tube frequency

Sensor erosion

¢ Contact Micro Motion.

Unusually low tube frequency

Plugged flow tube, corrosion, or erosion

* Purge the flow tubes.
¢ Perform meter verification. See
Section 11.15.

Unusually low pickoff voltages

Several possible causes

¢ See Section 11.20.4.

Unusually high drive gain

Several possible causes

* See Section 11.20.3.

11.14 Checking slug flow

A slug flow alarm is posted whenever the measured process density is outside the configured slug
flow limits (i.e., density is higher or lower than the configured normal range). Slug flow is typically
caused by gas in a liquid process or liquid in a gas process. See Section 8.7 for a discussion of slug

flow functionality.
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11.15

11.16

11.17

11.18

If slug flow occurs:
*  Check the process for cavitation, flashing, or leaks.
* Change the sensor orientation.
*  Monitor density.
e If desired, enter new slug flow limits (see Section 8.7).

- Raising the low slug flow limit or lowering the high slug flow limit will increase the
possibility of slug flow conditions.

- Lowering the low slug flow limit or raising the high slug flow limit will decrease the
possibility of slug flow conditions.

e If desired, increase slug duration (see Section 8.7).

Checking the sensor tubes

Corrosion, erosion, or damage to the sensor tubes can affect process measurement. To check for these
conditions, perform the meter verification procedure, if available. See Chapter 10. If the meter
verification procedure is not available, perform a visual inspection, or perform a density calibration
and check for a shift in the K1 and K2 values. Contact Micro Motion customer service.

Checking the flow measurement configuration

Using an incorrect flow measurement unit can cause the transmitter to produce unexpected output
levels, with unpredictable effects on the process. Make sure that the configured flow measurement
unit is correct. Check the abbreviations; for example, g/min represents grams per minute, not gallons
per minute. See Section 6.3.

Checking the characterization

A transmitter that is incorrectly characterized for its sensor might report inaccurate process variable
values. Both the K1 and Flow Cal (FCF) values must be appropriate for the sensor. If these values are
incorrect, the sensor may not drive correctly or may send inaccurate process data.

If you discover that any of the characterization data are wrong, perform a complete characterization.
See Section 6.2.

Checking the calibration

Improper calibration can cause the transmitter to report unexpected process variable values. If the
transmitter appears to be operating correctly but sends unexpected process variable values, an
improper calibration may be the cause.

Micro Motion calibrates every transmitter at the factory. Therefore, you should suspect improper
calibration only if the transmitter has been calibrated after it was shipped from the factory. Before
performing a calibration, consider meter validation or meter verification and select the appropriate
procedure (see Section 10.2). Contact Micro Motion customer service for assistance.
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Troubleshooting

11.19 Restoring a working configuration

At times it may be easier to start from a known working configuration than to troubleshoot the
existing configuration. To do this, you can:

* Restore a configuration file saved via ProLink II, if one is available. See Figure C-1.
* Restore the factory configuration. To do this:
- Using ProLink II, see Figure C-2. ProLink II v2.6 or higher is required.
- Using a PROFIBUS host and the EDD, see Figure C-10.
- Using PROFIBUS bus parameters, use the Diagnostic Block, Index 51 (see Table D-4).

Both of these actions will overwrite the existing configuration. Ensure that the existing configuration
is appropriately documented or saved.

11.20 Checking the test points

Some status alarms that indicate a sensor failure or overrange condition can be caused by problems
other than a failed sensor. You can diagnose sensor failure or overrange status alarms by checking the
flowmeter test points. The fest points include left and right pickoff voltages, drive gain, and tube
frequency. These values describe the current operation of the sensor.

11.20.1 Obtaining the test points
To obtain the test point values:
*  With the display, configure the required test points as display variables. See Section 8.9.3.
e  With ProLink II:
a. Click ProLink > Diagnostic Information.

b. Observe or record the values displayed for Tube Frequency, Left Pickoff, Right Pickoff,
and Drive Gain.

*  With a PROFIBUS host with the EDD, use the Meter Diagnostics window in the Device menu
(see Figure C-7).

*  With PROFIBUS bus parameters, read Indices 32, 33, 35, and 36 in the Diagnostic block (see
Table D-4).

11.20.2 Evaluating the test points
Use the following guidelines to evaluate the test points:
e If the drive gain is erratic, negative, or saturated, refer to Section 11.20.3.

» If the value for the left or right pickoff does not equal the appropriate value from Table 11-4,
based on the sensor flow tube frequency, refer to Section 11.20.4.

» If the values for the left and right pickoffs equal the appropriate values from Table 11-4, based
on the sensor flow tube frequency, record your troubleshooting data and contact the Micro
Motion customer service department.
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Sensor pickoff values

Sensor Pickoff value Qo
ELITE® CMF sensors 3.4 mV peak-to-peak per Hz based on sensor flow tube frequency -?n
F025, FO50, F100 sensors 3.4 mV peak-to-peak per Hz based on sensor flow tube frequency §
F200 sensors 2.0 mV peak-to-peak per Hz based on sensor flow tube frequency g’
H025, H050, H100 sensors 3.4 mV peak-to-peak per Hz based on sensor flow tube frequency
H200 sensors 2.0 mV peak-to-peak per Hz based on sensor flow tube frequency
R025, R050, or R100 sensors 3.4 mV peak-to-peak per Hz based on sensor flow tube frequency
R200 sensors 2.0 mV peak-to-peak per Hz based on sensor flow tube frequency
T-Series sensors 0.5 mV peak-to-peak per Hz based on sensor flow tube frequency
CMF400 |.S. sensors 2.7 mV peak-to-peak per Hz based on sensor flow tube frequency

(1) If your sensor is not listed, contact Micro Motion.

11.20.3 Drive gain problems
Problems with drive gain can appear in several different forms:
*  Saturated or excessive (near 100%) drive gain
* Erratic drive gain (e.g., rapid shifting from positive to negative)

* Negative drive gain

99UBWLIONA JUsWaINSea|

See Table 11-5 for a list of possible problems and remedies.

Drive gain problems, causes, and remedies

Cause Possible remedy

Excessive slug flow * See Section 11.14.
Cavitation or flashing e Increase inlet or back pressure at the sensor. -
* If a pump is located upstream from the sensor, increase the distance o
between the pump and sensor. s
o
Plugged flow tube * Purge the flow tubes. @
Mechanical binding of sensor tubes * Ensure sensor tubes are free to vibrate. Possible problems include: 8_
=
Q@

- Pipe stress. Check for pipe stress and eliminate if present.

- Lateral tube shift due to hammer effect. If this is a possibility,
contact Micro Motion.

- Warped tubes caused by overpressurization. If this is a possibility,
contact Micro Motion.

Incorrect sensor type configured * Verify sensor type configuration, then verify sensor characterization.
See Section 6.2.

Open drive or left pickoff sensor coil * Contact Micro Motion.

Drive board or module failure, cracked flow tube, e Contact Micro Motion.
or sensor imbalance

11.20.4 Low pickoff voltage

Low pickoff voltage can be caused by several problems. See Table 11-6.

&
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)
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Cause

Low pickoff voltage causes and remedies

Possible remedy

Slug flow * See Section 11.14.

No tube vibration in sensor * Check for plugging.

Moisture in the sensor electronics ¢ Eliminate the moisture in the sensor electronics.

Damaged sensor * Ensure sensor is free to vibrate (no mechanical binding).

Possible problems include:
- Pipe stress. Check for pipe stress and eliminate if
present.
- Lateral tube shift due to hammer effect. If this is a
possibility, contact Micro Motion.
- Warped tubes caused by overpressurization. If this is a
possibility, contact Micro Motion.
* Test sensor circuitry. See Section 11.21.
 Contact Micro Motion.

11.21
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Checking sensor circuitry

Problems with sensor circuitry can cause several alarms, including sensor failure and a variety of
out-of-range conditions. Testing involves:

* Inspecting the cable that connects the transmitter to the sensor
* Measuring the resistances of the sensor's pin pairs

* Ensuring that the circuits are not shorted to each other or to the sensor case

Note: To check the sensor circuitry, you must remove the transmitter from the sensor. Before
performing this test, ensure that all other applicable diagnostics have been performed. Diagnostic
capabilities of the Model 2400S transmitter have been greatly enhanced, and may provide more useful
information than these tests.

1. Follow appropriate procedures to ensure that the process of checking the sensor circuitry does
not interfere with existing measurement and control loops.

2. Power down the transmitter.
3. If the transmitter is in a hazardous environment, wait five minutes.
4. Check the sensor cable and sensor connection:

a. Referring to Figure B-1, loosen the four captive transmitter housing cover screws and
remove the transmitter housing cover.

b. Loosen the two captive user interface screws.
c. Gently lift the user interface module, disengaging it from the connector on the transmitter.
d. Referring to Figure B-2, disconnect the PROFIBUS cable and the power wires.

e. Two captive screws (2.5 mm hex head) hold the transmitter in the housing. Loosen the
screws and gently lift the transmitter away from the housing. Allow the transmitter to hang
temporarily.

f.  Ensure that the cable is fully plugged in and making a good connection. If it was not,
reseat the cable, reassemble the transmitter and sensor, and check operation.

g. If the problem is not resolved, unplug the cable from the feedthrough by removing the
snap clip (see Figure 11-1), then pulling the connector away from the feedthrough. Set the
transmitter aside.

h. Check the cable for any signs of damage. If the cable is damaged, contact Micro Motion.
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Figure 11-1 Accessing the feedthrough pins

Transmitter
(side view)

]
Sensor cable for

feedthrough connection

Feedthrough connector

Snap clip (assembled)

Pull tab to remove Feedthrough pins

5. Using a digital multimeter (DMM), check the sensor internal resistances for each flowmeter
circuit. Table 11-7 defines the flowmeter circuits and the resistance range for each. Refer to
Figure 11-2 to identify the feedthrough pins. For each circuit, place the DMM leads on the pin
pairs and record the values.

Note: In order to access all feedthrough pins, you may need to remove the clamp and rotate the
transmitter to a different position.
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In this test:
*  There should be no open circuits, i.e., no infinite resistance readings.

e Nominal resistance values vary 40% per 100 °C. However, confirming an open or shorted
circuit is more important than any slight deviation from the resistance values shown here.

e The LPO and RPO circuit readings should be the same or very close (= 10%).
* The readings across pin pairs should be steady.

* Actual resistance values depend on the sensor model and date of manufacture. Contact
Micro Motion for more detailed data.

If a problem appears, or if any resistance is out of range, contact Micro Motion.
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Nominal resistance ranges for flowmeter circuits

Circuit Pin pairs Nominal resistance range‘"
Drive Drive + and — 8-1500 Q

Left pickoff Left pickoff + and — 16—1000 Q

Right pickoff Right pickoff + and — 16—1000 ©

Flow tube temperature sensor RTD + and RTD — 100 Q at0°C + 0.38675 Q/ °C
LLC/RTD

* T-Series sensors RTD — and composite RTD 300 Q at0°C + 1.16025 O/ °C
* CMF400 |.S. sensors RTD — and fixed resistor 39.7-42.2 Q

* F300 sensors RTD - and fixed resistor 44.3-46.4 Q

* H300 sensors
* FO25A, FO50A, F100A sensors
* CMFS sensors

¢ All other sensors RTD —and LLC 0

(1) Actual resistance values depend on the sensor model and date of manufacture. Contact Micro Motion for more detailed data.

Feedthrough pins

Drive — Drive +

LLC / Composite RTD /
Fixed resistor"

RTD +

Left pickoff — Right pickoff +

Left pickoff + Right pickoff —

(1) Functions as fixed resistor for the following sensors: F300, H300, FO25A, FO50A, F100A, CMF400 LS., CMFS. Functions
as composite RTD for T-Series sensors. For all other sensors, functions as lead length compensator (LLC).
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6. Using the DMM, check each pin as follows:

a. Check between the pin and the sensor case.

b. Check between the pin and other pins as described below:
e Drive + against all other pins except Drive —
* Drive — against all other pins except Drive +
* Left pickoff + against all other pins except Left pickoff —
*  Left pickoff — against all other pins except Left pickoff +
* Right pickoff + against all other pins except Right pickoff —
* Right pickoff — against all other pins except Right pickoff +
* RTD + against all other pins except RTD — and LLC/RTD
* RTD - against all other pins except RTD + and LLC/RTD
e LLC/RTD against all other pins except RTD + and RTD —

With the DMM set to its highest range, there should be infinite resistance on each lead. If there
is any resistance at all, there is a short to case or a short between pins. See Table 11-8 for
possible causes and solutions. If the problem is not resolved, contact Micro Motion.

Sensor and cable short to case causes and remedies

Cause Possible remedy

Moisture inside the transmitter housing * Make sure that the transmitter housing is dry and no corrosion is
present.

Liquid or moisture inside the sensor case * Contact Micro Motion.

Internally shorted feedthrough (sealed passage ¢ Contact Micro Motion.
for wiring from sensor to transmitter)

To return to normal operation:

1. Follow appropriate procedures to ensure that reconnecting the transmitter does not interfere
with existing measurement and control loops.

2. Reach inside the transmitter housing and install the transmitter’s sensor connection onto the
feedthrough:

a. Rotate the connector until it engages the pins.
b. Push down until the connector shoulder is flush with the feedthrough notch.

c. Replace the snap clip by sliding the clip tab over the connector shoulder (see the
instruction label on the component).

. Replace the transmitter in the transmitter housing, and tighten the screws.
. Reconnect the power wires, lower the Warning flap, and tighten the Warning flap screw.
. Reconnect the PROFIBUS cable to the PROFIBUS terminals on the transmitter.

. Plug the user interface module onto the transmitter. There are four possible positions; select
the position that is most convenient.

AN L A W

~J

. Tighten the user interface screws.
8. Replace the transmitter housing cover on the user interface module, and tighten the screws.

9. Power up the transmitter.

Configuration and Use Manual 141

uonesuadwo)

99UBWLIONA JUBWaINSEa|

=
o
c
=X
o
o
>
o
o
=3
5
Q

s}inejaqg



142 Micro Motion® Model 2400S Transmitters for PROFIBUS-DP



Default Values and Ranges
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A.1 Overview

This appendix provides information on the default values for most transmitter parameters. Where
appropriate, valid ranges are also defined.

These default values represent the transmitter configuration after a master reset. Depending on how
the transmitter was ordered, certain values may have been configured at the factory.

A.2 Most frequently used defaults and ranges

The table below contains the default values and ranges for the most frequently used transmitter
settings.

Transmitter default values and ranges

99UBWLIONA JUBWaINSEa|

Type Setting Default Range Comments
Flow Flow direction Forward
Flow damping 0.64 sec 0.0-40.96 sec User-entered value is

corrected to nearest lower
value in list of preset values.
For gas applications, Micro
Motion recommends a

minimum value of 2.56. g'
Flow calibration factor 1.00005.13 For T-Series sensors, this &
value represents the FCF and o
FT factors concatenated. See =
Section 6.2.2. <]
Mass flow units a/s a
Mass flow cutoff 0.0g/s Recommended setting:
¢ Standard use — 0.2% of the
sensor’s rated maximum
flowrate
* Empty-full-empty batching —
2.5% of the sensor’s
maximum flowrate
Volume flow type Liquid volume
Volume flow units L/s
Volume flow cutoff 0/0 L/s 0.0—xL/s X is obtained by multiplying
the flow calibration factor by
0.2, using units of L/s.
Meter factors Mass factor 1.00000
Density factor 1.00000
Volume factor 1.00000
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Transmitter default values and ranges continued

Type Setting Default Range Comments
Density Density damping 1.28 sec 0.0-40.96 sec User-entered value is
corrected to nearest value in
list of preset values.
Density units g/cm?®
Density cutoff 0.2 g/cm?® 0.0-0.5 g/cm?®
D1 0.00000
D2 1.00000
K1 1000.00
K2 50,000.00
FD 0.00000
Temp Coefficient 4.44
Slug flow Slug flow low limit 0.0 g/cm?® 0.0-10.0 g/cm®
Slug flow high limit 5.0 g/cm?® 0.0-10.0 g/cm®
Slug duration 0.0 sec 0.0-60.0 sec
Temperature Temperature damping 4.8 sec 0.0-38.4 sec User-entered value is
corrected to nearest lower
value in list of preset values.
Temperature units Deg C
Temperature calibration factor 1.00000T0.0000
Pressure Pressure units PSI
Flow factor 0.00000
Density factor 0.00000
Cal pressure 0.00000
T-Series sensor D3 0.00000
D4 0.00000
K3 0.00000
K4 0.00000
FTG 0.00000
FFQ 0.00000
DTG 0.00000
DFQ1 0.00000
DFQ2 0.00000
Events 1-5 Type Low
Variable Density
Setpoint 0.0
Setpoint units g/cm?®
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Transmitter default values and ranges continued

Type Setting Default Range Comments 9

Display Backlight on/off On %
Backlight intensity 63 0-63 %
Update period 200 milliseconds 100-10,000 %','

milliseconds =)

Variable 1 Mass flow rate
Variable 2 Mass total
Variable 3 Volume flow rate
Variable 4 Volume total
Variable 5 Density
Variable 6 Temperature =
Variable 7 Drive gain 4
Variable 8-15 None %
Display totalizer start/stop Disabled ,3,
Display totalizer reset Disabled %
Display auto scroll Disabled %
Display offline menu Enabled 3
Display offline password Disabled %
Display alarm menu Enabled °
Display acknowledge all Enabled
alarms
Offline password 1234
Auto scroll rate 10 sec

Digital PROFIBUS-DP node address 126

gg{m‘;”' IrDA port enabled/disabled  Disabled 5
IrDA port write-protect Read-only =
Modbus address 1 o
Modbus ASCII support Enabled §
Floating-point byte order 3412 §
Fault action None
Fault timeout 0 seconds 0.0-60.0 sec
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Appendix B
Transmitter Components

B.1

B.2

Overview

This appendix provides illustrations of transmitter components and wiring, for use in troubleshooting.
For detailed information on installation and wiring procedures, see the transmitter installation manual.

Transmitter components

The Model 2400S DP transmitter is mounted on a sensor. Figure B-1 provides an exploded view of
the Model 2400S DP transmitter and its components.

Figure B-1 Model 24008 DP transmitter — Exploded view

User interface module

) Transmitter housing cover
Sensor connection

Transmitter housing cover screws

Snap clip (x4)

Transmitter housing

Transmitter

Feedthrough

Transmitter rotation slots
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Transmitter Components

B.3 Terminals and connectors

Figure B-2 shows the terminals and connectors that are beneath the user interface module:

* To access the PROFIBUS connector, you must remove the transmitter housing cover and the

user interface module.

* To access the power supply terminals or the grounding screw, you must remove the transmitter
housing cover and the user interface module, loosen the Warning flap screw, and open the

Warning flap.

For detailed instructions, see the manual entitled Micro Motion Model 2400S Transmitters:

Installation Manual.

Terminals

Warning flap closed

User interface module

connector
- N
7
s,
K 7 Micro Motion™
Mode! 2400S PROF 1BUS-DP
M| vure e
112 109
O ®
@0@ &WARNlNG
ELECTRIC
SHOCK
HAZARD,
ower off
before
Liftin
cover
Tighten
@ screw
ft
O O) ir?;g O
A\ Y J

J u< Warning flap

PROFIBUS terminals Warning flap screw

Warning flap open

+(L)

o o C o) M

Miero Motion

AWB L’“’C"%/*

12 1o|9
® ©

G

=)
)

O e © o
AN u - u J

Transmitter internal
grounding screw
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sweJbeiq

C.1 Overview
This appendix provides the following menu flowcharts for the Model 2400S DP transmitter:

*  ProLink II menus
- Main menu - see Figure C-1
- Configuration menu — see Figures C-2 and C-3

* EDD menus
- Main menu — see Figure C-4
- View menu — see Figure C-5
- Device menu — see Figures C-6 and C-7
- Configuration menu — see Figures C-8 through C-11

- Specialist menu — see Figure C-12

* Display menus
- Off-line menu: Top level — see Figure C-13
- Off-line maintenance: Version information — see Figure C-14

- Off-line maintenance: Configuration — see Figure C-15

- Off-line maintenance: Zero — see Figure C-16 ©
c
- Off-line maintenance: Meter verification — see Figure C-17 %
For information on the codes and abbreviations used on the display, see Appendix E. §
For meter verification and calibration procedures, see Chapter 10. %
@
C.2  Version information
These menu flowcharts are based on:
* Transmitter software v1.10
e ProLink IT v2.5
e EDDrevl
Menus may vary slightly for different versions of these components.
=)
(7]}
=
<2
(%)
o
<3
(1]
(7}
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C.3 ProLink Il menu flowcharts

ProLink Il main menu

‘ File ‘ ‘ View ‘ ‘ Connection ‘ ‘ ProLink ‘ ‘ Tools ‘ ‘ Plug-ins ‘
| | |
Load from Xmitr to File Connect to Device Meter Verification Data Logging"
Save to Xmtr from File Disconnect
Options
License - ProLink Il Language
- Error Log On

Preferences

- Use External Temperature

- Enable Inventory Totals Reset

- Enable External Pressure Compensation
- Copper RTD

Installed options

(1) For information about using the data logging
function, see the ProLink Il manual.

(2) Available only if the enhanced density application
is installed.

(3) Available only if the petroleum measurement
application is installed.

150

Configuration

Process Variables
Status

Alarm Log

Diagnostic Information
Calibration

Test

ED Totalizer Control®
Totalizer Control

Core Processor Diagnostics
API Process Variables®
ED Process Variables®
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Figure C-2  ProLink Il configuration menu

ProLink >

Configuration

Flow

- Flow direction

- Flow damp

- Flow cal

- Mass flow cutoff
- Mass flow units
- Vol flow cutofft"
- Vol flow units"

Density

- Density units

- Density damping

- Slug high limit

- Slug low limit

- Slug duration

- Low density cutoff

Temperature

- Temp units

- Temp cal factor

- Temp damping

- External temperature

Pressure

- Flow factor

- Dens factor

- Cal pressure

- Pressure units

- External pressure

Density

- Lower sensor limit
- Upper sensor limit
- Min span

Temperature

- Lower sensor limit
- Upper sensor limit
- Min span

(1) Displayed only if Vol Flow Type is set to Liquid Volume.

port

Tag

- Vol flow type o - K2
- Std gas vol flow cutoff - FD .
- Std gas vol flow units® o L continued === —-==-=-- >
- Std gas density® - D2
- Temp coeff (DT)
Gas wizard®
- Mass factor
- Dens factor
- Vol factor
Sensor Sensor Limits® T Series Device
- Sensor s/n Mass flow -FTG - Tag
- Sensor model num - Lower sensor limit - FFQ - Date
- Sensor matl - Upper sensor limit DTG - Descriptor
- Liner matl - Min span DFQ1 - Message
- Flange - DFQ2 - Floating pt ordering
Volume flow - K3 - Add comm resp delay
- Lower sensor limit - D3 - Transmitter serial #
- Upper sensor limit - D4
- Min span - K4 Digital comm settings

Fault setting

Modbus address

Disable Modbus ASCII
Enable IrDA comm
Enable write protect IrDA

I&M functions®

Tag location

Last measured value timeout

Restore factory configuration®

(2) Displayed only if Vol Flow Type is set to Standard Gas Volume.

(3) All values on this panel are read-only, and are displayed only for informational purposes.

(4) Requires ProLink Il v2.6 or later.
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ProLink Il configuration menu continued

ProLink >
Configuration

Display Discrete events Alarm Sensor simulation

- Var1 - Event name - Alarm Enable simulation mode

- Var2 - Event type - Severity

C - Process variable Mass flow

- Var 15 - Low setpoint - Wave form
- High setpoint - Fixed value

Display precision - Period

- Var - Minimum

- Number of decimals - Maximum

Discrete input"

Display options Density

- Display start/stop totalizers - Start sensor zero - Wave form

- Display totalizer reset - Reset mass total - Fixed value

- Display auto scroll - Reset volume total - Period

- Display offline menu - Reset all totals - Minimum

- Display offline password - Start/stop all totalization - Maximum

- Display alarm menu - Reset gas standard volume total

- Display ack all alarms - Reset API reference volume total Temperature

- Display back light on/off - Reset ED reference volume total - Fixed value

- Reset ED net mass total - Period

- Offline password - Reset ED net volume total - Minimum

- Auto scroll rate - Increment current ED curve - Maximum

- Update period

- Backlight intensity

- Display language

API setup® ED setup® ED curve®
- Table type Global config Process fluid density at specified temperature
- Units - Active curve and concentration
- Derived variable - Curve being configured
- Lock/unlock ED curves - Curve fit max order
- Temperature isotherms
Curve specific config - Concentration
- Curve configured
- Curve name Curve fit results
- Reference temperature - Accuracy
- Water reference temperature
- Water reference density Process fluid density at reference temperature
- Trim slope and specified concentration
- Trim offset - Reference temperature
- Concentration
Extrapolation

- Alarm limit

- Enable density low

- Enable density high

- Enable temperature low
- Enable temperature high

Concentration
- Units
- Special unit string

(1) Used to assign events to actions, even though the Model 2400S DP transmitter does not provide a discrete input.
(2) Available only if the petroleum measurement application is installed.
(3) Available only if the enhanced density application is installed.
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C.4 EDD menu flowcharts

If you connect as a Maintenance user, the I&M functions menu (see Figure C-12) is not available. All
other EDD menus are available.

If you connect as a Specialist user, all EDD menus are available.

sweJbeiq

EDD - Main menu

Main Menu >
Maintenance

Device ‘ ‘ Device > Device View > Display ‘ ‘ MMI Coriolis Flow
‘ - Set address - Process variables - Process Variables - Configuration Parameters
- Totalizers - Totals - Offline Diagnostic Info
- Alarm status - Alarm Status - API setup parameters
- Meter diagnostics - ED Setup Data
- Zero Cal
- Density Cal
- Discrete Events . ) (1) Available only if gas standard volume measurement is
- GSV Process Variables
) . enabled.

- Core Processor Diagnostics . .
. API Process Variables® (2) Available only if the petroleum measurement
. ED Process Variables® application is installed.
- ED Totals® (3) Available only if the enhanced density application is
- Meter Verification installed.

EDD - View menu

Main Menu > o
Maintenance > ﬁ
View > Display 3
| o
3
| | | 8
@
Process Variables Totals Alarm Status ")
| | |
- Mass flow - Mass total - Alarm one status, bits 1-8
- Mass flow units - Mass inventory - Alarm two status, bits 1-8
- Volume flow" - Mass total and mass inventory unit | |- Alarm three status, bits 1-8
- Volume flow units - Volume total® - Alarm four status, bits 1-8
- Density - Volume inventory - Alarm five status, bits 1-8
- Density units - Volume total and inventory unit” - Alarm six status, bits 1-8
- Temperature - Alarm seven status, bits 1-8
- Temp units - Alarm eight status, bits 1-8
- External pressure input
- Pressure unit - Acknowledge all alarms
- Acknowledge alarm 1=
- Reset alarm history -g
(1) Liquid volume only. 2
(@)
o
<3
3
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EDD - Device menu

Device >
Device

T_ ——continued——--»

Process Variables

- Mass flow

- Mass flow units

- Volume flow "

- Volume flow units'"

- Density

- Density units

- Temperature

- Temperature units

- External pressure input
- Pressure units

Totalizers

- Start/stop all totals

- Reset all totals

- Reset all inventories

- Mass total

- Mass inventory

- Mass total and mass inventory unit
- Reset mass total

- Reset mass inventory

- Volume total

- Volume inventory

- Volume total and volume inventory unit
- Reset volume total

- Reset volume inventory

GSV Process Variables®

- Gas Std volume flow rate

- Gas Std volume flow total

- Gas Std volume flow inventory

- Gas Std volume flow unit

- Gas Std volume total and inventory units
- Reset gas std volume total

- Reset gas std volume inventory

API Process Variables®

API volume at reference temperature
- Reference temperature

- Vol flow at ref temp

- Vol total at ref temp

- Vol inventory at ref temp

API batch weighted average
- Average observed density
- Average observed temperature

API other

- Reference temperature
- API CTL

- Density at ref temp

Reset API volume total
Reset API volume inventory

ED Process Variables”

Volume at reference temp
- Volume flow rate at ref temp
- Volume total at ref temp

Net mass

- Net mass flow rate
- Net mass total

- Net mass inventory

Net volume

- Net volume flow rate
- Net volume total

- Net volume inventory

Other
- Density at ref temp
- Density in fixed SG units

Concentration

ED Totals®

Volume at reference temp

- Volume flow rate at ref temp

- Volume total at ref temp

- Volume inventory at ref temp

- Reset volume total at ref temp

- Reset volume inventory at ref temp

Net mass

- Net mass flow rate

- Net mass total

- Net mass inventory

- Reset net mass total

- Reset net mass inventory

Net volume

- Net volume flow rate
- Net volume total

- Net volume inventory

- Density in fixed Baume units

- Reset net volume total
- Reset net volume inventory

|

Discrete Events

- Discrete event status

Alarm Status

- Alarm one, bits 1-8

- Alarm two, bits 1-8

- Alarm three, bits 1-8
- Alarm four, bits 1-8

- Alarm five, bits 1-8

- Alarm six, bits 1-8

- Alarm seven, bits 1-8
- Alarm eight, bits 1-8

- Acknowledge all alarms
- Acknowledge alarm
- Reset alarm history

- Col
- Cu

Concentration

ncentration
rve n concentration units

(1) Liquid volume only.

(2) Available only if gas standard volume is enabled.
(3) Available only if the petroleum measurement application is installed.
(4) Available only if the enhanced density application is installed.
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Figure C-7  EDD - Device menu continued

Device >
Device

Meter Diagnostics

- Drive gain

- Tube frequency

- Live zero

- Left pickoff voltage

- Right pickoff voltage

Core Processor Diagnostics

- Temperature unit

- Board temperature

- Maximum electronics temperature
- Minimum electronics temperature
- Average electronics temperature
- Maximum sensor temperature

- Minimum sensor temperature

- Average sensor temperature

- Drive current

- RTD cable resistance

- Line RTD resistance

- Case RTD resistance

- Power cycles

- Power on time

- Input voltage

- Actual target amplitude

Zero Calibration

- Mass flow

- Mass flow unit

- Perform auto zero

- Restore factory zero
- Zero time

- Standard deviation
- Manual zero
- Zero failed value

- Flow signal offset at zero flow

- Alarm one status, bits 1-8

- Alarm two status, bits 1-8

- Alarm three status, bits 1-8
- Alarm four status, bits 1-8

- Alarm five status, bits 1-8

- Alarm six status, bits 1-8

- Alarm seven status, bits 1-8
- Alarm eight status, bits 1-8

Density Calibration

- Mass flow
- Mass flow unit

- D1
- Do density cal-Point 1

-D2
- Do density cal-Point 2

- FD value
- Do density cal-Flowing
density

- D3 (T-Series only)
- Do density cal-Point 3

- D4 (T-Series only)
- Do density cal-Point 4

Configuration and Use Manual

- Alarm one status, bits 1-8

- Alarm two status, bits 1-8

- Alarm three status, bits 1-8
- Alarm four status, bits 1-8

- Alarm five status, bits 1-8

- Alarm six status, bits 1-8

- Alarm seven status, bits 1-8
- Alarm eight status, bits 1-8

Meter Verification

Meter verification setup
- Enable meter verification
- Output state
- Stiffness limit set point

Meter verification parameters
- Algorithm state
- Abort code
- State at abort
- LPO stiffness out of limits
- RPO stiffness out of limits
- Progress (% complete)

Meter verification data set selection
- Current data means >
- Stiffness LPO
- Stiffness RPO
- Damping
- Mass LPO
- Mass RPO
- Current data standard deviation >
- Stiffness LPO
- Stiffness RPO
- Damping
- Mass LPO
- Mass RPO
- Factory cal air means >
- Stiffness LPO
- Stiffness RPO
- Damping
- Mass LPO
- Mass RPO
- Factory cal water means >
- Stiffness LPO
- Stiffness RPO
- Damping
- Mass LPO
- Mass RPO
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EDD - Configuration menu

MMI Coriolis Flow DP >
MMI Coriolis Flow >
Configuration Parameters

v

A4

Flow
-GSV

Temperature
- External temperatuare

Density
- T-Series

Pressure
- Pressure configuration values
- Pressure compensation values

Discrete event parameters

Discrete event action code and
assignment

Alarm
- Alarm status parameters
- Alarm history parameters

Device
- Transmitter options
- Digital comm settings

Sensor

Sensor limits

- Mass flow

- Volume flow
- Density

- Temperature

Display

- Display options

- Display parameters
- Display precision
- Display language

Offline diagnostic info

(1) Liquid volume only.
(2) Available only if gas standard volume is
enabled.

> Configuration Parameters

>> Flow

Flow direction

Flow damping

Flow calibration factor
Mass flow units

Mass flow cutoff
Volume flow units'”
Volume flow cutofft"
Mass factor

Density factor
Volume factor

Flow temperature coefficient

>>> GSV parameters
Enable gas std volume flow and total

>>>> GSV process variables®

Gas std density

Gas std volume flow units

Gas std volume total and inventory units
Gas std volume flow cutoff

>> Temperature

Temperature units
Temperature damping
Temperature calibration offset
Temperature calibration slope

>>> External temperature
External temperature input
Enable external temp for API or ED

>> Density
Density units
Density damping
Slug low limit
Slug high limit
Slug duration

Low density cutoff

DTC
FD value

>> T-Series
FTG

FFQ

DTG

DFQ1
DFQ2

K3

D3

K4

D4
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Figure C-9  EDD - Configuration menu continued

MMI Coriolis Flow DP >
MMI Coriolis Flow >
Configuration Parameters

v

Flow
-GSV

Temperature
- External temperatuare

Density
- T-Series

Pressure
- Pressure configuration values
- Pressure compensation values

Discrete event parameters

Discrete event action code and
assignment

Alarm
- Alarm status parameters
- Alarm history parameters

Device
- Transmitter options
- Digital comm settings

Sensor

Sensor limits

- Mass flow

- Volume flow
- Density

- Temperature

Display

- Display options

- Display parameters
- Display precision
- Display language

Offline diagnostic info

Configuration and Use Manual

A 4

> Configuration Parameters

>> Pressure

>>> Pressure configuration values
Enable pressure compensation
Pressure unit

External pressure input

>>> Pressure compensation values
Flow factor

Density factor

Calibration pressure

>> Discrete event parameters
Discrete event index

Discrete event type

Low setpoint (A)

High setpoint (B)

Discrete event process variable code

>> Discrete event action code and assignment
Discrete event action code
Discrete event assignment

>> Alarm
Fault action
Last measured value fault timeout

>>> Alarm status parameters
Alarm n index

Alarm n severity

Alarm n status

Alarm n count

Alarm n last posted

Alarm n last cleared

>>> Alarm history parameters

Alarm log history index

Alarm n number

Alarm n status change

Alarm n time stamp of status change
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EDD - Configuration menu continued

MMI Coriolis Flow DP >
MMI Coriolis Flow >
Configuration Parameters

v

Flow
-GSV

Temperature
- External temperatuare

Density
- T-Series

Pressure
- Pressure configuration values
- Pressure compensation values

Discrete event parameters

Discrete event action code and
assignment

Alarm
- Alarm status parameters
- Alarm history parameters

Device
- Transmitter options
- Digital comm settings

Sensor

Sensor limits

- Mass flow

- Volume flow
- Density

- Temperature

Display

- Display options

- Display parameters
- Display precision
- Display language

Offline diagnostic info

> Configuration Parameters

>> Device

ETO

Transmitter serial #
Software rev

Board rev

>>> Transmitter options
Enabled features

>>> Digital comm settings
Enable IrDA communication
Enable write protect IrDA port

>> Sensor

Sensor serial number
Sensor model
Sensor type code
Sensor material
Sensor liner

Flange type

>> Sensor limits
>>> Mass flow
Lower sensor limit

> Upper sensor limit

Minimum span

>>> Volume flow
Lower sensor limit
Upper sensor limit
Minimum span

>>> Density
Lower sensor limit
Upper sensor limit
Minimum span

>>> Temperature
Lower sensor limit
Upper sensor limit
Minimum span

>> Display

>>> Display options
Display totalizer reset
Display start/stop totalizers
Display auto scroll

Display offline menu
Display offline password
Display backlight on/off
Display alarm menu
Display ack all alarms

>>> Display parameters
Display offline password
Display auto scroll rate
Display update period
Display backlight intensity
Display variable 1-15

>>>> Display precision
LDO process variable
Number of decimals

>>>> Display language
Display language selection

>> Offline diagnostic info
Restore factory configuration
Reset power on time
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Figure C-11 EDD - Configuration menu: API setup and ED setup

MMI Coriolis Flow DP >
MMI Coriolis Flow >
Configuration Parameters

v

Flow

Temperature

Density

Pressure

Discrete event parameters

Discrete event action code and
assignment

Alarm

Device

Sensor

Sensor limits

Display

Offline diagnostic info

AP setup parameters("

ED setup data®
- ED global configuration
- ED curve specific configuration
- Extrapolation
- Concentration
- ED curve data
- Curve fit results
- Maximum curve fit order

(1) Available only if the petroleum
measurement application is installed.

(2) Available only if the enhanced density

application is installed.

Configuration and Use Manual

> Configuration

>> API setup parameters'"

API reference temperature

API thermal expansion coefficient
API2540 CTL table type

>> ED setup data®

>>> ED global configuration
Active calculation curve
Derived variable
Lock/unlock ED curves
Reset all curve information

>>> ED curve specific config

Curve configured

Curve n name

Curve n long name

Curve n reference temperature
Curve n water reference temperature
Curve n water reference density
Curve n trim slope

Curve n trim offset

>>>> ED extrapolation
Curve n alarm limit
Enable density low
Enable density high
Enable temperature low
Enable temperature high

>>>> ED concentration
Curve n concentration units

>>> ED curve data

Curve temperature isotherm index (X-axis)

Curve concentration index (Y-axis)

Curve n (6*5) temp isotherm X Value (X-axis)

Curve n (6*5) density @ temp isotherm X, concentration Y
Curve n (6*5) coeff @ temp isotherm X, concentration Y
Curve n (6*5) concentration Y value (label for Y-axis)
Curve n (5*1) density @ concentration Y (at ref. temp.)
Curve n (5*1) coeff @ concentration Y (at ref. temp.)
Curve n (5*1) concentration Y value (Y-axis)

>>>> Curve fit results
Curve n fit results
Curve n curve fit expected accuracy

>>>> Maximum curve fit order
Maximum fit order for 5*5 curve
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C.5

EDD Specialist menu - Identification

Display menu flowcharts

Main Menu >
Specialist >
Identification

|

|

Operation Unit Device
- Tag - Profile ID
- Tag location - Manufacturer

- Available 1&M records

- Order number

- Serial number

- Hardware revision
- Software revision
- 1&M version

- Revision counter

Display menu - Off-line menu, top level

Scroll and Select simultaneously
for 4 seconds

v

‘ SEE ALARM

OFF-LINE MAINT EXIT ‘

CONFG - zERO | SENSOR VERFY" EXIT

(1) This option is displayed only if the meter verification software is installed on the transmitter.
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Figure C-14 Display menu - Off-line maintenance - Version information

Scroll and Select simultaneously
for 4 seconds

Scroll

‘ OFF-LINE MAINT ‘

*

Select

Scroll

‘ VER ‘

Select

LS

‘ Version info ‘

Scroll

(1) The option is displayed only if the corresponding
Engineering To Order (ETO) or application is
installed on the transmitter.

Scroll

y

‘ API? ENHANCED DENS" ‘

Scroll

L

‘ SENSOR VERFY'" ‘

Scroll

L

EXIT

;
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Display menu - Off-line maintenance — Configuration

Scroll and Select
simultaneously
for 4 seconds

OFF-LINE MAINT

Scroll Scroll

Scroll

Select

TOTALS RESET

Scroll

TOTALS STOP

Scroll

DISPLAY OFFLN

Scroll

DISPLAY ALARM

START ZERO

Scroll

RESET MASS

Scroll

RESET voL"

Scroll

RESET TCORR®

Scroll Scroll Scroll

Scroll Scroll Scroll

ASCIl MBUS

Scroll

ADDR MBUS

Scroll

Scroll Scroll

Scroll

Scroll

RESET STD V¢

Scroll

RESET NET M®

DISPLAY ACK

Scroll

AUTO SCRLL

RESET NET V©

Scroll

RESET ALL

SCROLL RATE®

Scroll

OFF-LINE PASSW

Scroll

INCR CURVE®

Scroll

CHNG PASSW®

Scroll

DISPLAY RATE

Scroll

DISPLAY BKLT

Scroll

DISPLAY LANG

Scroll

(1) Either Vol or GSV is displayed.

(2) Displayed only if the petroleum measurement application is installed.
(3) Displayed only if the enhanced density application is installed.

(4) Displayed only if Auto Scroll is enabled.

(5) Displayed only Off-Line Password is enabled.
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Figure C-16 Display menu - Off-line maintenance - Zero

Scroll and Select simultaneously
for 4 seconds

OFF-LINE MAINT

‘ ZERO
- :} CAL ZERO Scroll - :} RESTORE ZERO EXIT
‘ ZEROIYES? ‘
4% Current zero display ‘
No—I—Yes
‘ ...................... ‘ ‘ Factory zero display ‘
[ l
‘ CAL FAIL ‘ ‘ CAL PASS ‘
i RESTORE ZERO
‘ Troubleshoot ‘
RESTORE EXIT ‘ RESTORE ZEROIYES"

l—YesJ—N 0
l Scroll ] [ Select ] [ Select ]
| |
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Display menu - Off-line maintenance — Meter verification

Scroll and Select simultaneously
for 4 seconds

OFF-LINE MAINT

SENSOR VERFY OFF-LINE EXIT

OUTPUTS

E}@ (1) Either Unstable Flow or Unstable Drive Gain may be

displayed, indicating that the standard deviation of the
flow or drive gain is outside limits. Check the process
and retry the procedure.

(2) Represents the percentage completion of the

A4

SENSOR EXIT

A 4

‘ FAULT procedure.
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Appendix D
PROFIBUS Bus Parameters

D.1 Overview

This appendix documents the bus parameters that are included in the PROFIBUS blocks. The
following blocks are documented:

e Measurement block (Slot 1) — see Table D-2

e Calibration block (Slot 2) — see Table D-3

* Diagnostic block (Slot 3) — see Table D-4

¢ Device information block (Slot 4) — see Table D-5

* Local display block (Slot 5) — see Table D-6

e API block (Slot 6) — see Table D-7

* Enhanced density block (Slot 7) — see Table D-8

¢ I&M functions block (Slot 0) — see Table D-9
The following codes are documented:

* Totalizer and inventory measurement unit codes — see Tables D-10 through D-12

*  Process variable codes — see Table D-13

* Alarm index codes — see Table D-14
Note: For measurement unit codes used for process variables, see Section 6.3.

For each block, all parameters contained in the block are listed. For each parameter, the following are
documented:

* Index — the index of the parameter within the block

oY)
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e Name — the name used for this parameter in the code
* Data type — the data type of the parameter (see Section D.2)

*  Memory class — the class of memory required by the parameter, and the update rate (in Hz) if
applicable:

- D = dynamic store (cyclic data — parameter updated periodically)
- S = static store (acyclic data — parameter changed on a deliberate write)
- N =nonvolatile parameter (retained across power cycles)
e Access
- R =Read-only
- R/W = Read/write
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PROFIBUS Bus Parameters

D.2 PROFIBUS-DP data types and data type codes
Table D-1 documents the data types and data type codes used with the PROFIBUS bus parameters.

PROFIBUS-DP data types

Data type Size (bytes) Description Range Code
Boolean 1 True/false *0 = False BOOL
1 =True
Integer8 1 8-bit signed integer value -128 to +127 INT8
Unsigned8 1 8-bit unsigned integer value 0 to 255 USINT8
Integer16 2 16-bit signed integer value -32768 to +32767 INT16
Unsigned16 2 16-bit unsigned integer value 0 to 65535 USINT16
Integer32 4 32-bit signed integer value —2147483648 to +2147483647 INT32
Unsigned32 4 32-bit unsigned integer 0 to 4294967296 USINT32
FLOAT 4 An IEEE single precision —3.8E38 to +3.8E38 FLOAT
floating point number
OCTET STRING Upto 128 bytes A character array of ASCII N/A STRING
characters
BIT_ENUMERATED Upto 128 bytes An enumerated value where = N/A B_ENUM

each bit represents a different
enumeration

D.3 Measurement block (Slot 1)

Measurement block (Slot 1)

Data Memory
Index Name type class Access Comments
4 SNS_MassFlow FLOAT D(20Hz) R Current value of mass flow process variable
5 SNS_MassFlowUnits USINT16 S R/W Mass flow measurement unit
See Table 6-2 for codes
SNS_Temperature FLOAT D(20Hz) R Current value of temperature process variable
SNS_TemperatureUnits USINT16 S R/W Temperature measurement unit
See Table 6-6 for codes
SNS_Density FLOAT D(20Hz) R Current value of density process variable
SNS_DensityUnits USINT16 S R/W Density measurement unit
See Table 6-5 for codes
10 SNS_VolFlow FLOAT D(0Hz) R Current value of liquid volume flow process
variable
11 SNS_VolumeFlowUnits ~ USINT16 S R/W Liquid volume flow measurement unit
See Table 6-3 for codes
12 SNS_DampingFlowRate FLOAT S R/W Flow damping value
0.0 to 60.0 sec
13 SNS_DampingTemp FLOAT S R/W Temperature damping value
0.0 to 80.0 sec
14 SNS_DampingDensity FLOAT S R/W Density damping value
0.0 t0 60.0 sec
15 SNS_MassMeterFactor  FLOAT S R/W Mass flow meter factor
0.8to 1.2
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Measurement block (Slot 1) continued

Data Memory
Index Name type class Access Comments o
Q
16 SNS_DensMeterFactor  FLOAT S R/W Density meter factor %
0.8t01.2 3
(7]
17 SNS_VolMeterFactor FLOAT S R/W Volume flow meter factor
0.8t0o 1.2
18 SNS_MassFlowCutoff FLOAT S R/W Mass flow cutoff
0 to sensor limit
19 SNS_VolumeFlowCutoff FLOAT S R/W Volume flow cutoff
0 to sensor limit
20 SNS_LowDensityCutoff =~ FLOAT S R/W Density cutoff
0.0t0 0.5
21 SNS_FlowDirection USINT16 S R/W *0 = Forward Only
* 1 = Reverse Only
2 = Bidirectional
* 3 = Absolute Value
* 4 = Negate/Forward Only
* 5 = Negate/ Bidirectional %
22 SNS_StartStopTotals USINT16 --- R/W * 0x0000 = Stop totalizers g
* 0x0001 = Start totalizers
23 SNS_ResetAllTotal USINT16 --- R/W * 0x0000 = No action
*0x0001 = Reset
24 SNS_ResetAll USINT16 --- R/W * 0x0000 = No action
Inventories ¢ 0x0001 = Reset
25 SNS_ResetMassTotal USINT16 --- R/W * 0x0000 = No action
*0x0001 = Reset
26 SNS_ResetLineVolTotal USINT16 --- R/W Liquid volume totalizer
* 0x0000 = No action
¢ 0x0001 = Reset
27 SNS_MassTotal FLOAT D(20Hz) R Current value of mass total
28 SNS_VolTotal FLOAT D(0Hz) R Current value of liquid volume total g
29 SNS_MasslInventory FLOAT D(20Hz) R Current value of mass inventory 5
30 SNS_Vollnventory FLOAT D(20Hz) R Current value of liquid volume inventory g
(1]
31 SNS_MassTotalUnits USINT16 S R Mass total/inventory measurement unit §'
See Table D-10 for codes »
32 SNS_VolTotalUnits S R Liquid volume total/inventory measurement
USINT16 unit
See Table D-11 for codes
33 SNS_EnableGSV™ USINT16 S R/W Enable gas standard volume flow
measurement
* 0x0000 = disabled
*0x0001 = enabled
34 SNS_GSV_GasDens FLOAT S R/W Standard density of the gas
35 SNS_GSV_VolFlow FLOAT D(20Hz) R Current value of gas standard volume flow
process variable o
36 SNS_GSV_VolTot FLOAT D(20Hz) R Current value of gas standard volume total -3
Q
37 SNS_GSV_Volinv FLOAT D(20Hz) R Current value of gas standard volume <
inventory S’
o
38 SNS_GSV_FlowUnits USINT16 S R/W Gas standard volume flow measurement unit o

See Table 6-4 for codes
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Measurement block (Slot 1) continued

Data Memory

Index Name type class Access Comments

39 SNS_GSV_TotalUnits USINT16 S R Gas standard volume total/inventory
measurement unit
See Table D-12 for codes

40 SNS_GSV_FlowCutoff FLOAT S R/W Gas standard volume flow cutoff
=> OO

41 SNS_ResetGSVolTotal USINT16 S R/W * 0x0000 = No action
* 0x0001 = Reset

42 SNS_ResetAPIGSVInv  USINT16 S R/W ¢ 0x0000 = No action
* 0x0001 = Reset

43 SNS_ResetMassinv USINT16 S R/W ¢ 0x0000 = No action
¢ 0x0001 = Reset

44 SNS_ResetVolinv USINT16 S R/W ¢ 0x0000 = No action

*0x0001 = Reset

(1) If gas standard volume flow is enabled, liquid volume flow is disabled, and vice versa.

D.4  Calibration block (Slot 2)
Calibration block (Slot 2)
Data Memory
Index Name type class Access  Definition/Code/Comments
4 SNS_FlowCalGain FLOAT S R/W Flow calibration factor (6-character string)
5 SNS_FlowCalTemp FLOAT S R/W Temperature coefficient for flow (4-character
Coeff string)
6 SNS_FlowZeroCal USINT16 --- R/W * 0x0000 = Abort zero calibration
* 0x0001 = Start zero calibration
7 SNS_MaxZeroingTime  USINT16 S R/W Zero time
Range: 5-300 seconds
8 SNS_AutoZeroStdDev FLOAT S R Standard deviation of auto zero
9 SNS_AutoZeroValue FLOAT S R/W Present flow signal offset at zero flow, in psec
10 SNS_FailedCal FLOAT S R Zero value if calibration fails
11 SNS_Ki1Cal USINT16 --- R/W * 0x0000 = None
*0x0001 = Start D1 Cal
12 SNS_K2Cal USINT16 --- R/W * 0x0000 = None
¢ 0x0001 = Start D2 Cal
13 SNS_FdCal USINT16 --- R/W * 0x0000 = None
*0x0001 = Start FD Cal
14 SNS_TseriesD3Cal USINT16 --- R/W * 0x0000 = None
*0x0001 = Start D3 Cal
15 SNS_TseriesD4Cal USINT16 --- R/W *0x0000 = None
* 0x0001 = Start D4 Cal
16 SNS_K1 FLOAT S R/W Density calibration constant 1 (usec)
17 SNS_K2 FLOAT S R/W Density calibration constant 2 (psec)
18 SNS_FD FLOAT S R/W Flowing density calibration constant (usec)
19 SNS_Tseriesk3 FLOAT S R/W Density calibration constant 3 (usec)
20 SNS_TseriesK4 FLOAT S R/W Density calibration constant 4 (psec)
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Calibration block (Slot 2) continued

Data Memory
Index Name type class Access Definition/Code/Comments o
Q
21 SNS_D1 FLOAT S R/W Density of D1 calibration fluid %
22 SNS_D2 FLOAT S R/W Density of D2 calibration fluid a
23 SNS_CalValForFD FLOAT S R/W Density of flowing density calibration fluid
24 SNS_TseriesD3 FLOAT S R/W Density of D3 calibration fluid
25 SNS_TseriesD4 FLOAT S R/W Density of D4 calibration fluid
26 SNS_DensityTempCoeff FLOAT S R/W Density temperature coefficient
27 SNS_TSeriesFlow FLOAT S R/W T-Series FTG value
TGCO
28 SNS_TSeriesFlow FLOAT S R/W T-Series FFQ value
FQCO
29 SNS_TSeriesDens FLOAT S R/W T-Series DTG value
TGCO
30 SNS_TSeriesDens FLOAT S R/W T-Series DFQ1 value =
FQCO1 )
31 SNS_TSeriesDens FLOAT S R/W T-Series DFQ2 value &
FQCO2
32 SNS_TempCalOffset FLOAT S R/W Temperature calibration offset
33 SNS_TempCalSlope FLOAT S R/W Temperature calibration slope
34 SNS_EnableExtTemp USINT16 S R/W Use external temperature for APl and ED:
* 0x0000 = Disabled
*0x0001 = Enabled
35 SNS_ExternalTemplinput FLOAT S R/W External temperature value
36 SNS_EnablePresComp  Method S R/W Pressure compensation:
* 0x0000 = Disabled
*0x0001 = Enabled
37 SNS_ExternalPresinput  FLOAT D (20) R/W Exernal pressure value g
38 SNS_PressureUnits USINT16 S R/W Pressure measurement unit %
See Table 6-7 for codes %
39 SNS_FlowPresComp FLOAT S R/W Pressure correction factor for flow %
40 SNS_DensPresComp FLOAT S R/W Pressure correction factor for density g
41 SNS_FlowCalPres FLOAT S R/W Flow calibration pressure
42 SNS_FlowZeroRestore S R/W Restore factory zero:
* 0x0000 = No action
*0x0001 = Restore
43 DB_SNS_AutoZero S R Factory value for flow signal offset at zero flow,
Factory in ysec

=)
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D.5 Diagnostic block (Slot 3)

Diagnostic block (Slot 3)

Data Memory
Index Name type class Access  Definition/Code/Comments
1 SNS_SlugDuration FLOAT S R/W Slug duration
Unit: seconds
Range: 0 to 60 seconds
2 SNS_SlugLo FLOAT S R/W Slug low limit
Unit: g/cm?®
Range: 0-10 g/cm?®
3 SNS_SlugHi FLOAT S R/W Slug high limit
Unit: g/cm?®
Range: 0-10 g/cm?®
4 UNI_PClIndex USINT16 S R/W Discrete event index
0,1,2,3,4
5 SNS_PC_Action USINT16 S R/W Discrete event type
* 0 = Greater than Setpoint A
*1 = Less than Setpoint A
*2 = In Range (A=<x<=B)
* 3 = Out of Range (A>=x or B<=x)
SNS_PC_SetPointA FLOAT S R/W Value of Setpoint A
SNS_PC_SetPointB FLOAT S R/W Value of Setpoint B
SNS_PC_PVCode USINT16 S R/W Discrete event process variable
See Table D-13 for codes
9 SNS_PC_Status B_.ENUM D ((20Hz) R Discrete event status

*0x0001 = DE, active
* 0x0002 = DE, active
* 0x0004 = DE, active
* 0x0008 = DE, active
*0x0010 = DE, active
* Bits 5 to 15 undefined

10 SNS_StatusWords1 B_ENUM D ((20Hz) R ¢ 0x0001 = Core EEPROM checksum error
* 0x0002 = Core RAM test error
* 0x0004 = Not Used
* 0x0008 = Sensor failure
* 0x0010 = Temperature out of range
¢ 0x0020 = Calibration failed
* 0x0040 = Other failure
* 0x0080 = Transmitter initializing
*0x0100 = Not Used
* 0x0200 = Not Used
* 0x0400 = Simulation mode active (A132)
* 0x0800 = Not Used
* 0x1000 = Watchdog error
* 0x2000 = Not Used
* 0x4000 = Not Used
* 0x8000 = Fault
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Diagnostic block (Slot 3) continued

Data Memory
Index Name type class Access

Definition/Code/Comments

11 SNS_StatusWords2 B_ENUM D (20Hz) R

* 0x0001 = Not Used

* 0x0002 = Not Used

* 0x0004 = Not Used

* 0x0008 = Not Used

* 0x0010 = Density out of range

* 0x0020 = Drive out of range

* 0x0040 = PIC\Daughterboard
communications failure

* 0x0080 = Not Used

* 0x0100 = Non-volatile memory error (CP)

* 0x0200 = RAM error (CP)

* 0x0400 = Sensor failure

* 0x0800 = Temperature out of range

*0x1000 = Input out of range

* 0x2000 = Not used

* 0x4000 = Transmitter not characterized

* 0x8000 = Not Used

12 SNS_StatusWords3 B_ENUM D ((20Hz) R

¢ 0x0001 = Not Used

* 0x0002 = Power reset

* 0x0004 = Transmitter initializing
* 0x0008 = Not Used

¢ 0x0010 = Not Used

¢ 0x0020 = Not Used

¢ 0x0040 = Not Used

¢ 0x0080 = Not Used

* 0x0100 = Calibration failed

¢ 0x0200 = Calibration failed: Low
* 0x0400 = Calibration failed: High
* 0x0800 = Calibration failed: Noisy
¢ 0x1000 = Transmitter failed

* 0x2000 = Data loss

* 0x4000 = Calibration in progress
* 0x8000 = Slug flow

13 SNS_StatusWords4 B_ENUM D (20Hz) R

*0x0001 = API: Temperature out of range
* 0x0002 = API: Density out of range
*0x0004 = Line RTD out of range

* 0x0008 = Meter RTD out of range
*0x0010 = Reverse flow

* 0x0020 = Factory data error

*0x0040 = ED: bad curve

* 0x0080 = LMV override

*0x0100 = ED: Extrapolation error

* 0x0200 = Need calibration factor

* 0x0400 = Not Used

* 0x0800 = Not Used

* 0x1000= Transmitter not characterized

* 0x2000 = Non-volatile memory error (CP)
* 0x4000 = Non-volatile memory error (CP)
* 0x8000 = Non-volatile memory error (CP)
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PROFIBUS Bus Parameters

Diagnostic block (Slot 3) continued

Data Memory
Index Name type class Access

Definition/Code/Comments

14 SNS_StatusWords5 B_ENUM D (20Hz) R

¢ 0x0001 = Boot sector (CP)

* 0x0002 = Not Used

* 0x0004 = Not Used

* 0x0008 = Not Used

*0x0010 = Not Used

* 0x0020 = Not Used

* 0x0040 = D3 calibration in progress

* 0x0080 = D4 calibration in progress

*0x0100 = Not used

* 0x0200 = Not used

* 0x0400 = Temperature slope calibration in
progress

* 0x0800 = Temperature offset calibration in
progress

*0x1000 = FD calibration in progress

* 0x2000 = D2 calibration in progress

* 0x4000 = D1 calibration in progress

* 0x8000 = Zero calibration in progress

15 SNS_StatusWords6 B_ENUM D (20Hz) R

¢ 0x0001 = Not Used
¢ 0x0002 = Not Used
* 0x0004 = Not Used
¢ 0x0008 = Not Used
¢ 0x0010 = Not Used
* 0x0020 = Not Used
¢ 0x0040 = Not Used
* 0x0080 = Not Used
*0x0100 = DE, active
* 0x0200 = DE, active
* 0x0400 = DE, active
* 0x0800 = DE, active
*0x1000 = DE, active
¢ 0x2000 = Not Used
* 0x4000 = Not Used
* 0x8000 = Incorrect board type (A030)

16 SNS_StatusWords7 B_ENUM D (20Hz) R

* 0x0001 = K1/FCF combination unrecognized

* 0x0002 = Warming up

* 0x0004 = Low power (A031)

* 0x0008 = Tube not full (A033)

* 0x0010 = Meter verification / Outputs in fault
(A032)™

* 0x0020 = Meter verification / Outputs at last
value (A131)®

* 0x0040 = PIC Ul EEPROM Error (A133)

* 0x0080 = Not Used

*0x0100 = Not Used

* 0x0200 = Not Used

* 0x0400 = Not Used

* 0x0800 = Not Used

*0x1000 = Not Used

* 0x2000 = Not Used

* 0x4000 = Meter verification failed (A034)

* 0x8000 = Meter verification aborted (A035)
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Index

Diagnostic block (Slot 3) continued

Name

Data
type

Memory
class

Access

Definition/Code/Comments

17

SNS_StatusWords8

B_ENUM

D (20 Hz)

R

¢ 0x0001 = Not Used
¢ 0x0002 = Not Used
* 0x0004 = Not Used
¢ 0x0008 = Not Used
¢ 0x0010 = Not Used
* 0x0020 = Not Used
¢ 0x0040 = Not Used
* 0x0080 = Not Used
¢ 0x0100 = Not Used
¢ 0x0200 = Not Used
¢ 0x0400 = Not Used
* 0x0800 = Not Used
¢ 0x1000 = Not Used
¢ 0x2000 = Not Used
* 0x4000 = Not Used
* 0x8000 = Not Used

18

SYS_DigCommFault
ActionCode

USINT16

R/W

*0 = Upscale

*1 = Downscale

o2 =Zero

*3 =NAN

*4 = Flow goes to zero
*5 =None

19

DB_SYS_TimeoutValue
LMV

USINT16

R/W

Fault timeout value
Range: 0—60 seconds

20

UNI_Alarm_Index

USINT16

R/W

Alarm index used to configure or read alarm
severity, or to acknowledge alarms
See Table D-13 for alarm index codes

21

SYS_AlarmSeverity

USINT16

R/W

*0 = Ignore
*1 = Info
¢ 2 = Fault

22

SYS_AlarmStatus

B_ENUM

D (20 Hz)

R/wW

The status of the alarm identified by the alarm
index.

* 0x00 = Acked /Cleared

*0x01 = Acked/Active

* 0x10 = Not Acked/Cleared

*0x11 = Not Acked/Active

Write 0 to acknowledge alarm

23

SYS_AlarmCount

USINT16

The number of inactive-to-active transitions of
the alarm identified by the alarm index.

24

SYS_AlarmPosted

USINT32

The number of seconds since the last
power-on time reset (Index 52) that the alarm
identified by the alarm index was posted

25

SYS_AlarmCleared

USINT32

The number of seconds since the last
power-on time reset (Index 52) that the alarm
identified by the alarm index was cleared

26

UNI_AlarmHistorylndex

USINT16

R/W

The entry in the alarm history log
Range: 049

27

SYS_AlarmNumber

USINT16

The alarm number that corresponds to the
alarm history entry identified by the alarm
history index

1 =A001, 2 = A002, etc.

28

SYS_AlarmEvent

USINT16

The alarm status change that corresponds to
the alarm history entry identified by the alarm
history index

*1 = Posted

*2 = Cleared
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PROFIBUS Bus Parameters

Diagnostic block (Slot 3) continued

Data Memory
Index Name type class Access Definition/Code/Comments
29 SYS_AlarmTime USINT32 S R The timestamp of the alarm status change that
corresponds to the alarm history entry
identified by the alarm history index
Seconds since last power-on time reset
(Index 52)
30 SYS_AckAllAlarms USINT16 S R/W * 0x0000 = Not used
*0x0001 = Acknowledge
31 SYS_ClearAlarmHistory USINT16 S R/W ¢ 0x0000 = Not used
*0x0001 = Reset
32 SNS_DriveGain FLOAT D(20Hz) R The drive gain
%
33 SNS_RawTubeFreq FLOAT D(20Hz) R The tube frequency
Unit: Hz
34 SNS_LiveZeroFlow FLOAT D(@20Hz) R The unfiltered value of mass flow
Unit: unit configured for mass flow
35 SNS_LPOamplitude FLOAT D(20Hz) R The left pickoff voltage
Unit: volts
36 SNS_RPOamplitude FLOAT D(20Hz) R The right pickoff voltage
Unit: volts
37 SNS_BoardTemp FLOAT D(0Hz) R The temperature on the board
Unit: °C
38 SNS_MaxBoardTemp FLOAT D(@0Hz) R The maximum temperature of the electronics
Unit: °C
39 SNS_MinBoardTemp FLOAT D(20Hz) R The minimum temperature of the electronics
Unit: °C
40 SNS_AveBoardTemp FLOAT D(20Hz) R The average temperature of the electronics
Unit: °C
41 SNS_MaxSensorTemp  FLOAT D(@20Hz) R The maximum temperature of the sensor
Unit: °C
42 SNS_MinSensorTemp FLOAT D(@20Hz) R The minimum temperature of the sensor
Unit: °C
43 SNS_AveSensorTemp FLOAT D(20Hz) R The average temperature of the sensor
Unit: °C
44 SNS_WireRTDRes FLOAT D(20Hz) R The resistance of the 9-wire cable
Unit: ohms
45 SNS_LineRTDRes FLOAT D(0Hz) R The resistance of the process line RTD
Unit: ohms
46 SYS_PowerCycleCount USINT16 D R The number of transmitter power cycles
47 SYS_PowerOnTimeSec USINT32 S R The cumulative amount of time the transmitter
has been on since the last reset
Unit: seconds since last reset
48 SNS_InputVoltage FLOAT S R Coriolis supply voltage (internal
measurement), ~12 VDC
Unit: volts
49 SNS_TargetAmplitude FLOAT S R The amplitude the transmitter is attempting to
drive the sensor
Unit: mV/HZ
50 SNS_CaseRTDRes FLOAT S R The resistance of the case (meter) RTD
Unit: ohms
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Diagnostic block (Slot 3) continued

Data Memory
Index Name type class Access Definition/Code/Comments o
o
51 SYS_RestoreFactory USINT16 S R/W * 0x0000 = No action %
Config *0x0001 = Restore 3
7
52 SYS_ResetPowerOn USINT16 S R/W * 0x0000 = No action
Time *0x0001 = Reset
53 FRF_EnableFCF USINT16 S R/W Type of meter verification to perform
Validation * 0x0000 = Disable
*0x0001 = Normal
* 0x0002 = Factory verification of air
* 0x0003 = Factory verification of water
*0x0004 = Debug
* 0x0006 = Continue measurement®
54 FRF_FaultAlarm USINT16 D R/W The state of the outputs when the meter
verification routine is running
*0 = Last value
*1 = Fault
55 DB_FRF_StiffnessLimit  FLOAT S R/W The setpoint of the stiffness limit. Represents =
percentage )
Unitless o
56 FRF_AlgoState USINT16 S R The current state of the meter verification
routine
1-18
57 FRF_AbortCode USINT16 S R The reason the meter verification routine
aborted:

*0 = No error

* 1 = Manual abort

¢ 2 = Watchdog timeout

* 3 = Frequency drift

* 4 = High peak drive voltage

* 5 = High drive current standard deviation
* 6 = High drive current mean value

* 7 = Drive loop reported error

* 8 = High delta T standard deviation g
*9 = High delta T value %
* 10 = State running o
Q0
58 FRF_StateAtAbort USINT16 S R The state of the meter verification routine %
when it aborted T
1-18 )
59 DB_FRF_ USINT16 D R Is the inlet stiffness out of limits?
StiffOutLimLpo *0=No
*1=Yes
60 DB_FRF_ USINT16 D R Is the outlet stiffness out of limits?
StiffOutLimRpo *0=No
*1=Yes
61 FRF_Progress USINT16 S R The progress of the meter verification routine
%
62 DB_FRF_StiffnessLpo_  FLOAT S R The current inlet stiffness calculated as a
Mean mean o
63 DB_FRF_StiffnessRpo_  FLOAT S R The current outlet stiffness calculated as a g'
Mean mean g
64 DB_FRF_Damping_ FLOAT S R The current damping calculated as a mean g’
Mean %
65 DB_FRF_MassLpo_ FLOAT S R The current inlet mass calculated as a mean @
Mean
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Diagnostic block (Slot 3) continued

Data Memory
Index Name type class Access Definition/Code/Comments
66 DB_FRF_MassRpo_ FLOAT S R The current outlet mass calculated as a mean
Mean
67 DB_FRF_StiffnessLpo FLOAT S R The current inlet stiffness calculated as a
StdDev standard deviation
68 DB_FRF_StiffnessRpo_  FLOAT S R The current outlet stiffness calculated as a
StdDev standard deviation
69 DB_FRF_Damping_ FLOAT S R The current damping calculated as a standard
StdDev deviation
70 DB_FRF_MassLpo_ FLOAT S R The current inlet mass calculated as a
StdDev standard deviation
71 DB_FRF_MassRpo_ FLOAT S R The current outlet mass calculated as a
StdDev standard deviation
72 DB_FRF_StiffnessLpo_  FLOAT S R The inlet stiffness calculated as a mean during
AirCal factory calibration of air
73 DB_FRF_StiffnessRpo_  FLOAT S R The outlet stiffness calculated as a mean
AirCal during factory calibration of air
74 DB_FRF_Damping_ FLOAT S R The damping calculated as a mean during
AirCal factory calibration of air
75 DB_FRF_MasslLpo_ FLOAT S R The inlet mass calculated as a mean during
AirCal factory calibration of air
76 DB_FRF_MassRpo_ FLOAT S R The outlet mass calculated as a mean during
AirCal factory calibration of air
77 DB_FRF_StiffnessLpo_  FLOAT S R The inlet stiffness calculated as a mean during
WaterCal factory calibration of water
78 DB_FRF_StiffnessRpo_  FLOAT S R The outlet stiffness calculated as a mean
WaterCal during factory calibration of water
79 DB_FRF_Damping_ FLOAT S R The damping calculated as a mean during
WaterCal factory calibration of water
80 DB_FRF_MassLpo_ FLOAT S R The inlet mass calculated as a mean during
WaterCal factory calibration of water
81 DB_FRF_MassRpo_ FLOAT S R The outlet mass calculated as a mean during
WaterCal factory calibration of water
82 DB_UNI_DE_ USINT16 S R /W The action that will be performed by the event
ActionCode identified by the discrete event assignment
index
¢ 1 = Start Sensor Zero
* 2 = Reset Mass Total
* 3 = Reset Volume Total
* 4 = Reset API Volume Total
*5 = Reset ED Volume Total
*6 = Reset ED Net Mass Tot
*7 = Reset ED Net Vol Tot
* 8 = Reset All Totals
* 9 = Start/Stop All Totals
* 18 = Increment ED Curve
*21 = Reset GSV Total
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Diagnostic block (Slot 3) continued

Data Memory
Index Name type class Access Definition/Code/Comments
83 DB_UNI_DE_ USINT16 S R /W Discrete event assignment index
Assignment * 57 = Discrete Event 1
* 58 = Discrete Event 2
*59 = Discrete Event 3
* 60 = Discrete Event 4
*61 = Discrete Event 5
*251 = None
84 DB_SYS_MasterReset  USINT16 S R/W * 0x0000 = No action
* 0x0001 = Perform master reset
85 SYS_AckAlarm USINT16 S R/W Write alarm index to acknowledge alarm. See
Table D-13 for alarm index codes
86 SYS_DriveCurrent FLOAT D(@0Hz) R Sensor drive current
Units: mA
87®@ DB_FRF_MV_Index USINT16 D (20Hz) R/W Index of meter verification test record on
transmitter (0-19)
*0 = Newest
* 19 = Oldest
88®@ DB_FRF_MV_Counter USINT16 D(20Hz) R Counter assigned to meter verification test
record
89 DB_FRF_MV_Status USINT16 D (20Hz) R Meter verification test record: Test status
* Bit 7 = Pass/Fail
* Bits 64 = State
* Bits 3—0 = Abort code
90® DB_FRF_MV_Time USINT32 D(20Hz) R Meter verification test record: Test start time
91@ DB_FRF_MV_LPO_Nor FLOAT D(0Hz) R Meter verification test record: LPO stiffness
m
92@) DB_FRF_MV_RPO_Nor FLOAT D(20Hz) R Meter verification test record: RPO stiffness
m
93®@ DB_FRF_MV_FirstRun_ FLOAT D(20Hz) R/W Meter verification scheduler: Hours until first
Time test
* Range: 1-1000
*0 = No test scheduled
94@ DB_FRF_MV_Elapse_Ti FLOAT D(20Hz) R/W Meter verification scheduler: Hours between
me tests
*Range: 1-1000
* 0 = No recurring execution
95 DB_FRF_MV_Time_Left FLOAT D (20Hz) R Meter verification scheduler: Hours until next

test

(1) Applies only to systems with the original version of the meter verification application.
(2) Applies only to systems with Smart Meter Verification.
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PROFIBUS Bus Parameters

D.6  Device Information block (Slot 4)

Device Information block (Slot 4)

Data Memory
Index Name type class Access  Definition/Code/Comments

4 SYS_FeatureKey B_ENUM S R Transmitter options enabled
¢ 0x0000 = Standard
* 0x0800 = Meter verification
* 0x0008 = Enhanced density
¢ 0x0010 = Petroleum measurement

SYS_CEQ_Number USINT16
SNS_SensorSerialNum  USINT32
SNS_SensorType STRING

SNS_SensorTypeCode  USINT16

R ETO (Engineering To Order) on transmitter
R/W
RW

R/W ¢ (0 = Curved tube
* 1 = Straight tube

9 SNS_SensorMaterial USINT16 S R/W *0 = None
* 3 = Hastelloy C-22
¢4 = Monel
¢ 5 = Tantalum
¢ 6 = Titanium
* 19 = 316L stainless steel
¢ 23 = Inconel
¢ 252 = Unknown
* 253 = Special

10 SNS_LinerMaterial USINT16 S R/W *0 =None
* 10 = PTFE (Teflon)
*11 =Halar
* 16 = Tefzel
*251 = None
¢ 252 = Unknown
* 253 = Special

11 SNS_FlangeType USINT16 S R/W *0 = ANSI 150
*1 = ANSI 300
*2 = ANSI 600
*5=PN 40
7 =JIS 10K
*8 =JIS 20K
*9 = ANSI 900
* 10 = Sanitary clamp fitting
*11 = Union
*12=PN 100
¢ 252 = Unknown
* 253 = Special

High mass flow limit of sensor

0| N[O,
N ;w|IN|;m

12 SNS_MassFlowHiLim FLOAT
13 SNS_TempFlowHiLim FLOAT
14 SNS_DensityHiLim FLOAT
15 SNS_VolumeFlowHiLim  FLOAT
16 SNS_MassFlowLoLim FLOAT
17 SNS_TempFlowLoLim FLOAT
18 SNS_DensityLoLim FLOAT
19 SNS_VolumeFlowLoLim FLOAT
20 SNS_MassFlowLoSpan  FLOAT
21 SNS_TempFlowLoSpan FLOAT
22 SNS_DensityLoSpan FLOAT

High temperature limit of sensor

High density limit of sensor

High volume flow limit of sensor

Low mass flow limit of sensor

Low temperature limit of sensor

Low density limit of sensor

Low volume flow limit of sensor

Mass flow minimum range of sensor

Temperature minimum range of sensor

N OO OO Ol vl n|ln
V| V| V| V| V| V| V| V|WV|I/| T

Density minimum range of sensor
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Device Information block (Slot 4) continued

Data Memory
Index Name type class Access Definition/Code/Comments
23 SNS_VolumeFlow FLOAT S R Volume flow minimum range of sensor
LoSpan
24 HART_HartDevicelD USINT32 S R/W Transmitter serial number
25 SYS_SoftwareRev USINT16 S R Transmitter software revision (xxx.xx format,
e.g., 141 =rev1.41)
26 SYS_BoardRevision USINT16 S R Board revision
D.7 Local Display block (Slot 5)
Local Display block (Slot 5)
Data Memory
Index Name type class Access Definition/Code/Comments
4 Ul_EnableLdoTotalizer USINT16 S R/W Reset totalizers from display
Reset * 0x0000 = Disabled
*0x0001 = Enabled
5 Ul_EnableLdoTotalizer USINT16 S R/W Start/stop totalizers from display
StartStop * 0x0000 = Disabled
*0x0001 = Enabled
6 Ul_EnableLdoAutoScroll USINT16 S R/W Display auto scroll
* 0x0000 = Disabled
*0x0001 = Enabled
7 Ul_EnableLdoOffline USINT16 S R/W Enable/disable access to display offline menu
Menu * 0x0000 = Disabled
*0x0001 = Enabled
8 Ul_EnableSecurity USINT16 S R/W Password required to access display offline
menu
* 0x0000 = Password not required
*0x0001 = Password required
9 Ul_EnableLdoAlarm USINT16 S R/W Enable/disable access to display alarm menu
Menu * 0x0000 = Disabled
*0x0001 = Enabled
10 Ul_EnableLdoAckAll USINT16 S R/W Ack All function from display
Alarms * 0x0000 = Disabled
*0x0001 = Enabled
11 Ul_OfflinePassword USINT16 S R/W Display password
0 to 9999
12 Ul_AutoScrollRate USINT16 S R/W The number of seconds for which each display
variable will be displayed
110 30
13 Ul_BacklightOn USINT16 S R/W * 0x0000 = Off
*0x0001 =On
14 UNI_UI_ProcVarlndex USINT16 S R/W Process variable index
See Table D-13 for codes
15 Ul_NumDecimals USINT16 S R/W The number of digits displayed to the right of
the decimal point for the process variable
identified by the process variable index
Range: 0-5
16 Ul_ProcessVariables USINT16 S R/W See Table D-13 for codes. All codes are valid

(LDO_VAR_1_CODE)

except for 251 (None).
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PROFIBUS Bus Parameters

Local Display block (Slot 5) continued

Data Memory
Index Name type class Access Definition/Code/Comments
17 Ul_ProcessVariables USINT16 S R/W See Table D-13 for codes. All codes are valid.
(LDO_VAR_2_CODE)
18 Ul_ProcessVariables USINT16 S R/W
(LDO_VAR_3_CODE)
19 Ul_ProcessVariables USINT16 S R/W
(LDO_VAR_4_CODE)
20 Ul_ProcessVariables USINT16 S R/W
(LDO_VAR_5_CODE)
21 Ul_ProcessVariables USINT16 S R/W
(LDO_VAR_6_CODE)
22 Ul_ProcessVariables USINT16 S R/W
(LDO_VAR_7_CODE)
23 Ul_ProcessVariables USINT16 S R/W
(LDO_VAR_8_CODE)
24 Ul_ProcessVariables USINT16 S R/W
(LDO_VAR_9_CODE)
25 Ul_ProcessVariables USINT16 S R/W
(LDO_VAR_10_CODE)
26 Ul_ProcessVariables USINT16 S R/W
(LDO_VAR_11_CODE)
27 Ul_ProcessVariables USINT16 S R/W
(LDO_VAR_12_CODE)
28 Ul_ProcessVariables USINT16 S R/W
(LDO_VAR_13_CODE)
29 Ul_ProcessVariables USINT16 S R/W
(LDO_VAR_14_CODE)
30 Ul_ProcessVariables USINT16 S R/W
(LDO_VAR_15_CODE)
31 Ul_UpdatePeriodmsec USINT16 S R/W Refresh rate of the display
Range: 100-10,000 milliseconds
32 Ul_BacklightOnintensity USINT16 S R/W The brightness of the backlight
Range: 0 (off) to 63 (full on)
33 Ul_Language USINT16 S R/W *0 = English
1 =German
¢ 2 = French
* 3 = Not used
*4 = Spanish
34 SYS_Enable_IRDA_ USINT16 S R/W IrDA port availability:
Comm ¢ 0x0000 = Disabled
*0x0001 = Enabled
35 SYS_Enable_IRDA_ USINT16 S R/W IrDA port usage:

WriteProtect

* 0x0000 = Read/write
*0x0001 = Read-only
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D.8 APl block (Slot 6)

API block (Slot 6)

o
Q
Data Memory S
Index Name type class Access  Definition/Code/Comments 3
4 SNS_API_CorrDensity FLOAT D(0Hz) R Current value of API Temperature Corrected
Density process variable
5 SNS_API_CorrVolFlow  FLOAT D(20Hz) R Current value of APl Temperature Corrected
Volume Flow process variable
6 SNS_API_AveCorr FLOAT D(20Hz) R Batch weighted average density
Density
SNS_API_AveCorrTemp FLOAT D(20Hz) R Batch weighted average temperature
SNS_API_CTL FLOAT D(20Hz) R Current CTL value
SNS_API_CorrVolTotal ~ FLOAT D(0Hz) R Current value of API Temperature Corrected
Volume Total
10 SNS_API_CorrVollnv FLOAT D(20Hz) R Current value of APl Temperature Corrected
Volume Inventory =
11 SNS_ResetApiRefVol USINT16  --- R/W Reset APl Temperature Corrected Volume g
Total Total 0
* 0x0000 = No action
*0x0001 = Reset
12 SNS_ResetAPIGSVInv ~ USINT16 S R/W Reset API Temperature Corrected Volume
Inventory
* 0x0000 = No action
*0x0001 = Reset
13 SNS_APIRefTemp FLOAT S R/W The reference temperature to use in the API
calculations
14 SNS_APITEC FLOAT S R/W The thermal expansion coefficient to use in the
API calculations
15 SNS_API2540TableType USINT16 S R/W The table type to use in the API calculations
* 17 = Table 5A
*18 = Table 5B
*19 = Table 5D
* 36 = Table 6C

* 49 = Table 23A
* 50 = Table 23B
*51 = Table 23D
* 68 = Table 24C
* 81 = Table 53A
¢ 82 = Table 53B
* 83 = Table 53D
* 100 = Table 54C

o
c
(2]
Y
Q
=
)
3
]
—
(1]
=
(]

D.9  Enhanced Density block (Slot 7)

Enhanced Density block (Slot 7)

o

Data Memory >

Index Name type class Access  Definition/Code/Comments %
<

4 SNS_ED_RefDens FLOAT D((@20Hz) R Current value of ED density at reference g)
SNS_ED_SpecGrav FLOAT D (20 Hz) Current value of ED density (fixed SG units) §

SNS_ED_StdVolFlow FLOAT D (20 Hz) Current value of ED standard volume flow rate

SNS_ED_NetMassFlow FLOAT D (20 Hz)

N|o| o,
| V| D

Current value of ED net mass flow rate
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Enhanced Density block (Slot 7) continued

Data Memory
Index Name type class Access Definition/Code/Comments
8 SNS_ED_NetVolFlow FLOAT D(20Hz) R Current value of ED net volume flow rate
9 SNS_ED_Conc FLOAT D(20Hz) R Current value of ED concentration
11 SNS_ED_StdVolTotal FLOAT D(20Hz) R Current value of ED standard volume total
12 SNS_ED_StdVollnv FLOAT D(20Hz) R Current value of ED standard volume
inventory
13 SNS_ED_NetMassTotal FLOAT D(20Hz) R Current value of ED net mass total
14 SNS_ED_NetMassInv FLOAT D(@20Hz) R Current value of ED net mass inventory
15 SNS_ED_NetVolTotal FLOAT D(20Hz) R Current value of ED net volume total
16 SNS_ED_NetVolinv FLOAT D(20Hz) R Current value of ED net volume inventory
17 SNS_ResetEDRefVol USINT16 --- R/W Reset ED standard volume total:
Total * 0x0000 = No action
*0x0001 = Reset
18 SNS_ResetEDNetMass USINT16  --- R/W Reset ED net mass total:
Total * 0x0000 = No action
*0x0001 = Reset
19 SNS_ResetEDNetVol USINT16 --- R/W Reset ED net volume total:
Total * 0x0000 = No action
*0x0001 = Reset
20 SNS_ResetEDVollnv USINT16 S R/W Reset ED standard volume inventory:
* 0x0000 = No action
*0x0001 = Reset
21 SNS_ResetEDNetMass USINT16 S R/W Reset ED net mass inventory:
Inv ¢ 0x0000 = No action
¢ 0x0001 = Reset
22 SNS_ResetEDNetVolinv  USINT16 S R/W Reset ED net volume inventory:

¢ 0x0000 = No action
*0x0001 = Reset

23 SNS_ED_Curvelock USINT16 S R/W Write-protect (lock) all ED curves:
* 0x0000 = Not locked
¢ 0x0001 = Locked

24 SNS_ED_Mode USINT16 S R/wW Derived variable:
*0 =None
* 1 = Density at reference temperature
* 2 = Specific gravity
* 3 = Mass concentration (density)
* 4 = Mass concentration (specific gravity)
* 5 = Volume concentration (density)
* 6 = Volume concentration (specific gravity)
7 = Concentration (density)
* 8 = Concentration (specific gravity)

25 SNS_ED_ActiveCurve USINT16 S R/W Active curve index (a)
Range: 0-5
26 UNI_ED_Curvelndex USINT16 S R/W Curve configuration index (n)
Range: 0-5
27 UNI_ED_Tempindex USINT16 S R/W Curve, temperature isotherm index (x)
Range: 0-5
28 UNI_ED_Concindex USINT16 S R/W Curve, concentration index (y)
Range: 0-5
29 SNS_ED_TempISO FLOAT S R/W Temperature value: Curve, Isotherm,
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Enhanced Density block (Slot 7) continued

Data Memory
Index Name type class Access Definition/Code/Comments
30 SNS_ED_DensAtTemp  FLOAT S R/wW Density value: Curve, Isotherm,
ISO Concentration,
31 SNS_ED_DensAtTemp  FLOAT S R/W Coefficient: Curve, Isotherm, Concentrationy
Coeff
32 SNS_ED_ConcLabel55 FLOAT S R/W Curve, concentration units label code:
* 100 = Degrees Twaddell
* 101 = Degrees Brix
* 102 = Degrees Baume (heavy)
* 103 = Degrees Baume (light)
* 105 Percent solids per weight
* 106 = Percent solids per volume
* 107 = Degrees Balling
* 108 = Proof per volume
* 109 = Proof per mass
* 160 = Degrees Plato
* 253 = Special
33 SNS_ED_DensAtConc  FLOAT S R/W Curve, (1x6) density at Concentration, at
reference temperature
34 SNS_ED_DensAtConc  FLOAT S R/W Curve, (1x6) coefficient at Concentration, at
Coeff reference temperature
35 SNS_ED_ConclLabel51 FLOAT S R/W Curve, (1x6) Concentration, value (y-axis)
36 SNS_ED_RefTemp FLOAT S R/W Curve, reference temperature
37 SNS_ED_SGWaterRef = FLOAT S R/W Curve, specific gravity water reference
Temp temperature
38 SNS_ED_SGWaterRef = FLOAT S R/W Curve, specific gravity water reference density
Dens
39 SNS_ED_SlopeTrim FLOAT S R/W Curve, trim: slope
40 SNS_ED_OffsetTrim FLOAT S R/W Curve, trim: offset
41 SNS_ED_ExtrapAlarm FLOAT S R/W Curve, extrapolation alarm limit (%)
Limit
42 SNS_ED_CurveName STRING S R/W Curve, name
43 SNS_ED_MaxFitOrder ~ USINT16 S R/W Curve, maximum fit order
Range: 2-5
44 SNS_ED_FitResults USINT16 S R Curve, curve fit results:
*0 = Good
*1 = Poor
2 = Failed
*3 = Empty
45 SNS_ED_ConcUnit USINT16 S R/W Curve, concentration units code:
Code * 1110 = Degrees Twaddell
* 1426 = Degrees Brix
* 1111 = Deg Baume (heavy)
* 1112 = Deg Baume (light)
* 1343 = % sol/wt
* 1344 = % sol/vol
* 1427 = Degrees Balling
* 1428 = Proof (volume)
* 1429 = Proof (mass)
* 1346 = Percent Plato
* 1342 = Percent (Special Units)
46 SNS_ED_ExpectedAcc  FLOAT S R Curve, expected accuracy of curve fit
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PROFIBUS Bus Parameters

Enhanced Density block (Slot 7) continued

Data Memory
Index Name type class Access Definition/Code/Comments
47 SNS_ED_ResetFlag USINT16 S w Reset all density curve data:
* 0x0000 = No action
*0x0001 = Reset
48 SNS_ED_EnableDens USINT16 S R/W Low-density extrapolation alarm:
LowExtrap * 0x0000 = Disable
*0x0001 = Enable
49 SNS_ED_EnableDens USINT16 S R/W High-density extrapolation alarm:
HighExtrap * 0x0000 = Disable
*0x0001 = Enable
50 SNS_ED_EnableTemp USINT16 S R/W Low-temperature extrapolation alarm:
LowExtrap * 0x0000 = Disable
*0x0001 = Enable
51 SNS_ED_EnableTemp USINT16 S R/W High-temperature extrapolation alarm:
HighExtrap * 0x0000 = Disable
*0x0001 = Enable
52 SNS_ED_LongCurve OCTET S R/W Extended name of curve
Name STRING
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D.10 I&M functions (Slot 0)
I&M functions
Sub- Data Memory
Index index Name Description type Size class Access
255 65000 HEADER Manufacturer- specific STRING 10 S R
MANUFACTURER_ ID for manufacturer that is USINT16 2 S R
ID assigned by PTO
ORDER_ID Order number of device STRING 20 S R
SERIAL_NO Production serial number of STRING 16 S R
device
HARDWARE_ Revision number of the USINT16 2 S R
REVISION hardware
SOFTWARE_ Software or firmware revision 1xCHAR 4 S R
REVISION of device or module 3xUSINT8
REV_COUNTER Marks the change of hardware USINT16 2 S R
revision or any of its
parameters
PROFILE_ID Profile type of supporting USINT16 2 S R
profile
PROFILE_ Specific profile type USINT16 2 S R
SPECIFIC_TYPE
IM_VERSION Implemented version of &M 2xUSINT8 2 S R
functions
IM_SUPPORTED Indicated availability of I&M USINT16" 2 S R
functions
65001 HEADER Manufacturer-specific STRING 10 S R
TAG_FUNCTION Device identification tag STRING 32 S R/W
TAG_LOCATION Device location identification =~ STRING 22 S R/W
tag
(1) Implemented as bit array.
D.11 Totalizer and inventory measurement unit codes
Mass totalizer and mass inventory measurement unit codes
Code Label Description
1089 g Gram
1088 Kg Kilogram
1092 metric tons Metric ton
1094 Ibs Pound
1095 short tons Short ton (2000 pounds)
1096 long tons Long ton (2240 pounds)
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PROFIBUS Bus Parameters

D.12

186

Liquid volume totalizer and liquid volume inventory measurement unit codes

Code Label Description
1048 gal Gallon

1038 I Liter

1049 ImpGal Imperial gallon
1034 m3 Cubic meter
1036 cm3 Cubic centimeter
1051 bbl Barrel™

1641 Beer bbl Beer barrel®
1043 ft3 Cubic foot

(1) Unit based on oil barrels (42 U.S. gallons).
(2) Unit based on U.S. beer barrels (31 U.S. gallons).

Gas standard volume totalizer and gas standard volume inventory
measurement unit codes

Code Label Description

1053 SCF Standard cubic feet
1521 Nm3 Normal cubic meters
1526 Sm3 Standard cubic meters
1531 NL Normal liter

1536 SL Standard liter

Process variable codes

Process variahle codes

Code Description

0 Mass flow rate

1 Temperature

2 Mass total

3 Density

4 Mass inventory

5 Volume flow rate

6 Volume total

7 Volume inventory

15 API: Temperature-corrected density

16 API: Temperature-corrected (standard) volume flow
17 API: Temperature-corrected (standard) volume total
18 API: Temperature-corrected (standard) volume inventory
19 API: Batch weighted average density

20 API: Batch weighted average temperature

21 Enhanced density: Density at reference temperature
22 Enhanced density: Density (fixed SG units)
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Process variahle codes continued

Code Description

23 Enhanced density: Standard volume flow rate
24 Enhanced density: Standard volume total
25 Enhanced density: Standard volume inventory
26 Enhanced density: Net mass flow rate
27 Enhanced density: Net mass total

28 Enhanced density: Net mass inventory
29 Enhanced density: Net volume flow rate
30 Enhanced density: Net volume total

31 Enhanced density: Net volume inventory
32 Enhanced density: Concentration

33 API: CTL

46 Tube frequency

47 Drive gain

48 Case temperature

49 Left pickoff amplitude

50 Right pickoff amplitude

51 Board temperature

53 External pressure

55 External temperature

63 Gas standard volume flow rate

64 Gas standard volume total

65 Gas standard volume inventory

69 Live zero

251 None

D.13 Alarm index codes

Alarm index codes

o
=]
Q
o

Description

Nonvolatile memory failure

RAM/ROM error

Sensor failure

Temperature overrange

Input overrange

Transmitter not characterized

Reserved

Density overrange

O|loo| Nl || N| =

Transmitter initializing/warming up

-
o

Calibration failure

—_
—_

Zero too low
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188

Alarm index codes continued

Code Description

12 Zero too high

13 Zero too noisy

14 Transmitter failed

16 Line RTD Temperature out-of-range
17 Meter RTD temperature out-of-range
18 Reserved

19 Reserved

20 Incorrect sensor type (K1)

21 Invalid sensor type

22 NV error (core processor)

23 NV error (core processor)

24 NV error (core processor)

25 Boot fail (core processor)

26 Reserved

27 Security breach

28 Reserved

29 Internal communication failure

30 Hardware/software incompatible

31 Low power

32 Meter verification fault alarm

33 Tubes not full

42 Drive overrange

43 Data loss possible

44 Calibration in progress

45 Slug flow

47 Power reset

56 API: Temperature out of limits

57 API: Density out of limits

60 Enhanced density: unable to fit curve data
61 Enhanced density: extrapolation alarm
71 Meter verification info alarm

72 Simulation mode active

73-139 Undefined
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=
o
3
E.1 Overview
This appendix provides information on the codes and abbreviations used on the transmitter display.
Note: Information in this appendix applies only to transmitters that have a display.
E.2 Codes and abbreviations
Table E-1 lists and defines the codes and abbreviations that are used for display variables (see =
Section 8.9.3 for information on configuring display variables). ]
Table E-2 lists and defines the codes and abbreviations that are used in the off-line menu. G
Note: These tables do not list terms that are spelled out completely, or codes that are used to identify
measurement units. For the codes that are used to identify measurement units, see Section 6.3.
Display codes used for display variables
Code or abbreviation  Definition Comment or reference
AVE_D Average density
AVE_T Average temperature
BRD T Board temperature ©
CONC Concentration &
DGAIN Drive gain g
EXT P External pressure <3|>
EXTT External temperature g
GSVF Gas standard volume flow
GSV I _Gas standard volume flow
inventory
LPO_A Left pickoff amplitude
LVOLI Volume inventory
LZERO Live zero flow
MASSI Mass inventory
MTR T Case temperature
NET M Net mass flow rate Enhanced density application only %
NET V Net volume flow rate Enhanced density application only :ﬁ
NETMI Net mass inventory Enhanced density application only 9
NETVI Net volume inventory Enhanced density application only 5
PWRIN Input voltage Refers to power input to the core processor
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Display codes used for display variables

Code or abbreviation Definition Comment or reference

190

RDENS Density at reference Enhanced density application only
temperature

RPO A Right pickoff amplitude

SGU Specific gravity units

STDV Standard volume flow rate Enhanced density application only

STDVI Standard volume inventory Enhanced density application only

TCDEN Temperature-corrected Petroleum measurement application only
density

TCORI Temperature-corrected Petroleum measurement application only
inventory

TCORR Temperature-corrected total Petroleum measurement application only

TCVOL Temperature-corrected Petroleum measurement application only
volume

TUBEF Raw tube frequency

WTAVE Weighted average

Display codes used in off-line menu

Code or abbreviation

Definition

Comment or reference

ACK Display Ack All menu

ACK ALARM Acknowledge alarm

ACK ALL Acknowledge all

ACT Action Action assigned to a discrete event
ADDR Address

BKLT, B LIGHT Display backlight

CAL Calibrate

CHANGE PASSW

Change password

Change the password required for access to
display functions

CONFG Configuration

CORE Core processor

CURZ Current zero

CUSTODY XFER Custody transfer

DENS Density

DRIVE%, DGAIN Drive gain

DISBL Disable Select to disable

DSPLY Display

Ex Event x Refers to Event 1 or Event 2 when setting the
setpoint.

ENABL Enable Select to enable

EXTRN External

EVNTx Event x

FAC Z Factory zero

FCF Flow calibration factor
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Table E-2  Display codes used in off-line menu

Code or abbreviation

Definition

Comment or reference

FLDIR Flow direction

FLSWT, FL SW Flow switch

GSV Gas standard volume
GSVT Gas standard volume total
IRDA Infrared

LANG Display language

M_ASC Modbus ASCII

M_RTU Modbus RTU

MASS Mass flow

MBUS Modbus

MFLOW Mass flow

MSMT Measurement

MTR F Meter factor

OFF-LINE MAINT Off-line maintenance menu
OFFLN Display off-line menu
PRESS Pressure

r. Revision

SENSR Sensor

SPECL Special

SrC Source Variable assignment for outputs
TEMPR Temperature

VER Version

VERFY Verify

VFLOW Volume flow

VOL Volume or volume flow
WRPRO Write protect

XMTR Transmitter
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A
Acyclic communications 2
Additional communications response delay 71
Address switches 7

used to set node address 68
Alarms

See Status alarms
API block 181
Auto scroll 67
Auto zero

See Zero calibration

B
Baud rates
automatic detection 2, 7, 21
supported 2
Bus parameters
See PROFIBUS bus parameters
Button
See Optical switch
Byte order
See Floating-point byte order

C
Calibration 87, 89
calibration failure 126
density calibration procedure 117
See also Zero calibration, Density calibration,
Temperature calibration
temperature calibration procedure 121
troubleshooting 135
zero calibration procedure 113
Calibration block 168
Characterizing
troubleshooting 135
Communication tools 3
troubleshooting 124
Configuration
additional communications response delay 71
API parameters 74
cutoffs 54
damping 55
density measurement unit 32
device settings 73
digital communications fault action 71
digital communications parameters 68

Configuration and Use Manual

display 65
entering floating-point values 13
language 65
precision 66
variables 66
enhanced density application 77
events 57
external temperature compensation 84
fault timeout 72
floating-point byte order 70
flow direction parameter 56
GSV
1&M functions 73
IrDA port 69
mass flow measurement unit 30
meter factors 111
Modbus address 70
Modbus ASCII support 70
node address 68
optional 51
overview 3
petroleum measurement application 74
planning 3
pre-configuration worksheet 5
pressure compensation 82
pressure measurement unit 33
required 25
restoring a working configuration 136
saving to a file 18
sensor parameters 74
slug flow parameters 61
status alarm severity 62
temperature measurement unit 33
update period 65
volume flow measurement for gas 52
volume flow measurement unit 30

Configuration files

saving 18
upload and download 18

Configuration tools 3
Connecting to the transmitter

from a PROFIBUS host 21
from ProLink II or Pocket ProLink 18

Customer service 6, 124
Cutoffs 54
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D starting and stopping
Damping 55 inventories 47
Data exchange 2 totalizers 47
Default values 143 status alarms 41
Density update period 65
cutoff 54 using 12
factor 81 decimal notation 13
measurement unit entering floating-point values 13
configuration 32 exponential notation 13
list 32 for configuration 25, 51
Density calibration procedure 117 menus 13
Device address optical switch 11
See Node address variables 66
Device description viewing
See EDD process variables 36
Device Information block 178 totalizer and inventory values 45
Device settings 73 viewing process variables 12
Diagnostic block 170 Display variables 66
Digital communications Documentation 6
additional communications response delay 71 DP-VO0 cyclic services 2
fault action 71 using with PROFIBUS host 22
fault timeout 72 DP-V1 read and write services 2
floating-point byte order 70 using with PROFIBUS host 23
IrDA port usage 69 Drive gain, troubleshooting 137
Modbus address 70
Modbus ASCII support 70 E
node address 68 EDD 2,21
Digital communications parameters 68 menu flowcharts 153
Discrete event obtaining 3, 21
See Events resetting
Display inventories 49
changing event setpoints 61 totalizers 49
codes and abbreviations 189 starting and stopping
configuration 65 inventories 49
enable/disable totalizers 49
acknowledge all alarms 67 status alarms 43
alarm menu 67 using
auto scroll 67 for configuration 25, 51
off-line menu 67 with PROFIBUS host 23
totalizer reset 67 version 2
totalizer start/stop 67 viewing
language 12, 65 process variables 37
LCD panel backlight 67 status 39
menu flowcharts 160 totalizer and inventory values 46
off-line password 67 Enhanced density application
optional transmitter feature 9 configuration 77
password 13 required volume flow measurement type 77
precision 66 Enhanced Density block 181
resetting Events
inventories 47 changing setpoints from display 61
totalizers 47 configuration 57
See also User interface reporting status 60
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External temperature compensation
configuration 84
definition 84
output module 86

F

Fault action 71

Fault conditions 126

Fault timeout 72
Floating-point byte order 70
Flow calibration pressure 81
Flow direction parameter 56
Flow factor 81

G
Gas standard volume flow
See GSV
Grounding, troubleshooting 126
GSD 2,21
input modules 22
obtaining 3, 21
output modules 22
resetting
inventories 49
totalizers 49
starting and stopping
inventories 49
totalizers 49
using with PROFIBUS host 22
version 2
viewing
process variables 37
totalizer and inventory values 46
GSV
configuration
measurement units 32

H

Hardware addressing 68

|

1&M functions 2
configuration 73
PROFIBUS bus parameters 185
using 35

Identification & Maintenance functions
See 1&M functions

Input modules
list 22

Configuration and Use Manual

Inventories
definition 45
measurement unit codes 185
measurement units 28
resetting 47
starting and stopping 47
viewing values 45

IrDA port
enabled or disabled 69
write-protection 69

L
Language
used on display 12, 65
LCD panel backlight 67
LEDs
troubleshooting 128
types 38
using 38
Local Display block 179
Low pickoff voltage 137

M
Mass flow
cutoff 54
measurement unit
configuration 30
list 30
Measurement block 166
Menu flowcharts
Display 160
EDD 153
ProLink IT 150
Messaging 2
Meter factors 89
configuration 111
Meter validation 87, 89
See also Meter factors
Meter verification 87
execution 91
overview 87
preparing for test 91
results 102
See also Smart Meter Verification
Micro Motion customer service 6, 124
Modbus address 70
Modbus ASCII support 70
Model number 1
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N PROFIBUS bus parameters 2, 165
Network LED 38 alarm index codes 187
Node address API block 181
address switches 68 Calibration block 168
default 7,22, 68 data types 166
hardware addressing 68 Device Information block 178
setting 7, 21, 22, 68 Diagnostic block 170
software addressing 68 Enhanced Density block 181
1&M functions 185
0 Local Display block 179
Optical switch 11 Measurement block 166
Output modules measurement unit codes
list 22 density 32
pressure and external temperature mass flow 30
compensation 86 pressure 33
temperature 33
P totalizers and inventories 185
Password 13 volume flow 30
Petroleum measurement application process variable codes 186
configuration 74 resetting
required volume flow measurement type 74 inventories 49
Pickoff voltage 137 totalizers 49
Pocket ProLink starting and stopping
configuration upload and download 18 inventories 49
connecting to Model 2400S DP transmitter 18 totalizers 49
requirements 17, 125 status alarms 44
saving configuration files 18 using with PROFIBUS host 23
Power supply viewing
troubleshooting 125 process variables 38
Pressure status 39
measurement unit totalizer and inventory values 47
configuration 33 PROFIBUS host
list 33 connecting to Model 2400S DP transmitter 21
Pressure compensation requirements 125
configuration 82 using 21
definition 81 EDD 23
output module 86 GSD 22
pressure correction factors 81 PROFIBUS bus parameters 23
pressure effect 81 PROFIBUS wiring, troubleshooting 126
Pressure correction factors 81 ProLink II
Pressure effect 81 configuration upload and download 18
Process variable connecting to Model 2400S DP transmitter 18
recording 36 menu flowcharts 150
troubleshooting 132 requirements 17, 125
viewing 36 resetting
PROFIBUS inventories 48
baud rates 2 totalizers 48
configuration methods 2 saving configuration files 18
1&M functions 2 starting and stopping
messaging 2 inventories 48
operation methods 2 totalizers 48

status alarms 42
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using for configuration 25, 51
version 2
viewing

process variables 37

status 39

totalizer and inventory values 46

R

Restore factory configuration 136
Restore factory zero 113

Restore prior zero 113

)
Safety 1
Scroll optical switch 11
Select optical switch 11
Sensor circuitry, troubleshooting 138
Sensor parameters 74
Sensor tubes 135
Service port
clips 18
connection parameters 18
IrDA port 18
Set Slave Address telegram 22
Siemens Simatic PDM 21
Simulation mode 127
Slave address
See Node address
Slug flow
definition 61
parameters 61
troubleshooting 134
Smart Meter Verification
execution 96
overview 87
preparing for test 91
results 102
scheduling 109
Software address LED 38
Software addressing 68
Status alarm severity
configuration 62
implications for fault reporting 62
Status alarms
handling 40
list 128
See also Status alarm severity
Status LED 39
Status, viewing 39

Configuration and Use Manual

T
Temperature
measurement unit
configuration 33
list 33
Temperature calibration procedure 121
Temperature compensation
See External temperature compensation
Terminals 148
Test points 136
Totalizers
definition 45
measurement unit codes 185
measurement units 28
resetting 47
starting and stopping 47
viewing values 45
Transmitter
bringing online 7
components 147
configuration
default values and value ranges 143
optional 51
overview 3
required 25
connecting
from a PROFIBUS host 21
from Pocket ProLink 18
from ProLink IT 18
model number 1
software version 2
terminals 148
type 1
Troubleshooting
calibration 126, 135
characterization 135
communication device 124
drive gain problems 137
fault conditions 126
flow measurement configuration 135
grounding 126
low pickoff voltage 137
network LED 128
power supply wiring 125
process variables 132
PROFIBUS wiring 126
sensor circuitry 138
sensor tubes 135
slug flow 134
software address LED 128
status alarms 128
status LED 128
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test points 136

transmitter does not communicate 124
transmitter does not operate 124
wiring problems 125

zero failure 126

U

Update period
configuration 65

User interface
features and functions 9
optional display 9
removing cover 11
See also Display

V
Viewing
inventory values 45
process variables 36
with the display 12
status 39
totalizer values 45
Volume flow
cutoff 54
gas standard 52
liquid 52
measurement type 30, 52
required for enhanced density application 52
required for petroleum measurement
application 52
measurement unit
configuration 30
gas 32
liquid 31

w
Wiring problems 125

z
Zero calibration 112
failure 126
procedure 113
restoring factory zero 113
restoring prior zero 113
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